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製品概要

Dell 1082DS/2162DS/4322DS RCS( RCS) の IPを 介し たデジタ ル・キー

ボード 、 ビ デオ、 マウス ( KVM) およ びシリ アル・コ ン ソ ール・ス

イ ッ チは、 アナロ グと デジタ ルのテク ノ ロ ジーを 統合し て、 データ

セン タ ー・サーバーの柔軟な中央集中制御を 提供し 、 訓練さ れたオペ

レ ータ ーがいない遠隔地にある 支店での操作、 起動、 管理を 容易に

し ます。 IPベースのRCSを 使用し て、 いつでも 、 ど こ から でも RCS
ソ フ ト ウェ アまたはOBWI( 内蔵型Webイ ン タ ーフ ェ イ ス ) を 介し

た柔軟なタ ーゲッ ト ・デバイ スの管理制御およ びセキュ アなリ モー

ト ・アク セスが可能です。

特長と メ リ ッ ト

RCSは企業のお客様に次の特長と オプショ ン を 提供し ます。

• ケーブル量を 大幅に低減

• アナロ グ ( ロ ーカ ル ) またはデジタ ル ( リ モート ) 接続構成が

可能なバーチャ ル・メ ディ ア ( VM) 機能

• スマート ・カ ード ／Common Access Card( CAC) 機能

• セキュ ア ・シェ ル ( SSH) およ びTelnetによ る ト ゥ ルー・シリ アル

機能

• ビ デオ解像度のサポート 強化によ り 、 タ ーゲッ ト から リ モート に

ネーテ ィ ブで最大1600 x 1200または1680 x 1050( ワイ ド スク リ ー

ン ) 対応

• オプショ ン のデュ アル電源モデルで冗長性を 確保
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• イ ン テリ ジェ ン ト 電源装置を 管理する ためにオプショ ン のサ

ポート

• 独立し たデュ アル・ロ ーカ ル・ポート ・ビ デオ・パス ( ACI専用 )

• 同時アク セスのためのデュ アル・スタ ッ ク IPv4( DHCP) およ

び IPv6( DHCPv6およ びステート レ ス自動構成 )

• 10/100/1000BaseT LANポート を 経由し てのタ ーゲッ ト ・デバイ スへ

のアク セシビ リ テ ィ

• イ ーサネッ ト 接続が利用でき ない場合でも 、 V.34、 V.90、 V.92対
応モデムを サポート する モデム・ポート によ り スイ ッ チへのアク

セスが可能

• FIPSサポート

ケーブル量の低減

サーバーの高密度化に伴い、 ネッ ト ワーク 管理者にと っ てはケーブ

ル量が大き な考慮事項と なっ ています。 RCSは、 革新的なサーバー・

イ ン タ ーフ ェ イ ス ・ポッ ド ( SIP) モジュ ールと 単一の、 業界標準で

ある 非シールド ・ツ イ スト ・ペア ( UTP) ケーブルを 活用し て、

ラ ッ ク 内のKVMケーブル量を 大幅に削減し ます。 こ れによ っ て、 気

流を 大き く し 、 冷却能力を 増やし ながら 、 サーバー密度を さ ら に高

める こ と ができ ます。

KVMスイ ッ チ機能

RCSは、 タ ーゲッ ト ・デバイ スから 直接電力が供給さ れる SIPを サ

ポート し ている ため、 スイ ッ チに電源が入っ ていないと き も 「 キー

プ ・アラ イ ブ 」 機能を 提供し ます。 CAT 5設計を 採用し た SIPでは、

ケーブルの乱雑状態が大幅に解消さ れ、 また最適な解像度と ビ デオ

設定が提供さ れます。 SIPの内蔵メ モリ ーによ り 、 固有のデバイ ス

名または電子 ID( EID) 番号が個々の接続デバイ スに指定さ れ保持

さ れる ため、 構成が簡単です。

PS/2と USB SIPが使用可能で、 KVMを デバイ スに直接接続でき ま

す。 USB2およ びCAC用SIPも 利用でき ます。 RCSにはSIP接続用
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に 8、 16、 32のいずれかのアナロ グ・ラ ッ ク ・イ ン タ ーフ ェ イ ス

( ARI) ポート が備えら れています。 SIPを 利用する こ と で、 追加の

スイ ッ チを 接続し て RCSシステムを 拡張でき ます。 こ の柔軟性によ

り 、 データ ・セン タ ーの拡大に伴う 容量の増大が可能になり ます。

マルチプラ ッ ト フ ォ ームのサポート

Dell SIPを RCSと 組み合わせて、 PS/2、 USB、 USB2、 USB2およ びCAC
用の各デバイ ス環境と の接続を サポート し ます。 さ ら に、 こ れら の

モジュ ールを OBWIと 組み合わせる こ と で、 異なる プラ ッ ト フ ォ ー

ム間の切り 替えを 容易に行う こ と ができ ます。

相互運用性のある Avocent® IQモジュ ール・イ ン テリ ジェ ン ト ・ケーブ

ルを 使用し ても 、 デバイ スを RCSに接続でき ま

す。 PS/2、 USB、 Sun®、 およ びシリ アル・モジュ ールが使用可能で

す。 詳細については、 ご使用の製品に対応する アボセン ト 製品の

『 イ ン スト ーラ ／ユーザー・ガイ ド 』 を 参照する か、 また

はavocent.com/manualsで確認し て く ださ い。

ト ゥ ルー・シリ アル機能

RCSはTelnetを 介し て、 ト ゥ ルー・シリ アル機能を 提供する SIPを サ

ポート し ます。 SIPを 使用し て、 SSHセッ シ ョ ン を 起動する

か、 OBWIから シリ アル・ビ ュ ーアを 起動し て、 RCSに接続さ れてい

る シリ アル・タ ーゲッ ト に接続でき ます。

ローカ ルおよびリ モート ・ユーザー・イ ンタ ーフ ェ イ ス

ロ ーカ ル・ポート に直接接続する こ と によ り 、 ロ ーカ ル・ユーザー・イ

ン タ ーフ ェ イ ス ( ロ ーカ ルUI) を 使用し て RCSを 管理でき ます。 リ

モート のOBWIを 使用し て、 スイ ッ チを 管理する こ と も でき ま

す。 OBWIはWebブラ ウザ・ベースであり 、 スイ ッ チから 直接起動さ

れます。 また、 スイ ッ チに接続さ れている すべてのデバイ スが自動

的に検出さ れます。
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バーチャ ル・メ ディ アおよびスマート ・カ ード 対応スイ ッ チ

RCSによ り 、 あら ゆる タ ーゲッ ト ・デバイ ス間で、 バーチャ ル・メ

ディ アのデータ を 表示、 移動、 コ ピ ーでき ます。 オペレ ーテ ィ ン グ・

システムのイ ン スト ール、 オペレ ーテ ィ ン グ・システムのリ カ バ

リ 、 ハード ・ド ラ イ ブのリ カ バリ や複製、 BIOSの更新、 タ ーゲッ ト ・

デバイ スのバッ ク アッ プが可能になり 、 リ モート ・システムを 効率

よ く 管理でき ます。

RCSでは、 ご使用のスイ ッ チ ・システムと スマート ・カ ード を 組み合

わせて使用する こ と も でき ます。 スマート ・カ ード は情報を 格納お

よ び処理する ポケッ ト ・サイ ズのカ ード です。 CACなどのスマート ・

カ ード は、 コ ン ピ ュ ータ ーやネッ ト ワーク にアク セスし たり 、 セ

キュ リ テ ィ で保護さ れた部屋やビ ルに入る ための IDや認証を 格納

する ために使用でき ます。

バーチャ ル・メ ディ アおよ びスマート ・カ ード ･リ ーダーは、 スイ ッ チ

のUSBポート に直接接続でき ます。 さ ら に、 バーチャ ル・メ ディ アお

よ びスマート ・カ ード ・リ ーダーは、 リ モート のOBWI、 Dell RCSソ フ ト

ウェ ア 、 Avocent管理ソ フ ト ウェ アのいずれかを 実行し ている 任意

のリ モート ・ワーク ステーショ ン に接続でき 、 イ ーサネッ ト 接続を 使

用し てスイ ッ チに接続さ れます。

注： タ ーゲッ ト ・デバイ スと のバーチャ ル・メ ディ アまたはスマート ・カ ー
ド のセッ ショ ンを開始するには、 最初にSIPを使用し てタ ーゲッ ト ・デバ
イ スをスイ ッ チに接続する必要があり ます。

OBWI

OBWIを 使用する と RCSソ フ ト ウェ アと 同様の管理機能を 実行で

き 、 ソ フ ト ウェ ア ・サーバーは不要で、 イ ン スト ールの必要も あり ま

せん。 OBWIはスイ ッ チから 直接起動さ れます。 また、 RCSに接続

さ れている すべてのサーバーが自動的に検出さ れます。 OBWIを 使

用し て、 Webブラ ウザから RCSを 構成でき ます。 OBWIから ビ ュ ーア

を 起動する と 、 タ ーゲッ ト ・デバイ スに対し KVMセッ シ ョ ン と バー

チャ ル・メ ディ ア ・セッ シ ョ ン が確立さ れます。 また、 OBWIはLDAP
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認証を サポート し ています。 こ れによ り 、 単一のイ ン タ ーフ ェ イ ス

から 複数のRCSに対する アク セス権を 管理でき ます。

標準TCP/IPネッ ト ワーク を使用し たスイ ッ チへのアク セス

スイ ッ チはエージェ ン ト レ スのリ モート 制御およ びアク セスが可能

です。 接続さ れたサーバーまたはク ラ イ アン ト に特別のソ フ ト ウェ

アやド ラ イ バーを イ ン スト ールする 必要はあり ません。

注： ク ラ イ アント は、 イ ンタ ーネッ ト ・ブラ ウザを使用し てスイ ッ チに
接続し ます。

スイ ッ チおよ びすべての接続さ れている システムには、 イ ーサネッ

ト またはV.34、 V.90、 V.92のいずれかのモデム経由でク ラ イ アン ト

から アク セスでき ます。 ク ラ イ アン ト は、 有効なネッ ト ワーク 接続

さ え確立さ れていればどこ にでも 設置でき ます。

暗号化

RCSでは、 キーボード ／ビ デオ／マウスのセッ シ ョ ン と バーチャ ル・

メ ディ ア ・セッ シ ョ ン の128ビ ッ ト SSL( ARCFOUR) 、 およ

びAES／DES／3DES暗号化がサポート さ れています。

ビデオ

RCSは、 アナロ グのVGA、 SVGAおよ びXGAビ デオ用に最適な解像度

を 提供し ます。 スイ ッ チと サーバー間のケーブル長によ り 、 最

大1600 x 1200、 または1680 x 1050( ワイ ド スク リ ーン ) の解像度で

の表示が可能です。

FLASHアッ プグレード 対応

RCSと SIPのアッ プグレ ード は随時可能です。 アッ プグレ ード は定期

的に行い、 常に最新のフ ァ ームウェ ア ・バージョ ン で稼動し て く だ

さ い。 FLASHアッ プグレ ード は、 OBWIまたはシリ アル・コ ン ソ ール

から 起動でき ます。 RCSはSIPの自動フ ァ ームウェ ア ・アッ プグレ ー

ド を 実行する よ う に構成でき ます。 詳細については、 「 RCSフ ァ ー

ムウェ アのアッ プグレ ード 」 ( ページ 57) を 参照し て く ださ い。
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階層の拡張

RCSでは、 スイ ッ チの各アナロ グ・ラ ッ ク ・イ ン タ ーフ ェ イ ス ( ARI)
ポート から 追加のDell RCSを テ ィ ア接続でき ます。 テ ィ アド ・スイ ッ

チは他のデバイ スと 同じ 方法で接続し ます。 装置にこ のよ う にテ ィ

ア ( 階層 ) を 追加する こ と で、 1つのシステム内に最大1024台の

サーバーを 接続でき ます。 「 テ ィ ア ド ・スイ ッ チの追加」 ( ページ

33) を 参照し て く ださ い。

Avocent管理ソ フ ト ウェ ア・プラ グイ ン

スイ ッ チで Avocent管理ソ フ ト ウェ アを 使用する と 、 単一のWebベー

スのユーザー・イ ン タ ーフ ェ イ スから 、 複数のプラ ッ ト フ ォ ームにあ

る タ ーゲッ ト ・デバイ スのリ モート から のアク セス、 監視、 およ び

制御が可能になり ます。 詳細については、 Avocent管理ソ フ ト ウェ

アの「 技術告示」 を 参照し て く ださ い。

FIPS暗号モジュ ール

RCSスイ ッ チはFIPS 140-2のレ ベル1 暗号セキュ リ テ ィ 要件に対応し

ています。 FIPS の操作モード は、 OBWIまたはロ ーカ ル・ポート を 介

し 有効または無効し て、 再起動の後に実行する こ と ができ ま

す。 FIPSを 有効にする と 、 スイ ッ チの再起動で、 FIPSモード の完全

性チェ ッ ク のために約2分ほど要し ます。 また、 FIPSが有効なと

き 、 キーボード 、 マウスまたはビ デオの暗号化が128ビ ッ ト のSSL
( ARCFOUR) またはDESに設定さ れている 場合は、 暗号化のレ ベ

ルは自動的に AESの暗号化レ ベルに変更さ れます。

注： FIPSの操作モード はデフ ォ ルト では無効になっ ているので有効にし
て操作する必要があり ます。

注： 「 Setup」 ポート の工場出荷時のデフ ォ ルト 設定では、 FIPSモジュ ー
ルが自動的に無効になり ます。

注： FIPSモード は、 DSViewソ フ ト ウェ ア・プラ グイ ンを介し て変更するこ
と ができます。
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RCSスイ ッ チでは、 FIPS 140-2 実装ガイ ダン スのセク シ ョ ン G.5ガイ

ド ラ イ ン に従っ て Linux PPCプラ ッ ト フ ォ ームで稼動する 組み込み式

のFIPS 140-2認定暗号モジュ ール ( 証明書番号1051) を 使用し ます。

こ のFIPSモード は、 OBWI、 ロ ーカ ル・ポート 、 DSViewプラ グイ ン を

介し て有効／無効にする こ と ができ ます。 FIPSモード を 有効／無効

する には、 再起動が必要です。 こ のバージョ ン にフ ァ ームウェ アを

アッ プグレ ード する またはデフ ォ ルト 状態に設定を 戻すと ( 「 Setup
Port」 メ ニュ ー) 、 FIPSモード は無効になり ます。

FIPSモード では、 暗号化によ る 暗号は AESまたは3DESに限定さ れま

す。 FIPSが有効なと き 、 キーボード 、 マウスまたはビ デオの暗号化

が128ビ ッ ト のSSLまたはDESに設定さ れている 場合は、 暗号化レ ベ

ルは自動的に AESに変更さ れます。 FIPSが有効になっ ている と 、

こ れら のフ ァ イ ルは、 FIPS互換アルゴリ ズムである AESを 使用し て

保存 ( または復元 ) でき ます。 FIPSが無効なと き は、 アプラ イ アン

スから 保存する またはアプラ イ アン スへ復元する フ ァ イ ルは、 DES
を 使用し て外部フ ァ イ ルと し て暗号 ( 復号 ) さ れます。

こ れは、 ユーザーがOBWIの保存 ( 読み込み ) ダイ アロ グでパスワー

ド ・パラ メ ータ ーを 入力し ない ( こ の場合、 デフ ォ ルト のOEMパス

ワード は暗号化または復号化に使用さ れます ) と き にも 該当し ま

す。

FIPSモジュ ールを 有効にする と 、 結果の1つと し て、 以前に保存し

たユーザー・データ ベースと アプラ イ アン ス構成フ ァ イ ルが非互換に

なり ます。 こ の場合、 FIPSモード を 一時的に無効にし 、 アプラ イ ア

ン スを 再起動し 、 以前に保存し たデータ ーベースまたは構成を 復元

し て、 FIPSを 再度有効にし 、 再起し た後に、 FIPSを 有効にし ている

と き にフ ァ イ ルを 外部的にも う 一度保存する こ と ができ ます。 こ の

新し く 保存さ れた外部フ ァ イ ルは、 アプラ イ アン スがFIPSモード 有

効で作動し ている 限り 、 アプラ イ アン スと 互換性を 保ち ます。

こ れはの逆の場合にも 当てはまり ます。 すなわち 、 FIPSモード を 有

効にし た状態で保存し たデータ ベースと 構成フ ァ イ ルは、 FIPSモ
ジュ ールを 有効にし ていないアプラ イ アン スへの復元、 またはFIPS
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モード に対応し ていない古いフ ァ ームウェ アがイ ン スト ールさ れて

いる アプラ イ アン スでの復元に対し て互換性を 持ち ません。

構成例

図 1.1. RCSの構成例
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表 1.1: 図 1.1の説明

番号 説明 番号 説明

1
UTP接
続

6 電話回線ネッ ト ワーク

2
RCSへ
のKVM
接続

7 イ ーサネッ ト

3
リ モー

ト IP接
続

8 Avocent管理ソ フ ト ウェ ア・サーバー

4 RCS 9 アナログ・ユーザー( ローカ ルUI)

5
モデ

ム
10

デジタ ル・ユーザー( リ モート OBWIまた

はDell RCSソ フ ト ウェ ア用にイ ンタ ー

ネッ ト ・ブラ ウザを搭載し たコ ンピュ ー

タ ー)

安全に関する 注意事項

身体の安全を 守り 、 使用システムや作業環境を 損傷から 保護する た

めに、 次の安全に関する ガイ ド ラ イ ン に従っ て く ださ い。

注意： システムの電源は高電圧および高エネルギーを発出し て人身に

危害を及ぼす可能性があり ます。 カ バーを取り 外し てシステム内のコ ン

ポーネント にアク セスすると いっ た作業は、 必ず訓練を受けたサービス

技術者に任せてく ださ い。 こ の警告はDell™リ モート ・コ ンソ ール・スイ ッ

チ、 Dell™ PowerEdge™サーバーおよびDell PowerVault™スト レージ・システ

ムに適用さ れます。

本マニュ アルはDell 1082DS/2162DS/4322DS Remote Console Switchのみ

を 対象と し ています。 追加の安全事項も 併せてお読みいただき 、 そ

の指示に従っ て く ださ い。

• Dellリ モート ・コ ン ソ ール・スイ ッ チ ・ユーザー・ガイ ド
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• Dell安全シート

• Dell RTF規制技術告示

全般

• サービ ス ・マーク を 確認し 、 その指示に従います。

• Dellシステムのマニュ アルに記載さ れている 以外の修理、 メ ン

テナン ス作業は行わないでく ださ い。

• 電光のイ ラ スト の三角形記号が付いている カ バーを 開く と 感電

の危険があり ます。

• こ れら の格納区画内の部品については、 訓練を 受けたサービ ス

技術者だけが修理を 行います。

• 本製品には修理可能な部品は含まれていません。 ユニッ ト を 開

けよ う と し ないで く ださ い。

次のいずれかの状態が発生し た場合は、 電源コ ン セン ト から 製品の

電源ケーブルを 抜いて、 部品を 交換する か、 Dell認定サービ ス業者

に問い合わせてく ださ い。

- 電源ケーブル、 延長ケーブル、 またはプラ グが破損

し た。

- 製品内部に物体が落ち てし まっ た。

- 製品が水に晒さ れてし まっ た。

- 製品を 落と し たか、 破損さ せた。

- 操作手順に従っ ても 製品が正常に作動し ない。

• システムは暖房器具や熱源から 離し て設置し て く ださ い。 ま

た、 冷却用の通気孔を ふさ がないでく ださ い。

• システム・コ ン ポーネン ト に食べ物や液体を こ ぼさ ないでく ださ

い。 また、 水分のある 環境では製品を 操作し ないでく ださ い。

システムに水が入っ た場合、 ト ラ ブルシュ ーテ ィ ン グ・ガイ ド の
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該当する 項を 参照する か、 認定サービ ス業者にお問い合わせく

ださ い。

• 本製品は認定機器のみと 併用し て く ださ い。

• カ バーを 外す／内部コ ン ポーネン ト にアク セスする 際は、 製品

が常温に戻っ てから 行っ て く ださ い。

• 必ず、 電気定格ラ ベルに記載の外部電源タ イ プを 使用し て製品

を 作動し て く ださ い。 適合する 電源タ イ プが不明の場合は、 認

定サービ ス業者または地域の電力会社にお問い合わせく ださ

い。

注： システム破損を避けるため、 電源装置の電圧選択スイ ッ チ ( 備わっ
ている場合) は、 必ずご使用地域のAC電源に適合し た電圧になるよう 設
定し てく ださ い。 また、 モニタ ーと 接続デバイ スの電気定格が適切であ
るこ と を確認し てく ださ い。

• 使用モニタ ーおよ び周辺機器の電気定格が設置場所の電源に適

合し ている こ と を 確認し て く ださ い。

• 本製品に付属の電源ケーブルのみを 使用し て く ださ い。

• 感電を 避ける ため、 システムおよ び周辺機器の電源ケーブル

は、 正し い方法でアース処理さ れたコ ン セン ト に接続し て く だ

さ い。 こ れら の電源ケーブルは、 正し く アースする ために、 三

本ピ ン ・プ ラ グが使用さ れています。 アダプタ ー・プ ラ グを 使用

し たり 、 アースピ ン を ケーブルから 取り 外し たり し ないで く だ

さ い。

• 延長ケーブルおよ びケーブルタ ッ プは定格に従っ て使用し て く

ださ い。 電源スト リ ッ プに接続する 製品全部の合計定格アン ペ

アが電源スト リ ッ プの最大定格アン ペアの80%を 超えていない

こ と を 確認し て く ださ い。

• 突発的に起き る 一時的な電源の増減から システムを 保護する た

めに、 サージ ・サプレ ッ サー、 ラ イ ン ・コ ン ディ シ ョ ナ、 または

無停電電源装置 ( UPS) を 使用し て く ださ い。
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• システム・ケーブルおよ び電源ケーブルは慎重に配置し て く ださ

い。 ケーブルは踏んだり つまずいたり する こ と のない形で配線

し て く ださ い。 ケーブルには何も 載せないでく ださ い。

• 電源ケーブルやプラ グは改造し ないでく ださ い。 設置場所での

電気的改修については、 有資格の電気技術者または地域の電力

会社にお問い合わせく ださ い。 必ず使用の地域または国の配線

規定に従っ て く ださ い。

LANオプ シ ョ ン

• 雷雨中のLANへの接続や使用は避けてく ださ い。 雷によ っ て感

電する 危険があり ます。

• 湿潤環境でのLANへの接続や使用は避けてく ださ い。
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設置

RCSでは、 スイ ッ チに接続さ れている オペレ ータ ーと タ ーゲッ ト ・デ

バイ ス間で、 KVM情報と シリ アル情報を 送信し ます。 こ れは、 イ ー

サネッ ト またはモデム接続を 使用し てネッ ト ワーク を 介し て送ら れ

ます。 RCSではイ ーサネッ ト の通信にTCP/IPを 使用し ます。 最適な

システム・パフ ォ ーマン スのためには、 専用スイ ッ チ付き 100BaseT
ネッ ト ワーク または1000BaseTネッ ト ワーク を 使用し ます。 10BaseT
イ ーサネッ ト を 使用する こ と も でき ます。

RCSでは、 V.34、 V.90、 V.92のモデムを 介する 通信にポイ ン ト ・ツ ー・

ポイ ン ト ・プ ロ ト コ ル ( PPP) を 使用し ます。 OBWIまたはAvocent管
理ソ フ ト ウェ アを 使用し て、 KVMおよ びシリ アル・スイ ッ チ ・タ スク

を 実行でき ます。 Avocent管理ソ フ ト ウェ アの詳細について

は、 http://www.avocent.comを 参照し て く ださ い。

RCSボッ ク スには、 RCS、 RCSソ フ ト ウェ ア 、 OBWIが含まれていま

す。 システムの管理には、 RCSソ フ ト ウェ アまたはOBWIのいずれ

かを 選択し て使用でき ます。 OBWIは1台のRCSと その接続を 管理す

る のに対し 、 RCSソ フ ト ウェ アは複数のスイ ッ チと その接続を 管理

でき ます。 OBWIのみを 使用する 場合は、 RCSソ フ ト ウェ アを イ ン

スト ールする 必要はあり ません。

注： RCSソ フ ト ウェ アを使用すると 、 複数のスイ ッ チを管理できます。
詳細については、 ご使用の製品に対応する 「 イ ンスト ーラ ／ユーザー・ガ
イ ド 」 を参照し てく ださ い。

注： 使用中のRCSがすべて最新バージョ ンのフ ァ ームウェ アにアッ プグ
レード さ れているこ と を確認し てく ださ い。 OBWIを使用する RCSのアッ
プグレード の詳細については、 「 RCSツール」 ( ページ 56) を参照し てく
ださ い。
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RCSク イ ッ ク ・セ ッ ト ア ッ プ

次にク イ ッ ク ・セッ ト アッ プを 一覧で示し ます。 最初にRCSを
ラ ッ ク に設置し ます。 詳細な設置手順については、 「 はじ めに」

( ページ 15) を 参照し て く ださ い。

1 各サーバーで、 マウス加速度を SlowまたはNoneに調整し ます。

2 RCSのハード ウェ アを 設置し 、 各サーバーまたはテ ィ アド ・ス

イ ッ チに、 サーバー・イ ン タ ーフ ェ イ ス ・ポッ ド ( SIP) また

はAvocent® IQモジュ ールを 接続し ます。 各SIPまたはAvocent IQ
モジュ ールを CAT 5ケーブルを 使用し て RCSに接続し 、 さ ら に

キーボード と モニタ ー、 およ びマウス ・コ ネク タ ーを RCSのアナロ

グ・ポート に接続し ます。

3 ロ ーカ ル・ポート の周辺機器を RCSの背面パネルにある 適切な

ポート に接続し 、 ネッ ト ワーク 構成を セッ ト アッ プ し ます。 IP
アド レ スはこ こ から 、 またはRCSソ フ ト ウェ アから 設定でき ま

す。 Dellでは、 構成を 容易にする ため、 静的 IPアド レ スを 使用さ

れる こ と を お薦めし ます。

4 ロ ーカ ル・ポート を 使用し て、 OBWIイ ン タ ーフ ェ イ スから すべて

のサーバー名を 入力し ます。

RCSソ フ ト ウェ アを セッ ト アッ プする には ( RCSソ フ ト ウェ ア ・ユー

ザー・ガイ ド を 参照し て く ださ い ) ：

1 各ク ラ イ アン ト ・ワーク ステーショ ン にRCSソ フ ト ウェ アを イ ン

スト ールし ます。

2 1つのク ラ イ アン ト ・ワーク ステーショ ン から 、 RCSソ フ ト ウェ ア

を 起動し ます。

3 New RCS taskボタ ン を ク リ ッ ク し て、 新し いスイ ッ チを RCSソ フ

ト ウェ ア ・データ ベースに追加し ます。 前述のと おり に IPアド レ

スが構成さ れている 場合は、 Yes, the product already has an IP
addressを 選択し 、 それ以外の場合は、 No, the product does not have
an IP addressを 選択し ます。
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RCSソ フ ト ウェ アはRCSと RCSに接続さ れている すべてのSIPを 検出

し 、 Explorer内に名前を 表示し ます。

注： RCSソ フ ト ウェ アを使用し たDell RCSの追加と 管理以外にも 、 複数
のAvocentスイ ッ チを追加および管理できます。

4 Explorerを 使用し てプロ パテ ィ を 設定し 、 目的に従っ てサーバー

を ロ ケーショ ン 、 サイ ト 、 またはフ ォ ルダーにグループ分けし ま

す。

5 OBWIを 使用し て、 ユーザー・アカ ウン ト を 作成し ます。 詳細に

ついては、 「 ユーザー・アカ ウン ト のセッ ト アッ プ 」 ( ページ

86) を 参照し て く ださ い。

6 ク ラ イ アン ト ・ワーク ステーショ ン の1台がセッ ト アッ プ さ れた

ら 、 File→ Database→ Saveの順に選択し て、 データ ベースのコ

ピ ーを すべての設定内容と と も に保存し ます。

7 2台目のク ラ イ アン ト ・ワーク ステーショ ン から 、 File→ Database
→ Loadの順にク リ ッ ク し 、 保存し たフ ァ イ ルを 参照し て検索し

ます。 フ ァ イ ルを 選択し 、 Loadを ク リ ッ ク し ます。

8 こ のフ ァ イ ルを 読み込んだ後で、 ロ ーカ ル・ユーザーがいずれか

のSIPの追加、 削除、 名前の変更を 行っ た場合、 RCSを 選択し

て Resyncを ク リ ッ ク する と 、 ロ ーカ ル・スイ ッ チを 再同期化でき

ます。 接続さ れている サーバーを 制御する には、 Explorerでサー

バーを 選択し てConnect Videoタ スク ・ボタ ン を ク リ ッ ク し 、

ビ ュ ーアでサーバー・セッ シ ョ ン を 起動し ます。

9 ビ ュ ーアでサーバー・ビ デオの解像度 ( View → Scalingを 選択 ) と

画質 ( View → Colorを 選択 ) を 調整し ます。

はじ めに

Remote Console Switchには次のアイ テムが同梱さ れています。 RCSを
設置する 前に、 正し く 設置する ために必要なアイ テムを 手元に準備

し て く ださ い。

• Remote Console Switch
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• ジャ ン パー・コ ード

• 0U収納用金具

• 1U取り 付け用ブラ ケッ ト ・ハード ウェ ア ・キッ ト ( RCSに事前に

取り 付け済みの2本の追加レ ールはキッ ト ・ア ッ セン ブ リ ーに含

まれています )

• SETUPと MODEM用のケーブルと アダプタ ー

• CD収録版Remote Console Switchシステム・ユーザー・ガイ ド

• Dell安全シート

• Dell RTF規制技術告示

こ の他に必要なアイ テム：

• Dell SIPモジュ ールまたはAvocent IQモジュ ール ( 接続デバイ スに

つき に 1個 )

• CAT 5パッ チ ・ケーブル ( 最長45m) ( 接続デバイ スにつき 1本 )

オプショ ン のアイ テム：

• V.34、 V.90、 またはV.92対応モデムおよ びケーブル

• 電源管理装置

• ポート 拡張モジュ ール ( PEM)

注： PEMを介し てサーバーが接続さ れていると 、 バーチャ ル・メ ディ ア・
セッ ショ ンまたはCACセッ ショ ンは開始できません。

ネッ ト ワーク のセッ ト アッ プ

スイ ッ チは IPアド レ スを 使用し て、 スイ ッ チと タ ーゲッ ト ・デバイ

スを 個別に識別し ます。 RCSは、 Dynamic Host Configuration Protocol
( DHCP) と 静的 IPアド レ スの両方を サポート し ています。 IPアド

レ スを 各スイ ッ チに予約し て、 スイ ッ チがネッ ト ワーク に接続し て

いる 間、 各 IPアド レ スは静的のままになる よ う にし ます。
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キーボード

USBキーボード およ びマウスを RCSのアナロ グ・ポート に接続でき ま

す。

注： また、 RCSは、 アナログ・ポート に対する複数のキーボード やマウス
の接続にも 対応し ています。 ただし 、 同時に複数の入力機器を使用する
と 、 予期し ない結果を生じ るこ と があり ます。

RCSのラ ッ ク 収納

RCSは、 ラ ッ ク の棚、 または直接19イ ン チ幅のEIA-310-E準拠の

ラ ッ ク ( 4ポスト 、 2ポスト 、 ネジ穴式 ) に設置でき ます。 1U前面

ラ ッ ク 、 1U背面ラ ッ ク 、 およ び 2ポスト 設置用に、 Dell ReadyRails™
システムが用意さ れています。 ReadyRailsシステムには、 個別に梱

包さ れたレ ール組立部品が2組と 、 RCSの側面に取り 付けら れて同梱

さ れる レ ール2本が含まれます。 さ ら に、 0U構成用に取り 付け用ブ

ラ ケッ ト が1つ、 背面ラ ッ ク 設置用にブラ ン ク ・パネルが1枚付属し

ています。

警告： こ の説明はあく まで参考のためのも のであり 、 要約さ れていま

す。 始める前に、 「 安全、 環境、 および規制に関する情報」 の小冊子に

記載さ れている安全に関する指示をお読みく ださ い。

注： こ の文書中の図は、 特定のスイ ッ チを表すも のではあり ません。

機器をラ ッ ク に収納する際の安全措置

• ラ ッ ク への収納について ： ラ ッ ク に過負荷や不均一な負荷を か

ける と 、 棚やラ ッ ク の故障の原因と なり 、 機器およ び身体に対

する 損傷を 引き 起こ すこ と があり ます。 設置を 始める 前に、 ま

ず最終設置箇所にラ ッ ク を 固定さ せてく ださ い。 コ ン ポーネン

ト を ラ ッ ク の底部から 収納し ていき 、 上に向かっ て作業を 続け

てく ださ い。 ラ ッ ク の荷重定格を 超えてはいけません。

• 電源に関する 注意事項： 装置指定の電源以外には接続し ないで

く ださ い。 複数の電気コ ン ポーネン ト を ラ ッ ク に設置する 場合

は、 コ ン ポーネン ト の総出力定格が回路容量を 超えないこ と を
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確認し て く ださ い。 電源およ び延長コ ード が過負荷状態と なる

と 、 火災やショ ッ ク の危険性が生じ ます。

• 周辺温度の上昇： 密閉型のラ ッ ク ・ア ッ セン ブ リ ーに設置する 場

合、 ラ ッ ク 収納環境の作動温度が室温よ り 高く なる こ と があり

ます。 スイ ッ チの最高周囲温度は50°Cです。 こ れを 超えないよ

う に注意し て く ださ い。

• 通気の減少： ラ ッ ク に装置を 設置する 際には、 機器の安全な動

作に必要な気流の量が損なわれないよ う 配慮する 必要があり ま

す。

• 確実なアース処理： ラ ッ ク に取り 付けら れた装置については、

常時確実なアースを 確保し て く ださ い。 分岐回路に対し 直接接

続以外の給電接続を 行う 場合 ( 例： テーブルタ ッ プの使用 )
は、 特に注意を 払う 必要があり ます。

• リ ア ・パネルが下向き になっ た状態で製品を 収納し ないでく だ

さ い。

Dell ReadyRails™ システムの取り 付け

ReadyRailsシステムを 使用する と 、 RCS設置用に、 ラ ッ ク を 簡単に構

成でき ます。 ReadyRailsシステムは、 1Uツ ールレ ス方法、 または1U
ツ ール方法の利用可能な 3つのう ち 1つを 使用し て設置でき ます ( 2
ポスト ・フ ラ ッ シュ ・マウン ト 、 2ポスト ・セン タ ー・マウン ト 、 また

は4ポスト ・ネジ穴式 ) 。

1Uツ ールレ ス構成 ( 4ポスト の角穴または非ネジ式丸穴 )

1 ReadyRailsのフ ラ ン ジの端が外側に向いた状態で、 1本のレ ールを

左右の垂直ポスト の間に設置し ます。 背面フ ラ ン ジのレ ール・ペ

グを 背面の垂直ポスト ・フ ラ ン ジに揃えて固定し ます。 図 2.1の
アイ テム1と その部分拡大図は、 角穴およ び非ネジ式丸穴の両

方のケースでペグが取り 付けら れた様子を 示し ています。
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図 2.1. 1Uツ ールレ ス構成

2 ラ ッ ク 正面のフ ラ ン ジ ・ペグを 垂直柱の前面の穴に入る よ う に

合わせ、 固定し ます ( アイ テム2) 。

3 こ の手順を 2番目のレ ールでも 繰り 返し ます。

4 各レ ールを 取り 外すには、 各フ ラ ン ジの端 ( アイ テム3) にある

ラ ッ チ ・リ リ ース ・ボタ ン を 引いて、 各レ ールを 取り 外し ます。

2ポスト ・フ ラ ッ シュ ・マウン ト 構成

1 こ の構成では、 各ReadyRailsアッ セン ブ リ ーの前面から キャ スト

を 取り 外す必要があり ます ( 図 2.2、 アイ テム1) 。 Torx™ド ラ イ

バーを 使用し て、 前面フ ラ ン ジの端 ( レ ールのデバイ ス側にあ

る ) から 2つのネジを 取り 外し 、 各キャ スト を 取り 外し ます。

今後ラ ッ ク で必要になっ たと き のために、 キャ スト は保管し て
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おき ます。 背面フ ラ ン ジ ・キャ スト を 取り 外す必要はあり ませ

ん。

図 2.2. 2ポスト ・フ ラ ッ シュ ・マウン ト 構成

2 ユーザー供給の2個のネジで 1本のレ ールを 前面ポスト ・フ ラ ン ジ

に取り 付けます ( アイ テム2) 。

3 プラ ン ジャ ー・ブ ラ ケッ ト を 垂直ポスト に向かっ て前面にスラ イ

ド さ せて、 ユーザー供給の2個のネジでプラ ン ジャ ー・ブ ラ ケッ ト

を ポスト ・フ ラ ン ジに固定し ます ( アイ テム3) 。
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4 こ の手順を 2番目のレ ールでも 繰り 返し ます。

2ポスト ・セン タ ー・マウン ト 構成

1 カ チッ と いう 音がし て所定の位置に納まる までプラ ン ジャ ー・ブ

ラ ケッ ト を 後方にスラ イ ド さ せて、 ユーザー供給の2個のネジで

プラ ン ジャ ー・ブ ラ ケッ ト を 前面ポスト ・フ ラ ン ジに固定し ます

( 図 2.3、 アイ テム1) 。

図 2.3. 2ポスト ・セン タ ー・マウン ト 構成

2 背面ブラ ケッ ト を ポスト に向かっ てスラ イ ド さ せて、 ユーザー

供給の2個のネジでポスト ・フ ラ ン ジに固定し ます ( アイ テ

ム2) 。

3 こ の手順を 2番目のレ ールでも 繰り 返し ます。



22 | 設置

4ポスト ・ネジ穴構成

1 こ の構成では、 ReadyRailsアッ セン ブ リ ーの各端から フ ラ ン ジの

端のキャ スト を 取り 外す必要があり ます。 Torx™ ド ラ イ バーを

使用し て、 フ ラ ン ジの各端から 2つのネジを 取り 除き 、 各キャ

スト を 取り 除き ます ( 図 2.4、 アイ テム1) 。 今後ラ ッ ク で必要

になっ たと き のために、 キャ スト は保管し ておき ます。

2 各レ ールで、 ユーザー供給の2個のネジで前面フ ラ ン ジと 背面フ

ラ ン ジの各端を ポスト に取り 付けます ( アイ テム2) 。
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図 2.4. 4ポスト ・ネジ穴構成

RCSの設置

スイ ッ チは1U背面ラ ッ ク 、 1U前面ラ ッ ク 、 1U2ポスト ( フ ラ ッ シュ

およ びセン タ ー) 、 およ び 0U構成に収納でき ます。 次は、 1U背面

ラ ッ ク 、 1U前面ラ ッ ク 、 およ び 0U構成の例です。 1U2ポスト ( フ

ラ ッ シュ およ びセン タ ー) 構成では、 4ポスト 構成と 同じ 方法で、

スイ ッ チを レ ールにスラ イ ド さ せる こ と ができ ます。
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1U背面ラ ッ ク の設置

1 スイ ッ チに付いている レ ールの端を ReadyRailsアッ セン ブ リ ーに

挿入し 、 スイ ッ チを ラ ッ ク に押し 入れます ( 図 2.5、 アイ テ

ム1) 。

図 2.5. 1U背面ラ ッ ク の設置

2 各スイ ッ チ ・レ ールを 蝶ネジで固定し ます ( アイ テム2) 。

3 ( オプショ ン ) ブラ ン ク ・パネルを ラ ッ ク 前面のレ ールに取り 付

け、 蝶ネジを 固定し ます ( アイ テム3) 。

スイ ッ チを ラ ッ ク から 取り 外すには次の手順を 実行し ます。
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1 蝶ネジを 外し 、 ト ラ ベル・ス ト ッ プに達する まで、 スイ ッ チ ・

アッ セン ブ リ ーを ラ ッ ク から 引き 出し ます。 ト ラ ベルスト ッ プ

の位置は、 レ ールグリ ッ プの位置を 変える ためのも のであり 、

修理・交換の対象と はし ていません。

2 スイ ッ チ ・レ ールの側面にある 青いタ ブを 見つけます ( アイ テ

ム4) 。

3 タ ブを 内側に押し て、 スイ ッ チ ・レ ールがReadyRailsアッ セン ブ

リ ーから 完全に離れる までアッ セン ブ リ ーを 引き ます。

1U前面ラ ッ ク の設置

設置する 前に、 スイ ッ チに取り 付けら れている レ ールを 再構成する

必要があり ます。

1 各スイ ッ チ ・レ ールで、 前面スタ ン ド オフ の下にある タ ブを 持ち

上げ、 スイ ッ チから レ ールを 持ち 上げながら レ ールを 前方にス

ラ イ ド さ せます ( 図 2.6、 アイ テム1) 。
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図 2.6. スイ ッ チ ・レ ールの回転

2 各レ ールを 180°回転さ せ ( アイ テム2) 、 各レ ールを スイ ッ チに

再度取り 付けます ( アイ テム3) 。

3 ReadyRailsシステムでのスイ ッ チ ・アッ セン ブ リ ーの挿入と 取り 外

し については、 1U背面ラ ッ ク の手順を 参照し て く ださ い。

注： こ の構成ではブラ ンク ・パネルは必要あり ません。

0U RCSの設置

1 0U取り 付け用ブラ ケッ ト を スイ ッ チ ・レ ールに揃えて取り 付けま

す ( 図 2.7、 アイ テム1) 蝶ネジを 締めます ( アイ テム2) 。

2 取り 付け用ブラ ケッ ト のフ ッ ク を ラ ッ ク の穴に挿入し 、 青いボ

タ ン が飛び出し てブラ ケッ ト が所定の位置にロ ッ ク さ れる まで

押し 下げます。
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図 2.7. 0Uの設置

スイ ッ チ ・アッ セン ブ リ ーを 取り 外すには、 青いボタ ン ( アイ テ

ム3) を 押し てブラ ケッ ト の固定を 外し 、 アッ セン ブ リ ーを ポスト

から 持ち 上げます。

RCSハード ウェ アの接続

次の図は、 RCSハード ウェ アの構成の一例です。
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図 2.8. 基本的な RCS構成

表 2.1: 基本的な RCS構成の説明

番号 説明 番号 説明

1 ジャ ンパー・コ ード 7 外部バーチャ ル・メ ディ ア
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番号 説明 番号 説明

2 アナログ・ユーザー 8 電源管理装置

3 モデム 9 SIP

4 電話回線ネッ ト ワーク 10 タ ーゲッ ト ・デバイ ス

5 ネッ ト ワーク 11 RCS( 表示は32ポート ・モデル)

6 デジタ ル・ユーザー

スイ ッ チを 接続し て電源を 投入する には：

注意： 使用機器への感電や損傷のリ スク を抑えるため、 ジャ ンパー・

コ ード の接地プラ グは無効にせずにそのまま使用し てく ださ い。 接地プ

ラ グは安全上重要な役割を果たし ます。 ジャ ンパー・コ ード は、 常に容易

にアク セスできる接地処理さ れたコ ンセント に差し 込んでく ださ い。 装

置の電源を切る際は、 電源または装置のどちら かの側でジャ ンパー・コ ー

ド を引き抜いてく ださ い。

注： 建物に 3相AC電源がある場合は、 コ ンピュ ータ ーと モニタ ーが同じ 相
になっ ているこ と を確認し ます。 相が異なっ ていると 、 こ れが原因でビ
デオやキーボード の機能が正し く 作動し ないこ と があり ます。

注： スイ ッ チと デバイ ス間のケーブル長は30 mまではサポート さ れま
す。

• 電源の接地プラ グを 無効にし ないでく ださ い。 接地プラ グ

は安全上重要な役割を 果たし ます。

• ジャ ン パー・コ ード は、 常に容易にアク セスでき る 接地処理

さ れたコ ン セン ト に接続し て く ださ い。

• 製品の電源を 切る 際は、 電源または製品のどち ら かの側で

ジャ ン パー・コ ード を 引き 抜いてく ださ い。

• 本製品を オフ にする には、 通常、 ACコ ン セン ト から コ ード

を 抜いてく ださ い。 AC電源取入口が複数ある 製品の場合
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は、 電源を 完全に取り 除く ために、 すべてのACコ ード の接

続を 外し て く ださ い。

• 本製品の筐体内には、 ユーザーが修理でき る 部品はあり ませ

ん。 製品のカ バーを 開けたり 取り 外し たり し ないで く ださ

い。

1 VGAモニタ ー、 USBキーボード 、 およ びマウスのケーブルを ラ ベ

ル付き の適切なポート に接続し ます。

2 UTPケーブル ( 4ペア、 最長45 m) の一方の端を 、 番号が付いた

利用可能なポート に接続し ます。 も う 一方の端を SIPのRJ-45コ
ネク タ ーに接続し ます。

3 SIPを タ ーゲッ ト ・デバイ スの背面にある 適切なポート に接続し ま

す。 接続する すべてのタ ーゲッ ト ・デバイ スについて手順2と 3を
繰り 返し ます。

注： Sun Microsystemsのタ ーゲッ ト ・デバイ スに接続する際は、 VGAと Sync
on Greenの両方またはComposite Sync( 複合同期) 機能を備えたSunコ ン
ピュ ータ ーに対応するため、 ローカ ル・ポート で必ずマルチシンク ・モニ
タ ーを使用し てく ださ い。

4 ユーザーが用意し た UTPケーブルを イ ーサネッ ト ・ネッ ト ワーク か

ら RCS背面のLANポート に接続し ます。 ネッ ト ワーク ・ユーザーは

こ のポート を 介し て RCSにアク セスし ます。 冗長LANポート を 個

別のイ ーサネッ ト ・スイ ッ チに差し 込むと 、 1つのイ ーサネッ ト ・

スイ ッ チが故障し た場合の冗長性が高まり ます。

5 ( オプショ ン ) スイ ッ チは、 ITU V.92、 V.90、 またはV.24に対応

する モデムを 使用し ても アク セスでき ます。 RJ-45ケーブルの一

方の端を スイ ッ チのモデム・ポート に接続し ます。 も う 一方の端

を 付属のRJ-45/DB-9( オス ) 変換アダプタ ーに接続し 、 次にこ の

アダプタ ーを モデム背面にある 適切なポート に接続し ます。

注： LAN接続ではなく モデム接続を使用し た場合、 スイ ッ チの性能は制
限さ れます。

6 ( オプショ ン ) サポート 対象のPDUを RCSに接続する には、 CAT
5ケーブルの一方の端を スイ ッ チのPDU1ポート に接続し ます。
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も う 一方の端を PDUに接続し ます。 タ ーゲッ ト ・デバイ スから の

電源コ ード を PDUに接続し ます。 PDUを 電源に接続し ます。 必

要に応じ て、 同じ 手順で PDU2ポート を も う 1台のPDUに接続し

ます。

7 各タ ーゲッ ト ・デバイ スを オン にし 、 次にスイ ッ チに付属のジャ

ン パー・コ ード を 取り 出し ます。 スイ ッ チ背面にある 電源ソ ケッ

ト にコ ード の一方の端を 接続し ます。 も う 一方の端を 適切な電

源に接続し ます。 デュ アル電源が装備さ れている RCSを 使用す

る 場合、 2番目のジャ ン パー・コ ード を 使用し て RCSの背面にあ

る 2番目の電源ソ ケッ ト に接続し 、 も う 一方の端を 別の電源に

差し 込みます。

注： 冗長電源を個別の分岐回路に差し 込むと 、 外部AC電源が切れた場合
の冗長性が高まり ます。

8 ( オプショ ン ) バーチャ ル・メ ディ ア ・デバイ スまたはスマート ・

カ ード ・リ ーダーを スイ ッ チの任意のUSBポート に接続し ます。

注： すべてのバーチャ ル・メ ディ ア・セッ ショ ンには、 USB2またはUSB2お
よびCAC用SIPを使用する必要があり ます。

SIPの接続

SIPを 各サーバーに接続する には：

1 お使いのRCS用のSIPを 見つけます。

2 PS／2 SIP接続を 使用し ている 場合、 こ のRCSに接続する 最初の

サーバーのキーボード 、 マウス、 モニタ ーの適切なポート に、 SIP
ケーブルの色別さ れた両端を 接続し ます。 USB接続を 使用し て

いる 場合、 こ のRCSに接続する 最初のサーバーのUSBポート

に、 SIPから プラ グを 接続し ます。

3 SIPのRJ-45コ ネク タ ーに、 SIPから RCSに延びる CAT 5ケーブル配

線の一方の端を 接続し ます。 図 2.9を 参照し て く ださ い。

4 CAT 5ケーブルのも う 一方の端を 、 RCS背面にある 目的のAvocent
Rack Interface( ARI) ポート に接続し ます。

5 接続する サーバーすべてで 2～4の手順を 繰り 返し ます。
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注： 使用する前にRCSの電源を切り ます。 必ず、 ジャ ンパー・コ ード を電
源から 抜いてく ださ い。

注： RCSのデバイ スへの接続には、 Dell SIPのほかに、 Avocent IQモジュ ー
ル( Sunモジュ ールおよびシリ アルIQモジュ ールを含む ) を使用するこ と
も できます。

図 2.9. SIP接続

表 2.2: 図 2.9の説明

番号 説明

1 CAT 5

2 USB接続

3 VGA接続



設置 | 33

UTPコ ネク タ ーを 使用し て SIPを シリ アル・デバイ スに接続する には

次の手順を 実行し ます。

1 SIPのRJ-45コ ネク タ ーを シリ アル・デバイ スに接続し ます。

-または -
SIPを RJ-45／9ピ ン ( メ ス ) 変換アダプタ ーに接続し ます。 ア

ダプタ ーを シリ アル・デバイ スのシリ アル・ポート に接続し ま

す。

2 UTPケーブル ( 4ペア、 最長45 m) の一方の端を 、 スイ ッ チの背

面にある 番号が付いた利用可能なポート に接続し ます。 も う 一

方の端を SIPのRJ-45コ ネク タ ーに接続し ます。

3 USB／バレ ル間電源コ ード を SIPの電源コ ネク タ ーに接続し ま

す。 USB／バレ ル間電源コ ード のUSBコ ネク タ ーを 、 シリ アル・

タ ーゲッ ト ・デバイ スの任意の使用可能な USBポート に接続し ま

す。

ティ アド ・スイ ッ チの追加

注： RCSはEL80-DTをサポート し ていません。

注： M1000eモジュ ラ ー・エンク ロジャ ーは、 ティ アド 構成に対応し ていま
す。 CAT 5ケーブルの一端を、 RCSスイ ッ チのタ ーゲッ ト ・ポート に接続し
ます。 も う 一方の端を、 M1000eシャ ーシの後部にある iKVMモジュ ール
のPJ45ポート と 互換性のあるアナログ・コ ンソ ール・イ ンタ ーフ ェ イ ス
( ACI) に取り 付けます。 M1000eモジュ ール・エンク ロージャ ーの構成部品
に対するフ ァ ームウェ アのアッ プデート は、 こ のティ アド 構成を介し て
はできません。

スイ ッ チを 2レ ベルまでテ ィ ア接続し て、 ユーザーを 最大1024台の

サーバーに接続でき ます。 テ ィ アド ( 階層形式 ) システムでは、 メ

イ ン ・スイ ッ チの各タ ーゲッ ト ・ポート を 、 各テ ィ アド ・スイ ッ チ

のACIポート に接続し ます。 各テ ィ アド ・スイ ッ チは、 SIPまた

はAvocent IQモジュ ールが接続さ れている デバイ スに接続でき ま

す。

複数のスイ ッ チを テ ィ ア接続する には次の手順を 実行し ます。
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1 UTPケーブルの一端を スイ ッ チのタ ーゲッ ト ・ポート に接続し ま

す。

2 UTPケーブルのも う 一方の端を 、 テ ィ アド ・スイ ッ チの背面にあ

る ACIポート に接続し ます。

3 テ ィ アド ・スイ ッ チにデバイ スを 接続し ます。

4 システムに接続する すべてのテ ィ アド ・スイ ッ チに対し て、 こ

の手順を 繰り 返し ます。

注： システムが自動的に 2つのスイ ッ チを統合し ます。 ローカ ルUIのメ イ
ン ・スイ ッ チの一覧には、 ティ アド ・スイ ッ チに接続さ れているすべての
スイ ッ チが表示さ れます。

注： スイ ッ チは、 メ イ ン ・スイ ッ チのタ ーゲッ ト ・ポート ごと に 1つのティ
アド ・スイ ッ チをサポート し ています。 ティ アド ・スイ ッ チに、 スイ ッ チ
を接続するこ と はできません。

注： RCSでカ スケード 接続を行う 場合、 8ポート または16ポート のアナロ
グ・コ ンソ ール・スイ ッ チはティ アド 構成のプラ イ マリ ー・ユニッ ト と し
ては使用できません。 RCSはプラ イ マリ ー・ユニッ ト である必要があり ま
す。
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図 2.10. UTPアナロ グ・スイ ッ チと のRCSのティ ア接続

表 2.3: 図 2.10の説明

番号 説明

1 ローカ ル・ユーザー

2 ARI接続

3 UTP接続

4 ACI接続
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レガシー・スイ ッ チでのカ スケード 接続

レ ガシー・スイ ッ チ ( オプショ ン ) を 追加する には：

1 スイ ッ チを ラ ッ ク に収納し ます。 RCSと レ ガシー・スイ ッ チを 接

続する UTPケーブルを 用意し ます。

2 UTPケーブルの一端を コ ン ソ ール・スイ ッ チのARIポート に接続し

ます。

3 UTPケーブルのも う 一方の端を PS/2 SIPに接続し ます。

4 スイ ッ チ ・メ ーカ ーの推奨事項に従っ て、 SIPを レ ガシー・スイ ッ

チに接続し ます。

5 スイ ッ チに取り 付ける すべてのレ ガシー・スイ ッ チで 1～4の手順

を 繰り 返し ます。

注： RCSはARIポート ごと に 1つのスイ ッ チのみをサポート し ています。 こ
の最初のスイ ッ チの下に他のスイ ッ チをカ スケード 接続するこ と はでき
ません。

注： RCSでカ スケード 接続を行う 場合、 8ポート または16ポート のアナロ
グ・コ ンソ ール・スイ ッ チはプラ イ マリ ー・ユニッ ト と し ては使用できま
せん。 RCSはプラ イ マリ ー・ユニッ ト である必要があり ます。
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図 2.11. レ ガシー・スイ ッ チのカ スケード 接続

表 2.4: 図 2.11の説明

番号 説明

1 ローカ ル・ユーザー

2 ARI接続
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番号 説明

3 PS2接続

4 タ ーゲッ ト 接続

PEM( オプショ ン ) の追加

ポート 拡張モジュ ール ( PEM) によ り 、 各ARIポート を 拡張し て対応

デバイ ス数を 1台から 最大で 8台にする こ と ができ ます。 次の図およ

び図の説明の表を 参照し て く ださ い。

注： PEMは受動的に作動し ます。 従っ て、 PEMに接続さ れたデバイ スの
う ちの1台にユーザーがアク セスすると 、 その後にこ のPEMに接続さ れて
いる他のデバイ スのいずれかに他のユーザーがアク セスし よう と し ても
すべてブロッ ク さ れます。

注： PEMが働いている状態でのVMまたはCAC SIPの使用はサポート さ れて
いません。

注： ト ゥ ルー・シリ アルSIPはPEMが働いている状態では作動し ません。

PEM( オプショ ン ) を 追加する には次の手順を 実行し ます。

1 PEMを ラ ッ ク に収納し ます。 UTPケーブルは9本まで使用でき ま

す。 こ のう ち の1本はRCSを PEMに接続する ために使用し 、 他

の8本は各デバイ スに接続さ れている SIPに PEMを 接続する ため

に使用し ます。

2 PEMと RCSを つなぐ UTPケーブルの一方の端を 、 PEM上の他のコ

ネク タ ーから は若干離れた位置のRJ-45コ ネク タ ーに接続し ま

す。 UTPケーブルのも う 一方の端を 、 RCSの後面にある 目的

のARIポート に接続し ます。

3 PEM背面に並んでいる 8つのRJ-45コ ネク タ ーのいずれか1つ
に、 PEMと 各デバイ スのSIPを つなぐ UTPケーブルを 接続し ま

す。

4 UTPケーブルのも う 一方の端を 最初のSIPに接続し ます。

5 接続し たいデバイ スのすべてで 3～4の手順を 繰り 返し ます。
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図 2.12. PEMと のRCS構成

表 2.5: 図 2.12の説明

番号 説明

1 ARIポート

2 UTP

3 PEM

4 SIPまたはAvocent IQモジュ ール

5 サーバー
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Remote Console Switchの構成

すべての物理接続が完了し たら 、 スイ ッ チ ・システム全体で使用す

る ためにスイ ッ チを 構成する 必要があり ます。 こ れを 実行する に

は2つの方法があり ます。

Avocent管理ソ フ ト ウェ アを 使用し てスイ ッ チを 構成する には、 ご

使用の製品の『 イ ン スト ーラ ／ユーザー・ガイ ド 』 掲載の詳細な手順

を 参照し て く ださ い。

ロ ーカ ルUIを 使用し てスイ ッ チを 構成する には次の手順を 実行し ま

す。

ロ ーカ ルUIを 使用し て最初のネッ ト ワーク ・セッ ト アッ プを 構成す

る 詳細な手順については、 「 ネッ ト ワーク 設定」 ( ページ 61) を 参

照し て く ださ い。

組み込みWebサーバーの設定

組み込みWebサーバーを 使用し てスイ ッ チにアク セスし て、 スイ ッ

チに関する 日常作業のほと んどを 処理でき ます。 Webサーバーを 使

用し てスイ ッ チにアク セスする 前に、 まずスイ ッ チの背面パネルに

ある SETUPポート またはロ ーカ ルUIを 介し て IPアド レ スを 指定し ま

す。 スイ ッ チのユーザー・イ ン タ ーフ ェ イ スを 使用する 詳細な手順に

ついては、 第3章を 参照し て く ださ い。

フ ァ イ アウォ ールを使っ たOBWIへの接続

アク セスにOBWIを 使用する スイ ッ チの設置では、 外部にアク セス

する 必要がある 場合は、 フ ァ イ ヤーウォ ールで次のポート が開いて

いる 必要があり ます。
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ポート

番号
機能

TCP 22 SIPへのシリ アル・セッ ショ ンのSSHに使用さ れます。

TCP 23 ( Telnetが有効な場合) Telnetに使用さ れます。

TCP 80
ビデオ・ビュ ーアの最初のダウンロード に使用さ れます。 RCS管理

者はこ の値を変更できます。

TCP 443
スイ ッ チの管理と KVMセッ ショ ンの起動を行う Webブラ ウザ・イ ン

タ ーフ ェ イ スに使用さ れます。 RCS管理者はこ の値を変更できま

す。

TCP 2068
スイ ッ チでのKVMセッ ショ ン ・データ ( マウス／キーボード ) の伝

送またはビデオの伝送に使用さ れます。

TCP/UDP
3211

検出用です。

TCP 389
( オプショ ン ) LDAP Directory Servicesによっ て使用さ れる - 標準

アク セス・ポート

TCP 636
( オプショ ン ) LDAP Directory Servicesによっ て使用さ れる - セキュ

ア／SSLポート

TCP 3268
( オプショ ン ) Microsoft Active Directory Servicesによっ て使用さ れる

- 標準アク セス・ポート

TCP 3269
( オプショ ン ) Microsoft Active Directory Servicesによっ て使用さ れる

- セキュ ア／SSLアク セス・ポート

表 2.6: フ ァ イ ヤーウォ ールでのOBWIポート

次の図と 表は一般的な構成を 示し ます。 こ の構成では、 ユーザーの

コ ン ピ ュ ータ ーはフ ァ イ ヤーウォ ールの外側に位置し 、 スイ ッ チは

フ ァ イ ヤーウォ ールの内側に位置し ます。
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図 2.13. 一般的な RCSフ ァ イ ヤーウォ ールの構成

表 2.7: 図 2.13の説明

番

号
説明

1 RCS

2 フ ァ イ アウォ ール

3 ユーザーのコ ンピュ ータ ー

4
フ ァ イ ヤーウォ ールはHTTP要求と KVMト ラ フ ィ ッ ク をスイ ッ チへ転送

し ます。

5 ユーザーはフ ァ イ ヤーウォ ールの外部IPアド レスを参照し ます。

フ ァ イ ヤーウォ ールを 構成する には次の手順を 実行し ます。

フ ァ イ ヤーウォ ールの外側から スイ ッ チにアク セスする には、 フ ァ

イ ヤーウォ ールの内部イ ン タ ーフ ェ イ スを 介し て、 外部イ ン タ ー

フ ェ イ スから KVMスイ ッ チにポート 22、 23( Telnetが有効な場
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合 ) 、 80、 443， 2068、 3211が転送さ れる よ う にフ ァ イ ヤーウォ ール

を 構成し ます。 フ ァ イ ヤーウォ ールの特定ポート の転送手順につい

ては、 マニュ アルを 参照し て く ださ い。

注： 管理者はポート 80と 443を再構成できます。

OBWIの起動の詳細については、 「 OBWI」 ( ページ 49) を 参照し て

く ださ い。

接続の確認

リ ア・パネルのイ ーサネッ ト 接続LED

RCSのリ ア ・パネルには、 イ ーサネッ ト LAN1の接続状態を 示すLED
と 、 イ ーサネッ ト LAN2の接続状態を 示すLEDがそれぞれ2つあり ま

す。

• ネッ ト ワーク への有効な接続が確立さ れる と 緑のLEDが点灯

し 、 ポート にアク テ ィ ビ テ ィ がある と き は点滅し ます。

• 両色LEDは、 緑または黄色に点灯し ます。

• 通信速度が1000Mの時には緑色に点灯し ます。

• 通信速度が100Mの時には黄色に点灯し ます。

• 通信速度が10Mの時には点灯し ません。

リ ア・パネルの電源状態LED

各RCSのリ ア ・パネルには、 電源LEDが電源ごと に 1つあり ます。

デュ アル電源モデル ( 16ポート およ び 32ポート ) には電源LEDが2つ
あり 、 8ポート ・モデルのLEDは1つのみです。 スイ ッ チに電源が入

り 正常に動作し ている と き 、 LEDは緑に点灯し ます。

• 電源が入っ ていなかっ たり 、 エラ ーが発生する と 、 LEDはオフ

になり ます。

• ユニッ ト が準備完了になる と 、 LEDは点灯し ます。
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• スイ ッ チの起動中またはアッ プグレ ード 処理中は、 LEDは点滅

し ます。

• 電源エラ ー、 周辺温度の上昇、 フ ァ ン のエラ ーなどの障害が検

出さ れたと き 、 LEDは「 SOS」 を 点滅し ます。 障害が続く 限

り 、 LEDは「 SOS」 を 点滅し 続けます。

モジュ ールの電源が失われた場合、 スイ ッ チは接続さ れている デバ

イ スから のシリ アル・ブレ ーク を 防止し ます。 ただし 、 シリ アル・

セッ シ ョ ン ・ビ ュ ーアのシリ アル・ブレ ーク を 押すこ と によ り 、 接続

さ れている デバイ スでシリ アル・ブレ ーク を 生成でき ます。

タ ーゲッ ト ・デバイ ス のマウス設定の調
整

スイ ッ チに接続し たコ ン ピ ュ ータ ーを リ モート ・ユーザー制御用に使

用する には、 タ ーゲッ ト ・マウスの速度の設定を 行い加速を オフ に

する 必要があり ます。 Microsoft® Windows®( Windows
NT®、 2000、 XP、 Server 2003) を 稼動し ている マシン では、 デフ ォ

ルト のPS/2マウス ・ド ラ イ バーを 使用し て く ださ い。

ロ ーカ ル・マウスの動き と リ モート ・カ ーソ ルの表示の間で同期が保

たれる よ う に、 KVMスイ ッ チを 介し てリ モート ・システムにアク セ

スする すべてのユーザー・アカ ウン ト では、 マウス加速度を 「 な

し 」 に設定する 必要があり ます。 また、 マウス加速度は、 各リ モー

ト ・システムで 「 なし 」 に設定する 必要があり ます。 特殊なカ ーソ

ルは使用し ないでく ださ い。 また、 カ ーソ ルの表示 ( ポイ ン タ ーの

軌跡、 Ctrlキーでカ ーソ ルの位置表示、 アニメ ーショ ン 、 カ ーソ ルの

影の有効、 カ ーソ ルの非表示など ) のオプショ ン も オフ にし て く だ

さ い。
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注： Windowsオペレーティ ング・システムから マウス加速度を無効にでき
ない場合や、 すべてのタ ーゲッ ト ・デバイ スの設定を変更し たく ない場
合は、 ビデオ・ビュ ーア・ウィ ンド ウにある Tools→ Single Cursor Modeコ マンド
を使用できます。 こ のコ マンド により 、 ビデオ・ビュ ーア・ウィ ンド ウが
「 透明マウス」 モード になり ます。 こ れにより 、 表示し ているタ ーゲッ
ト ・システムのマウス・ポイ ンタ ーと ク ラ イ アント ・コ ンピュ ータ ーのマウ
ス・ポイ ンタ ーの制御と を手動で切り 替えるこ と ができます。
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ロ ーカ ルおよ びリ モ ート の構
成

RCSには、 「 ポイ ン ト ・アン ド ・ク リ ッ ク 」 イ ン タ ーフ ェ イ スであ

る 、 ロ ーカ ル・ユーザー・イ ン タ ーフ ェ イ ス ( ロ ーカ ルUI) およ びリ

モート OBWIが備えら れています。 こ れら のイ ン タ ーフ ェ イ スで利

用でき る 構成オプショ ン を 使用し て、 特定のアプリ ケーショ ン に合

わせてスイ ッ チを 調整し たり 、 接続デバイ スを 制御し たり 、 すべて

の基本的な KVMまたはシリ アル・スイ ッ チのニーズを 処理し たり で

き ます。

注： ローカ ルUIと リ モート OBWIはほと んど同じ も のです。 指定がない限
り 、 こ の章のすべての情報は両方のイ ンタ ーフ ェ イ スに適用さ れます。

どち ら のイ ン タ ーフ ェ イ スから も 、 2種類のセッ シ ョ ン を 起動でき

ます。

• ビ デオ・ビ ュ ーア ・ウイ ン ド ウでは、 スイ ッ チに接続さ れた個々

のタ ーゲッ ト ・デバイ スのキーボード 、 モニタ ー、 マウスの機能

を リ アルタ イ ムで制御でき ます。 また、 ビ デオ・ビ ュ ーア ・ウィ

ン ド ウ内では、 事前に定義さ れたグロ ーバル・マク ロ を 使用し て

操作を 実行する こ と も でき ます。 ビ デオ・ビ ュ ーアの使用方法に

ついては、 第4章を 参照し て く ださ い。

• シリ アル・ビ ュ ーア ・ウィ ン ド ウでは、 コ マン ド またはスク リ プ

ト を 使用し て、 個々のシリ アル・タ ーゲッ ト ・デバイ スを 管理で

き ます。
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ロ ーカ ル・ユーザー・イ ン タ ーフ ェ イ ス
( UI)
スイ ッ チの背面にはロ ーカ ル・ポート があり ます。 こ のポート を 使用

し てキーボード 、 モニタ ー、 およ びマウスを スイ ッ チに直接接続し

て、 ロ ーカ ルUIを 使用でき ます。

次の任意のキースト ロ ーク を 選択し て構成し 、 ロ ーカ ルUIを 開いた

り 、 ロ ーカ ルUIと アク テ ィ ブ ・セッ シ ョ ン 間を 切り 替える よ う にで

き ます。 使用でき る キースト ロ ーク は、 <Print Screen>、 <Ctrl +
Ctrl>、 <Shift + Shift>、 <Alt + Alt>です。 デフ ォ ルト

は<PrintScreen>と <Ctrl-Ctrl>です。

ロ ーカ ルUIを 起動する には次の手順を 実行し ます。

1 モニタ ー、 キーボード 、 マウスのケーブルを スイ ッ チに接続し ま

す。 詳細については、 「 RCSハード ウェ アの接続」 ( ページ

27) を 参照し て く ださ い。

2 任意の有効なキースト ロ ーク を 押し て、 ロ ーカ ルUIを 起動し ま

す。

3 ロ ーカ ルUI認証が有効にさ れている 場合は、 ユーザー名と パス

ワード を 入力し ます。

注： スイ ッ チがAvocent管理ソ フ ト ウェ ア・サーバーに追加さ れている場合
は、 ユーザー認証のために、 Avocent管理ソ フ ト ウェ ア・サーバーにアク セ
スし ます。 スイ ッ チがAvocent管理ソ フ ト ウェ ア・サーバーに追加さ れてい
ない場合や、 Avocent管理ソ フ ト ウェ ア・サーバーに接続できない場合は、
ユーザー認証のために、 スイ ッ チのローカ ル・ユーザー・データ ベースに
アク セスし ます。 デフ ォ ルト のローカ ル・ユーザー名はAdminです。 パス
ワード はあり ません。 ローカ ル・ユーザー・データ ベースのユーザー名は、
大文字と 小文字が区別さ れます。

ロ ーカ ル・ポート のユーザー・イ ン タ ーフ ェ イ スに接続さ れたタ ーゲッ

ト ・デバイ スは、 左側ナビ ゲーショ ン ・ツ ールバーから 選択でき る 2つ
の個別の画面から 表示し て管理する こ と ができ ます。 タ ーゲッ ト の

数が20未満の場合は、 「 Target List-Basic」 画面が操作用と し て推奨
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さ れます。 20個以上のタ ーゲッ ト ・デバイ スの場合は、 「 Target List-
Full」 画面で追加の操作ツ ールが提供さ れます。 「 Target List-Full」 画

面では、 ページ番号の入力、 ページ操作ボタ ン の使用、 フ ィ ルタ ー

の使用を 活用する 操作が可能です。 「 Basic」 、 「 Full」 画面のいず

れかを 、 タ ーゲッ ト ・デバイ ス選択用のデフ ォ ルト 画面と し て設定

する こ と ができ ます。

フ ィ ルタ リ ング機能

一致項目を 取得する ために使用する テキスト ・ス ト リ ン グを 入力し

て、 タ ーゲッ ト ・デバイ スのリ スト 情報を フ ィ ルタ リ ン グする こ と

ができ ます。 フ ィ ルタ リ ン グによ っ て、 項目のよ り 短く 、 正確なリ

スト が提供可能になり ます。 フ ィ ルタ リ ン グを 実行する と 、 Name
列を 対象と し て、 指定し たテキスト ・ス ト リ ン グを 検索し ます。 こ

の検索では大文字／小文字を 区別し ません。 フ ィ ルタ リ ン グでは、

テキスト ・ス ト リ ン グの前後にワイ ルド カ ード と し てアスタ リ スク

( *) を 使用する こ と ができ ます。 例えば、 emailserver*と 入力し

て Filterを ク リ ッ ク する と 、 emailserverから 始まる 項目

( emailserver、 emailserverbackupなど ) が表示さ れます。

OBWI
スイ ッ チのOBWIは、 リ モート のWebブラ ウザ・ベースのユーザー・イ

ン タ ーフ ェ イ スです。 システム・セッ ト アッ プの詳細については、

「 RCSハード ウェ アの接続」 ( ページ 27) を 参照し て く ださ い。 次

の表に、 OBWIでサポート さ れている オペレ ーテ ィ ン グ・システムと

ブラ ウザの一覧を 示し ます。 必ず最新バージョ ン のWebブラ ウザを

使用し て く ださ い。
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表 3.1: OBWIでサポート さ れている オペレ ーテ ィ ン グ・システム

オペレーティ ング・システム

ブラ ウザ

Microsoft®

Internet
Explorerバー

ジョ ン 6.0 SP1
以降

Firefox
バー

ジョ

ン 2.0
以降

Microsoft Windows 2000 WorkstationまたはServer
( Service Pack 2)

はい はい

Microsoft Windows Server® 2003 Standard、 Enterpriseま
たはWeb Edition

はい はい

Microsoft Windows Server® 2008 Standard、 Enterpriseま
たはWeb Edition

はい はい

Windows XP Professional( Service Pack 3) はい はい

Windows Vista® Business( Service Pack 1) はい はい

Red Hat Enterprise Linux® 4および5 Standard、 Enterprise
またはWeb Edition( スマート ・カ ード はオペレー

ティ ング・システムでサポート さ れていない場合

があり ます )

いいえ はい

Sun Solaris® 9および10( スマート ・カ ード はオペ

レーティ ング・システムでサポート さ れていない場

合があり ます )
いいえ はい

Novell SUSE Linux Enterprise 10および11( スマート ・

カ ード はオペレーティ ング・システムでサポート さ

れていない場合があり ます )
いいえ はい

Ubuntu 8 Workstation( スマート ・カ ード はオペレー

ティ ング・システムでサポート さ れていない場合

があり ます )
いいえ はい
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スイ ッ チのOBWIにロ グイ ン する には：

1 Webブラ ウザを 起動し ます。

2 ブラ ウザのアド レ ス欄に、 アク セスする スイ ッ チに割り 当てら

れている IPアド レ スまたはホスト 名を 入力し ます。

「 http://xxx.xx.xx.xx」 または「 https://xxx.xx.xx.xx」 の形式を 使用し て

く ださ い。

注： IPv6モード を使用し ている場合は、 IPアド レスを角括弧で囲む必要が
あり ます。 「 http://[<ipaddress-] 」 の形式を使用し ます。

3 ブラ ウザがスイ ッ チに接続さ れたら ユーザー名と パスワード を 入

力し 、 Loginを ク リ ッ ク し ます。 スイ ッ チのOBWIが表示さ れま

す。

注： デフ ォ ルト のユーザー名はAdminです。 パスワード は必要あり ませ
ん。

フ ァ イ ヤーウォ ールの外側から スイ ッ チのOBWIにロ グイ ン する に

は、 上記の手順を 繰り 返し 、 代わり にフ ァ イ ヤーウォ ールの外部 IP
アド レ スを 入力し ます。

注： RCSは、 お使いのコ ンピュ ータ ーにJavaがすでにイ ンスト ールさ れて
いるかどう か、 検出を試みます。 イ ンスト ールさ れていない場合、 OBWI
を使用するにはイ ンスト ールが必要です。 また、 JNLPフ ァ イ ルを Java
WebStartに関連付ける必要も あり ます。

注： OBWIを使用するには、 Java Runtime Environment( JRE) バージョ
ン 1.6.0_11以降が必要です。

注： OBWIにいっ たんログイ ンすると 、 ログアウト するか、 セッ ショ ンの
アイ ド ル時間が管理者指定のタ イ ムアウト を超過し た場合を除いて、 新
規セッ ショ ンを起動する際にログイ ンし なおす必要はあり ません。

ユーザー・イ ン タ ーフ ェ イ ス の使用

認証後に、 ユーザー・イ ン タ ーフ ェ イ スが表示さ れます。 こ こ では、

スイ ッ チの表示、 アク セス、 管理を 行っ たり 、 システム設定の指定

と プロ フ ァ イ ル設定の変更を 行う こ と ができ ます。 次の図に、 ユー
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ザー・イ ン タ ーフ ェ イ スのウィ ン ド ウ領域を 示し ます。 画面の説明

を 、 続く 表に示し ます。

図 3.1. ユーザー・イ ン タ ーフ ェ イ ス ・ウィ ン ド ウ

表 3.2: ユーザー・イ ン タ ーフ ェ イ スの説明

番

号
説明

1
ト ッ プ ・オプショ ン ・バー： ト ッ プ ・オプショ ン ・バーを使用し て、 テク

ニカ ル・サポート に連絡し たり 、 ソ フ ト ウェ アの一般情報を表示し た

り 、 OBWIセッ ショ ンから ログアウト し たり し ます。

2
2番目のオプショ ン ・バー： こ のバーを使用し て、 Webページを印刷し た

り 、 現在のWebページを更新し たり 、 ヘルプ・ツールにアク セスし たり

し ます。



ローカ ルおよびリ モート の構成 | 53

番

号
説明

3
バージョ ン ・ブロッ ク ： 製品のフ ァ ームウェ アのバージョ ンと 現在ログ

イ ンし ているユーザー名が、 ト ッ プ ・オプショ ン ・バーの左側に表示さ れ

ます。

4
サイ ド ・ナビゲーショ ン ・バー： サイ ド ・ナビゲーショ ン ・バーを使用し

て、 表示する情報を選択し ます。 サイ ド ・ナビゲーショ ン ・バーでは、 設

定の変更や操作を実行するためのウィ ンド ウを表示できます。

5
ナビゲーショ ン ・タ ブ ： 選択し たタ ブのコ ンテンツ領域にシステム情報

が表示さ れます。 一部のタ ブにはサブタ ブがあり 、 ク リ ッ ク し て表示

し 、 カ テゴリ ー内の詳細を変更できます。

6
コ ンテンツ領域： コ ンテンツ領域を使用し て、 スイ ッ チのOBWIシステ

ムを表示し たり 、 変更し たり するこ と ができます。

セッ シ ョ ン の起動

注： セッ ショ ンを起動するには、 Java 1.6.0_11以降が必要です。

セッ シ ョ ン を 起動する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Target Listを 選択し ます。 利用

可能なデバイ スの一覧が表示さ れます。

2 Action列に、 KVMセッ シ ョ ン またはシリ アル・セッ シ ョ ン のう ち

適用可能な操作が表示さ れます。 適用可能な操作は、 セッ シ ョ

ン を 起動する よ う に選択し たタ ーゲッ ト ・デバイ スによ っ て異な

り ます。 指定し たタ ーゲッ ト ・デバイ スに適用可能な操作が複数

ある 場合は、 ド ロ ッ プダウン 矢印を ク リ ッ ク し て、 一覧から 適

用する 操作を 選択し ます。

タ ーゲッ ト ・デバイ スが使用中の場合、 プ リ エン プ ト 操作のレ ベル

が現在のユーザーのレ ベルと 同等またはそれ以上であれば、 デバイ

スに強制的に接続し てアク セスでき ます。
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また、 RCSでは外部TelnetまたはPuTTYなどのSSHアプリ ケーショ ン

を 介し て、 シリ アルSIPへのシリ アル・セッ シ ョ ン を 行えま

す。 Telnetおよ び SSHのセッ シ ョ ン はシリ アルSIPへの接続にのみ使

用さ れ、 RCSまたはKVMのタ ーゲッ ト ・デバイ スへのアク セスまたは

管理には使用でき ません。

TelnetまたはSSHアプリ ケーショ ン から シリ アル・セッ シ ョ ン を 起動

する には次の手順を 実行し ます。

1 シリ アルSIPが接続さ れている RCSホスト IPアド レ スを 入力し ま

す。

2 <RCSユーザー名>:<シリ アルSIP名>、 たと えば、 jsmith:routerを
入力し ます。

3 RCSユーザーのパスワード を 入力し ます。

注： Telnet機能はデフ ォ ルト では無効です。 Telnetサポート を有効にする
には、 「 シリ アル・セッ ショ ンの構成」 ( ページ 85) を参照し てく ださ
い。

ロ ーカ ルUIから アク テ ィ ブなセッ シ ョ ン に切り 替える には ( ロ ーカ

ル・ユーザーのみ ) ：

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Local Sessionを 選択し ます。

2 Resume Active Sessionチェ ッ ク ボッ ク スを オン にし ます。 「 ビ デ

オ・ビ ュ ーア 」 ウィ ン ド ウが表示さ れます。

スキャ ン ・ モ ード

スキャ ン ・モード では、 スイ ッ チによ り 複数のタ ーゲッ ト ・デバイ ス

がスキャ ン さ れます。 スキャ ン は、 一覧内でタ ーゲッ ト ・デバイ ス

が表示さ れている 順序に従っ て実行さ れます。 また、 スキャ ン が一

覧の次のタ ーゲッ ト ・デバイ スに移動する までの時間を 設定でき ま

す。

注： モデム経由で接続し ている場合、 「 Scan」 ボタ ンは無効です。
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スキャ ン ・リ ス ト にタ ーゲッ ト ・デバイ スを 追加する には

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Unit View → TTarget Listの順

に選択し て、 Target Devices画面を 開き ます。

2 スキャ ン する タ ーゲッ ト ・デバイ スの横にある チェ ッ ク ボッ ク ス

を オン にし ます。

3 スキャ ン を ク リ ッ ク し ます。

スキャ ン 時間を 構成する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Local Port UIの順に選

択し て、 Local Port UI Settings画面を 開き ます。

2 「 スキャ ン ・モード 」 ヘッ ダーの下で、 「 Scan Time」 フ ィ ールド

に時間を 秒単位 ( 3～255) で入力し ます。

3 Saveを ク リ ッ ク し ます。

シス テム情報の表示

ユーザー・イ ン タ ーフ ァ イ スの以下の画面では、 スイ ッ チおよ びタ ー

ゲッ ト ・デバイ スの情報を 表示する こ と ができ ます。

表 3.3: システム情報

カ テゴリ
操作画面

の選択順
表示内容

RCS
Unit View→

RCS→ Tools

RCS名と タ イ プ、 RCSツール

( メ ンテナンス、 診断、 証明

書およびと ト ラ ッ プMIB)

Unit View→

RCS→ Files

RCS構成、 ユーザー・データ

ベース、 およびタ ーゲッ ト ・デ

バイ ス
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カ テゴリ
操作画面

の選択順
表示内容

Unit View→

RCS→

Properties→

Identity

部品番号、 シリ アル番号、 お

よびEID

Unit View→

RCS→

Properties→

Location

サイ ト 、 部門およびロケー

ショ ン

Unit View→

RCS Settings

→ Versions

現在のアプリ ケーショ ンおよ

びブート ・バージョ ン

タ ーゲッ

ト ・デバ

イ ス

Unit View→

Target

Devices

接続さ れているタ ーゲッ ト ・デ

バイ スの一覧、 なら びに、 名

前、 タ イ プ、 状態、 および各

デバイ スの操作

以下の追加情報を表示するに

は、 タ ーゲッ ト ・デバイ スをク

リ ッ ク し ます： 名前、 タ イ

プ、 EID、 使用できるセッ ショ

ン ・オプショ ンおよび接続パ

ス

RCSツ ール

Tools → Maintenance → Overview画面では、 アプラ イ アン ス名と タ イ

プを 表示でき ます。 また、 基本的なアプラ イ アン ス ・タ スク を 実行

でき ます。
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RCSの再起動

RCSを 再起動する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Unit View → RCS→ Tools →
Maintenance→ Overviewのタ ブの順に選択し て、 Unit Maintenance
画面を 開き ます。

2 Rebootを ク リ ッ ク し ます。

3 ダイ アロ グ・ボッ ク スが表示さ れ、 すべてのアク テ ィ ブ ・セッ

シ ョ ン の接続が解除さ れる こ と を 警告し ます。 OK を ク リ ッ ク し

ます。

注： ローカ ルUIを使用し ている場合、 スイ ッ チの再起動中、 画面は空白
になり ます。 リ モート OBWIを使用し ている場合、 アプラ イ アンスでイ ン
タ ーフ ェ イ スが再起動の完了を待機し ているこ と を通知するメ ッ セージ
が表示さ れます。

RCSフ ァ ームウェ アのアッ プグレード

RCSを 最新のフ ァ ームウェ アにアッ プデート でき ます。

アッ プグレ ード によ り FLASHメ モリ ーが再プロ グラ ムさ れる と 、 ス

イ ッ チはソ フ ト ・リ セッ ト を 実行し 、 すべてのSIPセッ シ ョ ン を 終了

し ます。 タ ーゲッ ト ・デバイ スで SIPのフ ァ ームウェ ア ・アッ プデート

を 実行中の場合に、 表示さ れなく なる か、 または接続さ れていない

と 表示さ れる こ と があり ます。 フ ラ ッ シュ ・アッ プデート が完了す

る と 、 タ ーゲッ ト ・デバイ スは正常に表示さ れる よ う になり ます。

注意： フ ァ ームウェ ア ・アッ プデート 中に SIPの接続を 解除し たり 、

タ ーゲッ ト ・デバイ スのパワー・サイ ク リ ン グ ( 一旦電源を 切っ て入

れ直す ) を 行っ たり する と 、 モジュ ールが作動不能と なり SIPの工

場返送や修理の必要が生じ る 場合があり ます。

スイ ッ チのフ ァ ームウェ アを アッ プグレ ード する には次の手順を 実

行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Unit View → RCS → Tools →
Maintenance → Upgradeのタ ブの順に選択し て、 Upgrade RCS Firmware
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ウィ ン ド ウを 開き ます。

2 Upgradeを ク リ ッ ク し て、 Upgrade Appliance Firmwareを 開き ます。

3 フ ァ ームウェ ア ・フ ァ イ ルを 読み込むには、 次の方法のなかか

ら 1つを 選択し ます： Filesystem、 TFTP、 FTP、 HTTP。

注： 「 Filesystem」 オプショ ンは、 リ モート OBWIでのみ使用できます。

4 Filesystemを 選択し た場合、 Browseを 選択し て、 フ ァ ームウェ ア ・

アッ プグレ ード ・フ ァ イ ルの場所を 指定し ます。

-または -
「 TFTP」 を 選択し た場合、 サーバーの IPアド レ スと 読み込む

フ ァ ームウェ ア ・フ ァ イ ルを 入力し ます。

-または -
「 FTP」 または「 HTTP」 を 選択し た場合、 ユーザー名と ユー

ザー・パスワード 、 およ びサーバーの IPアド レ スと 読み込む

フ ァ ームウェ ア ・フ ァ イ ルを 入力し ます。

5 Upgradeを ク リ ッ ク し ます。

RCSの構成およびRCSユーザー・データ ベースの保存と 復元

スイ ッ チの構成はフ ァ イ ルに保存でき ます。 保存する 構成フ ァ イ ル

内には、 管理アプラ イ アン スに関する 情報が含まれます。 また、 ス

イ ッ チのロ ーカ ル・ユーザー・データ ベースを 保存でき ます。 いずれか

のフ ァ イ ルを 保存後、 以前に保存し た構成フ ァ イ ル、 またはロ ーカ

ル・ユーザー・データ ベース ・フ ァ イ ルを スイ ッ チに復元する こ と も で

き ます。

管理アプラ イ アン スの構成または管理アプラ イ アン スのユーザー・

データ ベースを 保存する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーで、 Unit View → RCS → Filesタ ブを 順

にク リ ッ ク し ます。

2 RCS Configurationタ ブまたはUser Databaseのいずれかを ク リ ッ ク し 、

次に Saveタ ブを ク リ ッ ク し ます。
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3 フ ァ イ ルの保存方法を 、 Filesystem、 TFTP、 FTP、 HTTP PUTか
ら 選択し ます。

4 「 TFTP」 を 選択し た場合、 サーバーIPアド レ スと 読み込む

フ ァ ームウェ ア ・フ ァ イ ル名を 入力し ます。

-または -
「 FTP」 または「 HTTP」 を 選択し た場合、 サーバーIPアド レ

ス、 ユーザー名、 ユーザー・パスワード 、 読み込むフ ァ ーム

ウェ ア ・フ ァ イ ル名を 入力し ます。

5 ダウン ロ ード 前にデータ を 暗号化する 場合は、 暗号化パスワード

を 入力し ます。

6 Downloadを ク リ ッ ク し ます。 「 名前を 付けて保存」 ダイ アロ グ・

ボッ ク スが開き ます。

7 対象の場所に移動し 、 フ ァ イ ルの名前を 入力し ます。 Saveを ク

リ ッ ク し ます。

管理アプラ イ アン スの構成または管理アプラ イ アン スのユーザー・

データ ベースを 復元する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーで、 Unit View → RCS → Filesタ ブを 順

にク リ ッ ク し ます。

2 RCS Configurationタ ブまたはUser Databaseのいずれかを ク リ ッ ク し 、

次に Restoreタ ブを ク リ ッ ク し ます。

3 フ ァ イ ルの保存方法を 、 Filesystem、 TFTP、 FTP、 HTTPから 選択

し ます。

4 Filesystemを 選択し た場合、 Browseを 選択し て、 フ ァ ームウェ ア ・

アッ プグレ ード ・フ ァ イ ルの場所を 指定し ます。

-または -
「 TFTP」 を 選択し た場合、 サーバーIPアド レ スと 読み込む

フ ァ ームウェ ア ・フ ァ イ ル名を 入力し ます。

-または -
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「 FTP」 または「 HTTP」 を 選択し た場合、 サーバーIPアド レ

ス、 ユーザー名、 ユーザー・パスワード 、 読み込むフ ァ ーム

ウェ ア ・フ ァ イ ル名を 入力し ます。

5 Browse を ク リ ッ ク し ます。 対象の場所に移動し 、 フ ァ イ ル名を

選択し ます。 Upload を ク リ ッ ク し ます。

6 元のフ ァ イ ルが暗号化さ れている 場合は、 復号化パスワード を

入力し ます。

7 完了の画面が表示さ れたら 、 管理アプラ イ アン スを 再起動し

て、 復元し た設定を 有効にし ます。 「 RCSの再起動」 ( ページ

57) を 参照し て く ださ い。

FLASHアッ プデート のエラ ーを 復旧する には次の手順を 実行し ま

す。

FLASHの手順後、 RCSが新し いフ ァ ームウェ アのバージョ ン で起動

さ れない場合、 次の手順を 使用し て、 以前のフ ァ ームウェ アのバー

ジョ ン に戻すこ と ができ ます。

1 シリ アル・ケーブルを RCSのリ ア ・パネルにある SETUPポート に接

続し ます。

2 Setupポート に接続さ れている コ ン ピ ュ ータ ーでタ ーミ ナル・プロ

グラ ムを 実行し ます。 こ のシリ アル・ポート の設定は、 9600
ボー、 8データ ・ビ ッ ト 、 1スト ッ プ ・ビ ッ ト 、 パリ テ ィ なし 、 フ

ロ ー・コ ン ト ロ ールなし 、 です。

3 RCSの電源を 入れます。

4 タ ーミ ナル・プロ グラ ムで、 「 Hit any key to stop autoboot」 と いう

メ ッ セージが表示さ れたら 、 いずれかのキーを 押し ます。 メ

ニュ ーが表示さ れます。

5 1( Boot Alternate) を 入力し て、 Enterキーを 押し ます。 RCSは自

動的に以前のフ ァ ームウェ アのバージョ ン で再起動し ます。

6 RCSの再起動後、 FLASHアッ プグレ ード を 試行でき ます。
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ネッ ト ワーク 設定

注： ネッ ト ワーク ・ダイ アログ・ボッ ク スの設定を変更できるのは、 ス
イ ッ チ管理者のみです。 他のユーザーには、 表示のみのアク セスが許可
さ れています。

サイ ド ・ナビ ゲーショ ン ・バーから 、 Networkを ク リ ッ ク し

て、 General、 IPv4、 IPv6のタ ブを 表示し ます。

一般ネッ ト ワーク 設定を 構成する には次の手順を 実行し ます。

1 Networkタ ブを ク リ ッ ク し 、 次にGeneralタ ブを ク リ ッ ク し

て、 RCS General Network Settings画面を 表示し ます。

2 「 LAN Speed」 ド ロ ッ プダウン ・メ ニュ ーから 、 Auto-Detect、 10 Mbps
Half Duplex、 10 Mbps Full Duplex、 100 Mbps Half Duplex、 100 Mbps Full
Duplex、 1 Gbps Full Duplex のオプショ ン のいずれか1つを 選択し ま

す。

注： イ ーサネッ ト ・モード を変更し た場合は、 再起動する必要があり ま
す。

3 「 ICMP Ping Reply」 ド ロ ッ プダウン ・メ ニュ ーから 、 Enabled また

はDisabled のいずれかを 選択し ます。

4 HTTPまたはHTTPSポート を 確認も し く は変更し ます。 設定はデ

フ ォ ルト のHTTP 80およ びHTTPS 443と なり ます。

5 Saveを ク リ ッ ク し ます。

IPv4ネッ ト ワーク 設定を 構成する には次の手順を 実行し ます。

1 IPv4タ ブを ク リ ッ ク し て、 IPv4 Settings画面を 表示し ます。

2 Enable IPv4チェ ッ ク ボッ ク スを ク リ ッ ク し てオン またはオフ に

し ます。

3 「 Address」 、 「 Subnet」 、 「 Gateway」 の各フ ィ ールド に適切な

情報を 入力し ます。 IPv4のアド レ スは、 xxx.xxx.xxx.xxxのド ッ ト 記

号式で入力し ます。
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4 DHCPド ロ ッ プダウン ・メ ニュ ーから 、 EnabledまたはDisabledのいず

れかを 選択し ます。

注： DHCPを有効にすると 、 「 Address」 、 「 Subnet」 、 「 Gateway」 の各
フ ィ ールド に入力し た情報は無視さ れます。

5 Saveを ク リ ッ ク し ます。

IPv6ネッ ト ワーク 設定を 構成する には次の手順を 実行し ます。

1 IPv6タ ブを ク リ ッ ク し て、 IPv6 Settings画面を 表示し ます。

2 Enable IPv6チェ ッ ク ボッ ク スを リ ッ ク し てオン またはオフ にし

ます。

3 「 Address」 、 「 Subnet」 、 「 Prefix Length」 の各フ ィ ールド に適切

な情報を 入力し ます。 IPv6のアド レ スは、 FD00:172:12000033 ま

たは省略 FD00:172:12:33 の16進数表記で入力し ます。

4 DHCPド ロ ッ プダウン ・メ ニュ ーから 、 EnabledまたはDisabledのいず

れかを 選択し ます。

注： DHCPv6を有効にすると 、 「 Address」 、 「 Gateway」 、 「 Prefix length」
の各フ ィ ールド に入力し た情報は無視さ れます。

5 Saveを ク リ ッ ク し ます。

DNS設定

手動で DNSサーバーを 割り 当てる こ と も 、 DHCPまたはDHCPv6を 使

用し て取得し たアド レ スを 使用する こ と も でき ます。

DNS設定を 手動で構成する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 DNSを 選択し て、 RCS DNS
Settings画面を 表示し ます。

2 Manual、 DHCP( IPv4が有効な場合 ) 、 DHCPv6( IPv6が有効な場

合 ) のいずれかを 選択し ます。
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3 Manualを 選択し た場合は、 Primary、 Secondary、 Tertiaryの各フ ィ ー

ルド にDNSサーバー番号を 入力し ます。

4 Saveを ク リ ッ ク し ます。

NTP設定

スイ ッ チは、 証明書の期限が切れていないこ と を 確認する ために、

現在の時刻にアク セスする 必要があり ます。 NTPから の時刻更新を

要求する よ う にスイ ッ チを 構成でき ます。 第5章の「 NTPの構成」

を 参照し て く ださ い。

SNMP設定

SNMPは、 ネッ ト ワーク 管理アプリ ケーショ ン と スイ ッ チ間で管理

情報を 通信する ために使用さ れる プロ ト コ ルです。 他のSNMPマ
ネージャ ーは、 MIB-IIにアク セスする こ と によ り 、 スイ ッ チと 通信

でき ます。 SNMP画面を 開く と 、 OBWIはユニッ ト から SNMPパラ

メ ータ ーを 取得し ます。

SNMP画面から 、 システム情報と コ ミ ュ ニテ ィ ー・ス ト リ ン グを 入力

でき ます。 また、 スイ ッ チを 管理する ステーショ ン 、 さ ら にスイ ッ

チから SNMPト ラ ッ プを 受信する ステーショ ン を 指定でき ま

す。 Enable SNMPを 選択する と 、 ユニッ ト はUDPポート 161を 介し

た SNMP要求に応答し ます。

一般SNMP設定を 構成する には次の手順を 実行し ます。

1 SNMPを ク リ ッ ク し て、 SNMP画面を 開き ます。

2 Enable SNMPチェ ッ ク ボッ ク スを ク リ ッ ク し て有効にし 、 ス

イ ッ チがUDPポート 161を 介し た SNMP要求に応答でき る よ う に

し ます。

3 「 Name」 フ ィ ールド にシステムの完全修飾ド メ イ ン 名を 、

「 Contact」 フ ィ ールド にノ ード の連絡先担当者を 入力し ます。
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4 「 Read」 、 「 Write」 、 「 Trap」 の各コ ミ ュ ニテ ィ ー名を 入力し

ます。 こ れら の名称は、 SNMPアク シ ョ ン で使用が必須と なっ

ている コ ミ ュ ニテ ィ ー・ス ト リ ン グを 指定し ます。 「 Read」 と

「 Write」 のス ト リ ン グは、 UDPポート 161を 介し た SNMPにのみ

適用さ れ、 スイ ッ チへのアク セスを 保護する パスワード と し て

機能し ます。 こ の値は、 64文字以内の範囲で受け入れら れま

す。 こ れら のフ ィ ールド を 空欄のまま残すこ と はでき ません。

5 スイ ッ チの管理を 許可する 最大4台の管理ワーク ステーショ ン の

アド レ スを 、 「 Allowable Managers 」 フ ィ ールド に入力し ます。 ま

たは、 こ れら のフ ィ ールド を 空欄のままにし て、 すべての

ワーク ステーショ ン にRCSの管理を 許可する こ と も でき ます。

6 Saveを ク リ ッ ク し ます。

監査イ ベン ト の設定

イ ベン ト はスイ ッ チによ っ て管理ステーショ ン に送信さ れる 通知

で、 何ら かの処置が必要である 事象が発生し たこ と を 示し ます。

個別のイ ベン ト を 有効にする には次の手順を 行います。

1 Auditingを ク リ ッ ク し て、 Events画面を 開き ます。

2 一覧の適切なチェ ッ ク ボッ ク スを オン にし て、 通知を 生成する

イ ベン ト を 指定し ます。

-または -
Event Nameの横にある チェ ッ ク ボッ ク スを オン ／オフ にする

と 、 リ ス ト 内のすべてを オン またはオフ にでき ます。

3 Saveを ク リ ッ ク し ます。

イ ベン ト 送信先の設定

監査イ ベン ト を 、 SNMPト ラ ッ プ送信先と Syslogサーバーに送信さ れ

る よ う に構成でき ます。 イ ベン ト 画面で有効にさ れたイ ベン ト は、
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イ ベン ト 送信先画面に一覧で表示さ れている すべてのサーバーに送

信さ れます。

1 Auditingと Destinationsタ ブを ク リ ッ ク し て、 Event Destinations画
面を 開き ます。

2 「 SNMP Trap Destination」 フ ィ ールド に、 こ のスイ ッ チがイ ベン

ト を 送信する 管理ワーク ステーショ ン のアド レ スと Syslogサー

バーを それぞれ4つまで入力し ます。

3 Saveを ク リ ッ ク し ます。

ポート - SIPの構成

スイ ッ チから 、 接続さ れている SIPの一覧や、 各SIPの電子 ID
( EID) 、 ポート 、 状態、 アプ リ ケーショ ン 、 イ ン タ ーフ ェ イ ス ・タ

イ プ 、 およ びUSB速度の情報を 表示でき ます。 SIPの1つを ク リ ッ ク

する と 、 スイ ッ チ ・タ イ プ 、 ブート ・バージョ ン 、 アプ リ ケーショ ン ・

バージョ ン 、 ハード ウェ ア ・バージョ ン 、 FPGAバージョ ン 、 最新バー

ジョ ン 、 アッ プグレ ード ・ステータ スなどの追加情報が表示でき ま

す。

また、 実行でき る タ スク には、 オフ ラ イ ン SIPの削除、 SIPフ ァ ーム

ウェ アのアッ プグレ ード 、 USB速度の設定、 ケーブルの停止があり

ます。

オフ ラ イ ン SIPを 削除する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → SIPsの順にク リ ッ ク し

て、 SIP画面を 開き ます。

2 Delete Offline を ク リ ッ ク し ます。

SIPのアッ プグレード

SIP FLASHのアッ プグレ ード 機能を 使用する と 、 RCS管理者はSIPを
利用可能な最新のフ ァ ームウェ アにアッ プデート でき ます。 こ の

アッ プデート は、 スイ ッ チのユーザー・イ ン タ ーフ ェ イ スまた

はAvocent管理ソ フ ト ウェ アを 使用し て実行でき ます。
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アッ プグレ ード によ り FLASHメ モリ ーが再プロ グラ ムさ れる と 、 ス

イ ッ チはソ フ ト ・リ セッ ト を 実行し 、 すべてのSIPセッ シ ョ ン を 終了

し ます。 SIPのフ ァ ームウェ アがアッ プデート 中のタ ーゲッ ト ・デバ

イ スは、 接続解除さ れたと 表示さ れる 場合があり ます。 フ ラ ッ

シュ ・アッ プデート が完了する と 、 タ ーゲッ ト ・デバイ スは正常に表

示さ れる よ う になり ます。

SIPの自動アッ プグレ ード を 行う よ う にRCSが構成さ れている 場合

は、 スイ ッ チがアッ プデート さ れる と 、 SIPも 自動的にアッ プデート

さ れます。 スイ ッ チのフ ァ ームウェ アを アッ プデート する には、

「 RCSツ ール」 ( ページ 56) 、 またはAvocent管理ソ フ ト ウェ アのオ

ン ラ イ ン ・ヘルプを 参照し て く ださ い。 通常のアッ プグレ ード 処理

中に問題が発生し た場合も 、 必要に応じ て、 SIPは強制的にアッ プ

グレ ード さ れる こ と があり ます。

注： フ ァ ームウェ ア・アッ プグレード ・フ ァ イ ルについて
は、 http://www.dell.comを確認し てく ださ い。

SIPの自動アッ プグレ ード 機能を 変更する には：

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → SIPsの順にク リ ッ ク し

て、 SIP画面を 開き ます。

2 アッ プグレ ード する SIPの横にある チェ ッ ク ボッ ク スを 選択し 、

Enable Auto → Upgradeを ク リ ッ ク し ます。

注意： フ ァ ームウェ ア ・アッ プデート 中に SIPの接続を 解除し たり 、

タ ーゲッ ト ・デバイ スのパワー・サイ ク リ ン グ ( 一旦電源を 切っ て入

れ直す ) を 行っ たり する と 、 モジュ ールが作動不能と なり SIPの工

場返送や修理の必要が生じ る 場合があり ます。

SIPフ ァ ームウェ アを アッ プグレ ード する には：

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → SIPsの順にク リ ッ ク し

て、 SIP画面を 開き ます。

2 変更する SIPの横にある チェ ッ ク ボッ ク スを 選択し ます。

3 Choose an operationを 選択し て、 Upgradeを 選択し ます。

4 設定が正し い場合は、 Upgradeを ク リ ッ ク し ます。
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USB速度を 設定する には次の手順を 実行し ます。

注： こ の選択は、 USB2 SIPにのみ適用さ れます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → SIPsの順にク リ ッ ク し

て、 SIP画面を 開き ます。

2 変更する SIPの横にある チェ ッ ク ボッ ク スを 選択し ます。

3 Choose an operationを 選択し て、 Set USB 1.1 Speedまたは Set USB 2.0
Speed選択し ます。

電源装置の設定

注： 電源装置の設定を変更するには、 管理者の権限が必要です。

注： サポート 対象のPDU一覧については、 www.dellkvm.comを参照し てく
ださ い。

RCS Power Devices画面から 、 接続さ れている 電源装置の一覧や、 各

電源装置の名前、 ポート 、 状態、 バージョ ン 、 モデル、 ブザー、 ア

ラ ーム、 およ び温度の情報を 表示でき ます。 また、 電源装置を 選択

し て、 Settingsを 選択する と 、 その電源装置の名前、 説明、 状態、

バージョ ン 、 ソ ケッ ト 、 ベン ダー名、 モデル、 およ び入力フ ィ ード

の詳細を 表示でき ます。

電源管理装置のアウト レ ッ ト にタ ーゲッ ト ・デバイ スが接続さ れて

いる 場合は、 タ ーゲッ ト ・デバイ スの電源のオン ／オフ 、 またはオ

フ ／オン ( 電源の入れ直し ) を 行う こ と ができ ます。

タ ーゲッ ト ・デバイ スの電源のオン 、 オフ 、 またはオフ ／オン を 行

う には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Power Devicesの順にク

リ ッ ク し て、 Power Devices画面を 開き ます。

2 構成する ユニッ ト の名前を ク リ ッ ク し て、 Outlet Listを オン にし

ます。
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3 構成する アウト レ ッ ト の左側にある チェ ッ ク ボッ ク スを 選択し

ます ( 複数可 ) 。

4 On、 Off、 またはCycleを 目的に応じ てク リ ッ ク し ます。

オフ ラ イ ン の電源装置を 削除する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Power Devicesの順にク

リ ッ ク し て、 Power Devices画面を 開き ます。

2 Delete Offlineを ク リ ッ ク し ます。

最小オン 時間、 オフ 時間またはウェ イ ク ・ア ッ プ状態を 変更する に

は次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Power Devicesの順にク

リ ッ ク し て、 Power Devices画面を 開き ます。

2 構成する ユニッ ト の名前を ク リ ッ ク し て、 Outletsを 選択し ます。

3 変更する アウト レ ッ ト の名前を ク リ ッ ク し ます。

4 ド ロ ッ プダウン ・ウィ ン ド ウを 使用し て対象の設定を 変更

し 、 Saveを ク リ ッ ク し ます。

タ ーゲッ ト ・サーバーと 電源アウト レ ッ ト の関連付け

OBWIの「 Target List」 ページでは、 リ ン ク さ れたアウト レ ッ ト を 持

つタ ーゲッ ト の電源管理操作を 選択でき ます。 Ports → Power Devices
タ ブを 順に選択し 、 次にデバイ ス名を ク リ ッ ク する と 、 Device
Settings、 Device Firmware Upgrade、 およ びOutlet List の各タ ブが表示

さ れます。 Outlet Listタ ブを ク リ ッ ク する と 、 タ ーゲッ ト ・デバイ ス

にリ ン ク さ れている アウト レ ッ ト が表示さ れます。

次の図に、 リ ン ク さ れた電源アウト レ ッ ト を 持つ Server2と いう 名前

のタ ーゲッ ト ・デバイ スを 示し ます。 「 Action」 列のド ロ ッ プダウ

ン ・メ ニュ ーの矢印を ク リ ッ ク する と 、 利用可能なオプショ ン の電

源操作が表示さ れます。
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図 3.2. Target List

次の図では、 タ ーゲッ ト のServer2のUnit Overviewページに、 Wall
Outlet Powerが表示さ れています。 こ こ では、 PDU1から のアウト

レ ッ ト 1と アウト レ ッ ト 9がServer2にリ ン ク さ れています。
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図 3.3. タ ーゲッ ト の概要 - Server2

電源アウト レ ッ ト のグループ化

アウト レ ッ ト は、 制御を 容易にする ために、 タ ーゲッ ト ・サーバーに

リ ン ク または関連付ける こ と ができ ます。 アウト レ ッ ト ( すなわち

サーバーに対する アウト レ ッ ト ) を グループにする には、 名前を 付

ける 最初のデバイ スで、 Manual Nameフ ィ ールド を 使用さ れなければ

なり ません。 二番目およ びそれ以降のデバイ スでは、 Link to Target
Deviceメ ニュ ーを 使用し 、 次にド ロ ッ プ ・ダウン ・リ ス ト から 最初の

デバイ スのタ ーゲッ ト 名を 選択し なければなり ません。

「 Target List」 ページで実行さ れた電源操作は、 適用可能なすべての

アウト レ ッ ト に適用さ れます。 「 ユニッ ト の表示」 ページでは、

タ ーゲッ ト の特定の電源アウト レ ッ ト に対し て電源管理操作を 実行

でき ます。 次の図に、 PDU1から の電源アウト レ ッ ト 4と 5と いう 組

み合わせを 持つ、 Group2と いう 名前のタ ーゲッ ト を 示し ます。

ソ ケッ ト 4およ び 5を グループにする には：
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1 アウト レ ッ ト 4を 選択し て、 Power Devices Outlet Settingsページを 表示

し ます。

2 Manualを 選択し て、 Group2を 入力し ます。

3 Saveを ク リ ッ ク し ます。

4 アウト レ ッ ト 5を 選択し て、 Power Devices Outlet Settingsページを 表示

し ます。

5 Link to Target Deviceを 選択し て、 ド ロ ッ プ ・ダウン ・メ ニュ ーか

ら Group2を 選択し ます。

6 Saveを ク リ ッ ク し ます。 Outlet Listに戻る と 、 アウト レ ッ ト 4およ

び 5は同じ 名前を 持つこ と になり ます。

図 3.4. タ ーゲッ ト の概要 - Group2
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デフ ォ ルト のアウト レ ッ ト 名

次の図に示すと おり 、 Power DevicesページのAssign Default Names to
Outletsチェ ッ ク ボッ ク スを 使用し て、 電源アウト レ ッ ト に電源デバ

イ スのデフ ォ ルト の名前を 指定する かどう か制御し ます。 名前の付

いた電源アウト レ ッ ト のみが「 タ ーゲッ ト 」 ページに一覧表示さ れ

ます。 Assign Default Names to Outletsチェ ッ ク ボッ ク スを オフ にし て

保存する と 、 デフ ォ ルト で割り 当てら れた電源アウト レ ッ ト 名を 削

除でき ます。 「 Assign Default Names to Outlets」 チェ ッ ク ボッ ク スを

オン にし て保存する と 、 名前のない電源アウト レ ッ ト にデフ ォ ルト

の名前を 割り 当てら れます。

図 3.5. RCS Power Devicesページ

アウト レ ッ ト 名の割り 当て

次の図に示すと おり 、 「 電源装置アウト レ ッ ト の設定」 ページに

は、 アウト レ ッ ト の名前を 割り 当てる ための3つのオプショ ン があ
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り ます。 オプシ ョ ン は、 「 手動」 割り 当て、 「 タ ーゲッ ト ・デバイ

スへのリ ン ク 」 、 「 タ ーゲッ ト ・デバイ スと し て表示し ない」 で

す。

図 3.6. 電源装置アウト レ ッ ト 設定ページ

• Manual Nameでは、 出力に固有の名前を 指定し ます。 名前は、 す

べてのSIPおよ び電源アウト レ ッ ト 名に対し て固有である 必要が

あり ます。 固有でない名前を 手動で指定し よ う と する と エラ ー

になり 、 名前は保存さ れません。

• Link to Target Deviceでは、 別のタ ーゲッ ト 名 ( アウト レ ッ ト また

はSIPのいずれか ) にアウト レ ッ ト を リ ン ク し て、 指定さ れた

タ ーゲッ ト の電源を 管理し ます。 アウト レ ッ ト がSIPタ ーゲッ ト

名にリ ン ク さ れる と 、 通常そのアウト レ ッ ト はリ ン ク さ れた SIP
に接続さ れている サーバーに物理的に電源を 供給し ます。

• 「 Do Not Display as Target Device」 オプシ ョ ン は、 アウト レ ッ ト

の名前を 空白にし ます。 こ れによ り 、 アウト レ ッ ト は「  Target
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List」 ページに表示さ れません。 こ のオプショ ン を 予備のアウト

レ ッ ト に使用し て、 予備のアウト レ ッ ト を 「 Target Lis」 ページ

に表示さ れないよ う にでき ます。

アク セス制御の継承

タ ーゲッ ト に電源アウト レ ッ ト を リ ン ク する こ と によ り 電源アウト

レ ッ ト 名を 変更する と 、 アウト レ ッ ト はそのタ ーゲッ ト 名に既に構

成さ れている アク セス制御を 継承し ます。 SIPが追加さ れ、 そのSIP
から 取得さ れた名前が既存のタ ーゲッ ト の名前と 一致する と 、 新し

い SIPはそのタ ーゲッ ト から アク セス制御を 継承し ます。 タ ーゲッ

ト ・デバイ スの名前が変更さ れる と 、 そのタ ーゲッ ト のすべてのSIP
およ びアウト レ ッ ト の名前は変更さ れ、 古いタ ーゲッ ト 名に構成さ

れていたアク セス制御を 継承し 続けます。

タ ーゲッ ト ・デバイ スの名前の変更

「 Target List - Overview」 ページでは、 タ ーゲッ ト の名前を 任意の固有

タ ーゲッ ト 名に変更でき ます。 名前は、 SIPおよ び電源アウト レ ッ

ト を 含むすべてのタ ーゲッ ト に対し て固有である 必要があり ます。

タ ーゲッ ト の名前が変更さ れる と 、 そのタ ーゲッ ト にリ ン ク し てい

る すべてのアウト レ ッ ト にも 、 新し いタ ーゲッ ト 名が指定さ れま

す。

タ ーゲッ ト ・デバイ スの優先付けさ れる 状態

「 Target Lis」 ページでは、 リ ン ク さ れた電源アウト レ ッ ト を 持つ

タ ーゲッ ト によ り 複数のデバイ スが制御さ れます。 タ ーゲッ ト に表

示さ れている 「 状態」 値は、 デバイ スのすべての状態値のう ち で

も っ と も 優先度の高いも のと し て選択さ れます。 次の表に、 状態値

の種類を 優先度順 ( 優先度の高い順から 低い順 ) と 適用可能なタ ー

ゲッ ト ・デバイ ス ・タ イ プを 示し ています。
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状態値 適用対象 状態の説明

SIP
電源ア

ウト

レッ ト

使用中 x なし セッ ショ ンがアク ティ ブです

パスがブ

ロッ ク 状

態

x なし
タ ーゲッ ト へのパスは別のセッ ショ

ンが使用中です

アッ プグ

レード 中
x なし SIPはアッ プグレード 中です

電源オン

中
なし x

1つ以上のアウト レッ ト が電源投入中

です

電源オフ

中
なし x

1つ以上のアウト レッ ト が電源遮断中

です

電源なし x なし SIPで電源が検出さ れません

電源の一

部
なし x

タ ーゲッ ト にはオン／オフ 状態のア

ウト レッ ト が両方あり ます

ロッ ク 解

除状態
なし x

1つ以上のアウト レッ ト がロッ ク さ れ

ています

電源オフ

状態
なし x

1つ以上のアウト レッ ト の電源がオ

フ です

ロッ ク 状

態
なし x

1つ以上のアウト レッ ト がロッ ク 解除

さ れています

表 3.4: タ ーゲッ ト の状態値
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状態値 適用対象 状態の説明

SIP
電源ア

ウト

レッ ト

アイ ド ル x なし
アク ティ ブなセッ ショ ンはあり ませ

ん。 SIPには電源が投入さ れています

電源オン

状態
なし x アウト レッ ト の電源はオンです

タ ーゲッ ト ・デバイ スに名前でリ ン ク さ れている 複数の電源アウト

レ ッ ト があり 、 それら が共通の電源状態にない場合、 RCSはLocked-
Offのアウト レ ッ ト 状態を Offと 見なし 、 Locked-Onのアウト レ ッ ト 状

態を Onと 見なす場合があり ます。 次の表に、 2つのアウト レ ッ ト の

状態値が組み合わさ れたと き に生じ る 状態値の一覧を 示し ます。

アウト レッ ト 1の状態 アウト レッ ト 2の状態 結果と なる状態

オフ オフ オフ

オフ オン 電源の一部

オン オン 電源がオンになり まし た

ロッ ク 状態 オン 電源がオンになり まし た

ロッ ク 状態 ロッ ク 状態 ロッ ク 状態

ロッ ク 状態 オフ 電源の一部

ロッ ク 解除状態 オン 電源の一部

ロッ ク 解除状態 ロッ ク 解除状態 ロッ ク 解除状態

ロッ ク 解除状態 オフ 電源がオフ になり まし た

表 3.5: 複数のアウト レ ッ ト の状態値と 表示さ れる 状態
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アウト レッ ト 1の状態 アウト レッ ト 2の状態 結果と なる状態

ロッ ク 状態 ロッ ク 解除状態 電源の一部

ローカ ル・ポート のLocal Sessionページ

ロ ーカ ル・ポート の「 ロ ーカ ル・セッ シ ョ ン 」 ページでは、 アク テ ィ

ブ ・セッ シ ョ ン のタ ーゲッ ト にリ ン ク さ れている 電源アウト レ ッ ト

がある 場合、 3つの電源コ ン ト ロ ールがアク テ ィ ブ ・セッ シ ョ ン の下

に表示さ れます。 次の図に、 Server2と いう 名前のタ ーゲッ ト のアク

テ ィ ブ ・ロ ーカ ル・ポート ・セッ シ ョ ン で表示さ れる 電源コ ン ト ロ ール

を 示し ます。

図 3.7. ロ ーカ ル・セッ シ ョ ン ・ページの電源管理
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ロ ーカ ル・ポート UIの設定

ロ ーカ ルUIの起動方法を 変更する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Local Port UIの順に選択

し て、 Local Port UI Settings画面を 開き ます。

2 「 Invoke Local Port UI」 ヘッ ダーの下で、 一覧で表示さ れている 1
つまたは複数の方法の横にある チェ ッ ク ボッ ク スを オン にし ま

す。

3 Saveを ク リ ッ ク し ます。

ロ ーカ ル・ポート のユーザー・イ ン タ ーフ ェ イ ス認証を オン ／オフ し た

り 、 ユーザー・アク セス ・レ ベルを 選択し たり でき ます。 ロ ーカ ル・

ポート のユーザー・イ ン タ ーフ ェ イ ス認証を オン にする 場合は、 イ ン

タ ーフ ェ イ スを 使用する ためにロ グイ ン する 必要があり ます。

また、 ロ ーカ ル・ポート のキーボード 言語やスキャ ン ・モード 時間を 選

択し たり 、 ロ ーカ ル・ポート のパスワード を 有効／無効にし たり 、

ユーザーのプリ エン プ ト 操作レ ベルを 選択し たり でき ます。 ユー

ザーが、 タ ーゲッ ト ・デバイ スと の間で別のユーザーが実行中のシリ

アル・セッ シ ョ ン またはKVMセッ シ ョ ン を 中断／切断でき る かど う

かは、 ユーザーのプリ エン プ ト 操作レ ベルによ っ て決まり ます。 プ

リ エン プ ト 操作レ ベルは1～4まであり 、 4が最高レ ベルです。 たと

えば、 プ リ エン プ ト 操作レ ベルが4のユーザーは、 他のレ ベ

ル1、 2、 3のユーザー、 およ びレ ベル4のユーザーを 切断でき ます。

ロ ーカ ル・ポート ・ユーザー認証を 変更する には次の手順を 実行し ま

す ( 管理者のみ ) 。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Local Port UIの順に選

択し て、 Local Port UI Settings画面を 開き ます。

2 Disable Local Port User Authenticationチェ ッ ク ボッ ク スを オン また

はオフ にし ます。
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3 Disable Local Port User Authenticationを チェ ッ ク する 場合は、 User
Access Levelド ロ ッ プダウン ・メ ニュ ーのオプショ ン から 1つ選択し

ます：  User、 User Administrator、 またはRCS Administrator。

4 Saveを ク リ ッ ク し ます。

モデムの設定

RCS Modem Settings画面から 、 一部のモデム設定を 構成でき ます。

また、 モデムのロ ーカ ル・アド レ ス、 リ モート ・ア ド レ ス、 サブネッ

ト ・マスク 、 ゲート ウェ イ の設定を 表示でき ます。

スイ ッ チのモデムへの接続に関する 詳細は、 「 RCSハード ウェ アの

接続」 ( ページ 27) を 参照し て く ださ い。

モデム設定を 構成する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Ports → Modemの順に選択し

て、 Modem Settings画面を 開き ます。

2 Modem sessions can preempt digital sessionsチェ ッ ク ボッ ク スを オン

またはオフ にし ます。

3 「 Authentication Timeout」 で認証がタ イ ムアウト する 時間 ( 30
秒～300秒 ) を 選び、 「 Inactivity Timeout」 で非アク テ ィ ブ ・タ イ

ムアウト 時間 ( 1分～60分 ) を 選びます。

4 Save を 選択し ます。

設定のセッ ト ア ッ プ - ポート ・セキュ リ
テ ィ

シリ アル・セッ ト アッ プ ・ポート から 、 アプラ イ アン スのネッ ト

ワーク 構成を 変更し たり 、 デバッ グ情報を 有効にし たり 、 アプラ イ

アン スを リ セッ ト する こ と ができ ます。

パスワード を 有効にし て、 シリ アル･セッ ト アッ プ ・ポート へのアク

セスを 制限する には：
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1 サイ ド ・ナビ ゲーショ ン ・バーで、 RCS Settings → Ports → Setupを 順に

選択し て、 Setup Port Settingsページを 表示し ます。

2 Enable Setup Port Securityボッ ク スを ク リ ッ ク し て有効にし ます。

3 パスワード を 入力し て確認し ます。

4 Saveを ク リ ッ ク し ます。

セッ シ ョ ン

「 Active Sessions」 画面から 、 アク テ ィ ブなセッ シ ョ ン の一覧と 各

セッ シ ョ ン についての以下の情報を 表示する こ と ができ ます： タ ー

ゲッ ト ・デバイ ス、 所有者、 リ モート ・ホス ト 、 継続時間、 タ イ プに

関する 情報を 表示でき ます。

一般セッ ショ ンの設定

一般セッ シ ョ ン を 構成する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Sessions → Generalの順に選択し

ます。 General Session Settings画面が表示さ れます。

2 Enable Inactivity Timeoutチェ ッ ク ボッ ク スを オン またはオフ にし ま

す。

3 「 Inactivity Timeout」 フ ィ ールド には、 セッ シ ョ ン を 閉じ る 非

アク テ ィ ブ時間を 入力し ます (1分～90分 )。

4 「 Login Timeout」 フ ィ ールド には、 再ロ グイ ン を 必要と する 非

アク テ ィ ブ時間を 入力し ます。 ( 21秒～120秒 )

5 Enable Preemption Timeoutチェ ッ ク ボッ ク スを オン またはオフ にし

ます。

6 「 Preemption Timeout」 フ ィ ールド には、 セッ シ ョ ン がプリ エン

プ ト さ れる こ と を 知ら せる メ ッ セージを 表示する 時間を 入力し

ます ( 1秒～120秒 ) 。
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7 適用でき る セッ シ ョ ン の共有オプショ ン

( Enabled、 Automatic、 Exclusive、 またはStealth) を 選択し ます。

8 1～50から Input Control Timeoutの値を 選択し ます。 ただし 、 1
は0.1秒を 表し ます。

9 Saveを ク リ ッ ク し ます。

KVMセッ ショ ンの構成

KVMセッ シ ョ ン を 構成する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Sessions → KVMの順に選択し ま

す。 KVM Session Settings画面が表示さ れます。

2 キーボード 信号およ びマウス信号の暗号化レ ベル ( 128ビッ ト SSL
( ARCFOUR) 、 DES、 3DES、 またはAES) およ びビ デオ信号の

暗号化レ ベル ( 128ビッ ト SSL( ARCFOUR) 、 DES、 3DES、 AES、
またはNone ( なし ) を 選択し ます。

3 キーボード ・ド ロ ッ プダウン ・メ ニュ ーから 言語を 選択し ます。

4 ハード ウェ アにUSB2+CAC SIPが含まれている 場合は、 ビ デオ解

像度を 選びます。

5 Saveを ク リ ッ ク し ます。

ローカ ル・バーチャ ル・メ ディ ア・セッ ショ ンの構成

バーチャ ル・メ ディ ア ・オプシ ョ ン を 設定する には次の手順を 実行し

ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Sessions → Virtual Mediaの順

に選択し て、 Virtual Media Session Settings画面を 開き ます。

2 Virtual Media locked to KVM Sessionsチェ ッ ク ボッ ク スを オン またはオ

フ にし ます。

3 Allow Reserved Sessionsチェ ッ ク ボッ ク スを オン またはオフ にし ま

す。
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4 ド ロ ッ プダウン ・メ ニュ ーの「 バーチャ ル・メ ディ ア ・アク セス ・

モード 」 から 、 Read-OnlyまたはRead-Writeのオプショ ン のいずれか

を 選択し ます。

5 サポート する 暗号化レ ベルを 選択し ます。

6 Saveを ク リ ッ ク し ます。

7 バーチャ ル・メ ディ アを 有効にする 各SIPの横にある チェ ッ ク

ボッ ク スを オン にし 、 Enable VMを ク リ ッ ク し ます。

-または -
バーチャ ル・メ ディ アを 無効にする 各SIPの横にある チェ ッ ク

ボッ ク スを オン にし 、 Disable VMをク リ ッ ク し ます。

バーチャ ル・メ ディ ア ・オプシ ョ ン

Virtual Media Session Settings画面に表示さ れる オプショ ン を 使用し

て、 バーチャ ル・メ ディ ア ・セッ シ ョ ン 中のスイ ッ チの動作を 指定で

き ます。 表3.4は、 バーチャ ル・メ ディ ア ・セッ シ ョ ン に対し て設定で

き る オプショ ン の概要です。

KVMセッ シ ョ ン でのバーチャ ル・メ ディ ア ・セッ シ ョ ン の使用に関す

る 詳細は、 「 バーチャ ル・メ ディ ア 」 ( ページ 108) を 参照し て く だ

さ い。
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設定 説明

セッ ショ ンの設定：

バーチャ ル・メ ディ

アがKVMセッ ショ ン

にロッ ク 状態

ロッ ク ・オプショ ンは、 バーチャ ル・メ ディ ア・セッ

ショ ンをタ ーゲッ ト ・デバイ ス上のKVMセッ ショ ン

にロッ ク さ れたままの状態にするかどう かを指定し

ます。 ロッ ク が有効( デフ ォ ルト ) である場合

にKVMセッ ショ ンが終了すると 、 バーチャ ル・メ

ディ ア・セッ ショ ンも 終了し ます。 ロッ ク が無効で

ある場合にKVMセッ ショ ンが終了すると 、 バーチャ

ル・メ ディ ア・セッ ショ ンはアク ティ ブのままになり

ます。

セッ ショ ンの設定：

予約済みセッ ショ ン

を許可する

特定のユーザー名にのみバーチャ ル・メ ディ ア接続へ

のアク セスを許可し 、 それ以外のユーザーがタ ー

ゲッ ト ・デバイ スにKVM接続を確立できないよう に

し ます。 KVMセッ ショ ンの接続が解除さ れたと き 、

「 バーチャ ル・メ ディ ア」 ダイ アログ・ボッ ク スの

「 ロッ ク 状態」 の設定により 、 バーチャ ル・メ ディ

ア・セッ ショ ンの接続が解除さ れるこ と があり ま

す。

表 3.6: バーチャ ル・メ ディ ア ・セッ シ ョ ン の設定
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設定 説明

ド ラ イ ブのマッ ピン

グ： バーチャ ル・メ

ディ ア・アク セス・

モード

マッ ピングさ れたド ラ イ ブのアク セス・モード は、

読み取り 専用か読み取り ／書き込みに設定できま

す。 アク セス・モード が読み取り 専用の場合、 ク ラ

イ アント ・サーバー上でマッ ピングさ れたド ラ イ ブ

にデータ を書き込むこ と はできません。 アク セス・

モード が読み取り ／書き込みの場合は、 マッ ピング

さ れたド ラ イ ブと の間でデータ の読み取り と 書き込

みを行う こ と ができます。 マッ ピングさ れるド ラ イ

ブが設計上読み取り 専用( CD-ROMド ラ イ ブ、 DVD-
ROMド ラ イ ブ、 ISOイ メ ージなど ) の場合は、 設定さ

れた読み取り ／書き込みアク セス・モード は無視さ

れます。 読み取り 専用モード に設定すると 、 大容量

記憶装置や外付けUSBメ ディ アのよう な読み取り ／

書き込み対応ド ラ イ ブをマッ ピングし た後に誤っ て

上書きさ れるこ と を回避できます。

DVDド ラ イ ブ ( 1台) と 大容量記憶装置( 1台) は同

時にマッ ピングできます。 CDド ラ イ ブ、 DVDド ラ イ

ブ、 ISOディ スク ・イ メ ージ・フ ァ イ ルは、 バーチャ ル

のCD／DVDド ラ イ ブと し てマッ ピングさ れます。

暗号化レベル

バーチャ ル・メ ディ ア・セッ ショ ンの暗号化レベルを

設定できます。 選択肢には、 なし ( デフ ォ ル

ト ) 、 128-bit SSL( ARCFOUR) 、 DES、 3DES、 AESで
す。

バーチャ ル・メ ディ

ア・アク セス ( SIP使
用) VMの有効／無

効

Virtual Media Access( SIP使用) セク ショ ンには、 す

べてのバーチャ ル・メ ディ ア SIPが一覧で表示さ れま

す。 一覧には、 各ケーブルのバーチャ ル・メ ディ ア

を有効化／無効化するオプショ ンを含む、 各ケーブ

ルの詳細が含まれます。
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ロ ーカ ル ユーザー

ロ ーカ ル・ユーザーも 、 ロ ーカ ル・セッ シ ョ ン 画面から バーチャ ル・メ

ディ アの動作を 指定でき ます。 バーチャ ル・メ ディ ア ・セッ シ ョ ン の

接続／接続解除に加えて、 次の表に示す設定を 構成でき ます。

表 3.7: ロ ーカ ル・バーチャ ル・メ ディ ア ・セッ シ ョ ン の設定

設定 説明

CD
ROM/

DVD
ROM

最初に検出さ れたCD-ROMド ラ イ ブまたはDVD-ROM( 読み取り 専用)
ド ラ イ ブに、 バーチャ ル・メ ディ ア・セッ ショ ンを確立できます。 こ

のチェ ッ ク ボッ ク スをオンにすると 、 バーチャ ル・メ ディ アのCD-ROM
またはDVD-ROMから タ ーゲッ ト ・デバイ スへの接続が確立し ます。 無

効にすると 、 バーチャ ル・メ ディ アのCD-ROMまたはDVD-ROMから タ ー

ゲッ ト ・サーバーへの接続が終了し ます。

大容

量記

憶装

置

バーチャ ル・メ ディ ア・セッ ショ ンを最初に検出さ れた大容量記憶装

置に確立するこ と ができます。 こ のチェ ッ ク ボッ ク スをオンにする

と 、 バーチャ ル・メ ディ アの大容量記憶装置から タ ーゲッ ト ・デバイ

スへの接続が確立し ます。 無効にすると 、 バーチャ ル・メ ディ アの大

容量記憶装置から タ ーゲッ ト ・デバイ スへの接続が終了し ます。

予備

特定のユーザー名にのみバーチャ ル・メ ディ ア接続へのアク セスを許

可し 、 それ以外のユーザーがタ ーゲッ ト ・デバイ スにKVM接続を確立

できないよう にし ます。

シリ アル・セッ ショ ンの構成

シリ アル・セッ シ ョ ン を 構成する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Sessions → Serialの順にク リ ッ ク

し て、 Serial Session Settings画面を 表示し ます。

2 Telnet Access Enabledチェ ッ ク ボッ ク スを オン またはオフ にし ます。

3 Saveを ク リ ッ ク し ます。
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ユーザー・アカ ウン ト のセッ ト ア ッ プ

ローカ ル･アカ ウン ト の管理

スイ ッ チのOBWIでは、 管理者が定義し たユーザー・アカ ウン ト を 通

し て、 ロ ーカ ル・アク テ ィ ビ テ ィ およ びロ グイ ン がセキュ アに実行

さ れます。 管理者は、 サイ ド ・ナビ ゲーショ ン ・バーのUser Accountsを
オン にする こ と で、 ユーザーの追加と 削除、 ユーザーのプリ エン プ

ト 操作の定義、 アク セス ・レ ベルの変更、 パスワード の変更などを

実行でき ます。

アク セス・レベル

ユーザー･アカ ウン ト が追加さ れる と き 、 ユーザーに対し て割り 当て

ら れる アク セス ･レ ベルには、 RCS Administrator、 User
Administrator、 Userがあり ます。

操作 RCS Administrator User Administrator Users

イ ンタ ーフ ェ イ スのシ

ステム・レベル設定の

構成

可 不可 不可

アク セス権の構成 可 可 不可

ユーザー・アカ ウント

の追加、 変更、 削除

すべてのアク セス・

レベルで可

可( UserおよびUser
Administratorのみ)

不可

自分自身のパスワード

の変更
可 可 可

タ ーゲッ ト ・デバイ ス

へのアク セス

可( すべてのタ ー

ゲッ ト ・デバイ ス対

象)

可( すべてのタ ー

ゲッ ト ・デバイ ス対

象)

許可さ

れてい

れば可

表 3.8: アク セス ・レ ベルによ っ て許可さ れる 操作
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新規のユーザー･アカ ウン ト を 追加する には ( User Administratorまた

はRCS Administratorのみ ) 次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーで、 User Accounts → Local User Accountsの
順にオン にし て、 Local User Accounts画面を 開き ます。

2 Addボタ ン を ク リ ッ ク し ます。

3 新規ユーザーのユーザー名と パスワード を 該当欄に入力し ます。

4 新規ユーザーのアク セス ･レ ベルを 選択し ます。

5 ユーザー・アカ ウン ト に割り 当てる 、 任意の使用可能なタ ーゲッ

ト ・デバイ スを オン にし て、 Add を ク リ ッ ク し ます。

注： User Administratorと RCS Administratorは、 すべてのタ ーゲッ ト ･デバイ ス
にアク セスできます。

6 Saveを ク リ ッ ク し ます。

ユーザー･アカ ウン ト を 削除する には ( User AdministratorまたはRCS
Administratorのみ ) 次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーで、 User Accounts → Local Accountsの順

にオン にし て、 Local User Accounts画面を 開き ます。

2 削除する アカ ウン ト の左にある チェ ッ ク ボッ ク スを それぞれク

リ ッ ク し て、 Deleteを ク リ ッ ク し ます。

ユーザー・アカ ウン ト を 編集する には ( 管理者またはアク テ ィ ブ ・

ユーザーのみ ) 次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーで User Accounts → Local Accountsの順に

オン にし ます。 Local User Accounts画面が表示さ れます。

2 編集する ユーザーの名前を ク リ ッ ク し ます。 ユーザー･プロ フ ァ

イ ルが表示さ れます。

3 画面にユーザー情報を 入力し 、 Saveを ク リ ッ ク し ます。
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Avocent管理ソ フ ト ウェ アのデバイ ス IPアド レス

Avocent管理ソ フ ト ウェ ア ・サーバーの IPアド レ スを 指定する と 、 管理

ソ フ ト ウェ ア ・サーバーを 使っ て、 管理さ れていないスイ ッ チに接

続し て登録でき ます。

サーバーIPアド レ スを 構成する には

1 サイ ド ・ナビ ゲーショ ン ・バーで User Accounts →Avocentの順に選

択し ます。 Avocent Management Software Settings画面が表示さ れま

す。

2 接続する サーバーIPアド レ スを 入力し ます。 IPアド レ スは最大

で 4つ入力でき ます。

3 スク ロ ール・バーを 使用し て、 再試行間隔を 選択し ます。

4 サーバーに登録さ れている RCSの関連を 解除する に

は、 Disassociateボタ ン を ク リ ッ ク し ます。

5 Saveを ク リ ッ ク し ます。

LDAP
Dell 1082DS/2162DS/4322D RCSは、 ロ ーカ ル・データ ベースを 介し て、

またはLDAP( Lightweight Directory Assistance Protocol) サポート のDell
RCSソ フ ト ウェ アやOBWIを 使用し ている 外部のスケーラ ブルな分散

型ディ レ ク ト リ ・サービ スによ っ て、 ユーザーを 認証およ び承認でき

ます。 RCSでのLDAPの構成およ び使用に関する 詳細情報について

は、 LDAPのセク ショ ン を 参照し て く ださ い。

Override Admin
ネッ ト ワーク 障害の発生に備え、 LDAPサーバーに照会し 、 認証する

ユニッ ト の性能に関係なく 使用でき る アカ ウン ト が用意さ れていま

す。 第5章の「 Override Adminアカ ウン ト の構成」 を 参照し て く ださ

い。
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ア ク テ ィ ブ ・セ ッ シ ョ ン

「 Active Sessions」 画面から 、 アク テ ィ ブなセッ シ ョ ン の一覧と 各

セッ シ ョ ン についての以下の情報を 表示する こ と ができ ます： タ ー

ゲッ ト ・デバイ ス、 所有者、 リ モート ・ホス ト 、 継続時間、 タ イ プに

関する 情報を 表示でき ます。

セッ ショ ンの終了

セッ シ ョ ン を 終了する には次の手順を 実行し ます。

1 サイ ド ・ナビ ゲーショ ン ・バーで、 Active Sessions を 選択し て、 RCS
Active Sessions画面を 表示し ます。

2 目的のタ ーゲッ ト ・デバイ スの横にある チェ ッ ク ボッ ク スを オン

にし ます ( 複数可 ) 。

3 Disconnectを ク リ ッ ク し ます。

注： 関連付けら れているロッ ク 状態のバーチャ ル・メ ディ ア・セッ ショ ン
がある場合は、 そのセッ ショ ンも 接続解除さ れます。

セッ シ ョ ン を 終了する には ( ロ ーカ ル・ユーザーのみ ) ：

1 サイ ド ・ナビ ゲーショ ン ・バーから 、 Local Sessionを 選択し ます。

2 Disconnect Active Sessionチェ ッ ク ボッ ク スを オン にし ます。



90 | ローカ ルおよびリ モート の構成



4

ビデオ・ビュ ーア･ウィ ンド ウ | 91

ビ デオ ・ビ ュ ーア ･ウィ ン ド ウ

OBWIを 使用し てスイ ッ チに取り 付けら れている タ ーゲッ ト ・デバイ

スと のKVMセッ シ ョ ン を 操作する には、 ビ デオ・ビ ュ ーアを 使用し

ます。 ビ デオ・ビ ュ ーアを 使用し てデバイ スに接続する と 、 タ ー

ゲッ ト ・デバイ スのデスク ト ッ プが別個のウィ ン ド ウに表示さ れま

す。 こ のウィ ン ド ウには、 ロ ーカ ル・カ ーソ ルと タ ーゲッ ト ・デバイ

スのカ ーソ ルの両方が含まれています。

スイ ッ チのOBWIソ フ ト ウェ アでは、 Javaベースのプロ グラ ムを 使用

し て、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウを 表示し ます。 スイ ッ チ

のOBWIは、 初めて起動し たと き にビ デオ・ビ ュ ーアを 自動的にダウ

ン ロ ード し て、 イ ン スト ールし ます。

注： セッ ショ ンを起動するには、 Java 1.6.0_11以降が必要です。

注： スイ ッ チのOBWIは、 Java Resource Engine( JRE) をイ ンスト ールし ま
せん。 JREは無料で http://www.sun.comから ダウンロード できます。

注： スイ ッ チのOBWIは、 システム・メ モリ ーを使用し て、 「 ビデオ・
ビュ ーア」 ウィ ンド ウ内にイ メ ージを保存し て表示し ます。 開かれた
「 ビデオ・ビュ ーア」 ウィ ンド ウには、 追加のシステム・メ モリ ーがそれ
ぞれ必要です。 ク ラ イ アント ・サーバーで色を 8ビッ ト に設定すると 、
「 ビデオ・ビュ ーア」 ウィ ンド ウあたり 1.4 MBのメ モリ ーが必要です。 16
ビッ ト に設定すると 2.4 MB、 32ビッ ト に設定すると 6.8 MBのメ モリ ーが必
要です。 システム・メ モリ ーが許容する ( 通常4つ ) 以上の「 ビデオ・
ビュ ーア」 ウィ ンド ウを開こ う と すると 、 メ モリ ー不足エラ ーが発生
し 、 要求し た「 ビデオ・ビュ ーア」 ウィ ンド ウは開きません。

アク セスし よ う と し ている デバイ スを 別のユーザーが表示中である

場合、 こ のユーザーのプリ エン プ ト 操作レ ベルと 同等またはそれ以

上のプリ エン プ ト 操作レ ベルが自分に許可さ れていれば、 相手の

ユーザーを プリ エン プ ト する よ う 指示する メ ッ セージが表示さ れま
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す。 また、 RCS管理者も 、 Active Sessionのページから 、 アク テ ィ ブな

ユーザーの接続を 解除でき ます。 詳細については、 「 アク テ ィ ブ ・

セッ シ ョ ン 」 ( ページ 89) を 参照し て く ださ い。

図 4.1. ビ デオ・ビ ュ ーア ・ウィ ン ド ウ ( 通常のウィ ン ド ウ・モード )

表 4.1: ビ デオ・ビ ュ ーアの説明

番

号
説明

1
タ イ ト ル・バー： 表示さ れているタ ーゲッ ト ・デバイ スの名前を表示し ま

す。 全画面表示モード ではタ イ ト ル・バーが隠さ れ、 タ ーゲッ ト ・デバイ

ス名がメ ニュ ーと ツールバーの間に表示さ れます。
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番

号
説明

2
画鋲アイ コ ン ： メ ニュ ーと ツールバーをロッ ク し て、 常に表示さ れるよ

う にし ます。

3

メ ニュ ーおよびツールバー： 「 ビデオ・ビュ ーア」 ウィ ンド ウ機能の多

く には、 こ こ から アク セスできます。 画鋲を使用し ていない場合、 メ

ニュ ーと ツールバーは表示／非表示状態になり ます。 ツールバー上に

カ ーソ ルを移動すると 、 メ ニュ ーと ツールバーが表示さ れます。 ツール

バーには10個までのコ マンド やマク ロ ・グループ・ボタ ンを表示できま

す。 デフ ォ ルト では、 ツールバーには、 シツールバー上には「 シング

ル・カ ーソ ル」 モード 、 更新、 自動ビデオ調整、 ローカ ル カ ーソ ルを合

わせるの各ボタ ンが表示さ れます。 詳細については、 「 ツールバーの変

更」 ( ページ 94) および「 ツールバーの変更」 ( ページ 94) を参照し て

く ださ い。

4
マク ロ ・ボタ ン ： タ ーゲッ ト ・デバイ スへの送信に通常使われるキーボー

ド ・シーケンスです。

5

接続ステータ ス・イ ンジケータ ー： こ のサーバーのRCSに接続さ れている

ユーザーの状態を示し ます。 モード は、 排他、 基本的なアク ティ ブ接

続、 プラ イ マリ ・アク ティ ブ共有、 セカ ンダリ ・アク ティ ブ共有、 パッ

シブ共有、 ステルス、 スキャ ンです。

6.

スマート ・カ ード のステータ ス・イ ンジケータ ー： スマート ・カ ード がス

マート ・カ ード ・リ ーダーに挿入さ れているかどう かを示し ます。 ビデ

オ・ビュ ーア画面のスマート ・カ ード ・アイ コ ンが半透明の場合は、 ス

マート ・カ ード ・オプショ ンが使用できないか、 または無効であるこ と を

示し ます。 スマート ・カ ード がマッ ピングさ れている場合は、 アイ コ ン

は緑です。

7 表示領域： サーバーのデスク ト ッ プにアク セスし ます。

8
フ レーム： 「 ビデオ・ビュ ーア」 ウィ ンド ウのサイ ズを変更するには、

フ レームをク リ ッ ク し てホールド し ます。
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ツールバーの変更

表示／非表示状態 ( つまり 、 画鋲によ っ て所定の位置にロ ッ ク さ れ

ていない ) にある ツ ールバーが「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウで非

表示になる までの秒数を 指定する こ と ができ ます。

ツ ールバーの非表示時間を 指定する には次の手順を 実行し ます。

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 Tools → Session
Optionsの順に選択し ます。

-または -
Session Optionsボタ ン を ク リ ッ ク し ます。

「 Session Options」 ダイ アロ グ・ボッ ク スが表示さ れます。

2 Toolbarタ ブを ク リ ッ ク し ます。

3 矢印キーを 使用し て、 ツ ールバーが非表示になる までの待ち 時間

( 秒数 ) を 指定し ます。

4 OKを ク リ ッ ク し て変更を 保存し 、 ダイ アロ グ・ボッ ク スを 閉じ

ます。

セッ シ ョ ン の起動

注： 非プロキシ接続を使用し ている場合、 低速のネッ ト ワーク 接続では
最適のビデオ・パフ ォ ーマンスが得ら れないこ と があり ます。 一部の色
設定( グレースケールなど ) では他の設定( 色－最適化など ) ほどネッ
ト ワーク 帯域を使用し ないため、 色設定を変更すると ビデオ・パフ ォ ーマ
ンスを改善できるこ と があり ます。 低速のネッ ト ワーク 接続で最適のビ
デオ・パフ ォ ーマンスを得るには、 「 グレースケール／圧縮－最適化」 ま
たは「 色－低／圧縮－高」 などの色設定を使用し てく ださ い。 詳細につ
いては、 「 ビュ ーの調整」 ( ページ 96) を参照し てく ださ い。

注： ユーザーがローカ ル・コ ンピュ ータ ーより 高い画面解像度でタ ーゲッ
ト ・デバイ スに接続し た場合には、 タ ーゲッ ト ・デバイ ス画面の一部が
「 ビデオ・ビュ ーア」 ウィ ンド ウに表示さ れ、 画面残り の部分はスク ロー
ル・バーで参照するよう になり ます。 こ の場合は、 タ ーゲッ ト ・デバイ ス
またはローカ ル・コ ンピュ ータ ー( またはこ の両方) の解像度を調整すれ
ば、 画面全体が表示できるよう になり ます。
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スイ ッ チのExplorerウィ ン ド ウから KVMセッ シ ョ ン を 起動する には

次の手順を 実行し ます。

1 「 Target List」 画面で一覧表示さ れたデバイ スを ク リ ッ ク し 、

「 Unit Overview」 ウィ ン ド ウを 開き ます。

2 KVM Sessionリ ン ク を ク リ ッ ク し 、 新し いウィ ン ド ウでビ デオ・

ビ ュ ーアを 開き ます。

セッ ショ ン ・タ イ ムアウト

一定の時間枠内に「 Session」 ウィ ン ド ウでアク テ ィ ビ テ ィ がなかっ

た場合、 リ モート ・セッ シ ョ ン はタ イ ムアウト と なる こ と があり ま

す。 セッ シ ョ ン のタ イ ムアウト 値は、 RCS KVM Session Settingsウィ

ン ド ウで構成でき ます。 指定し たタ イ ムアウト 値は、 次にスイ ッ チ

のOBWIにアク セスし たと き に使用さ れます。

セッ シ ョ ン のタ イ ムアウト を 有効／無効にする 、 またはタ イ ムアウ

ト 値を 構成する には次の手順を 実行し ます。

1 サイ ド ・メ ニュ ーで、 Unit View → RCS → RCS Settings → Sessions →
Generalの順に選択し ます。

2 Enable Activity Timeoutボッ ク スの目的の設定を 選びます。

3 必要に応じ て、 アク テ ィ ビ テ ィ なし によ る タ イ ムアウト の時間

枠を 指定し ます。

4 Saveを ク リ ッ ク し ます。

ウィ ン ド ウ ・サイ ズ

注： View → Scalingコ マンド は、 「 ビデオ・ビュ ーア」 ウィ ンド ウが全画
面表示( Full Screen) モード になっ ている場合は使用できません。 また、
共有セッ ショ ンの非プラ イ マリ ・ユーザーは使用できません。

スイ ッ チのOBWIを 初めて使用し た場合、 開いている 「 ビ デオ・

ビ ュ ーア 」 ウィ ン ド ウはすべて、 ユーザーが値を 変更する ま
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で、 1024 x 768の解像度で表示さ れます。 「 ビ デオ・ビ ュ ーア 」 ウィ

ン ド ウは、 それぞれ異なる 解像度に設定でき ます。

自動スケールが有効になっ ている 場合は、 セッ シ ョ ン 中にウィ ン ド

ウ･サイ ズが変わっ ても 、 スイ ッ チのOBWIは表示を 自動調整し ま

す。 タ ーゲッ ト ・デバイ スの解像度がセッ シ ョ ン 中に変更さ れた場

合でも 、 表示は自動調整さ れます。

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウの解像度を 変更する には次の手順

を 実行し ます。

1 View → Scalingコ マン ド を 選択し ます。

2 希望の解像度を 選択し ます。

ビ ュ ーの調整

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウ内のメ ニュ ーやタ スク ・ボタ ン で

は、 次の機能を 実行でき ます：

• マウス ・カ ーソ ルの位置を 合わせる 。

• 画面を 更新する 。

• 全画面表示モード を 有効／無効にする 。 全画面表示モード が有

効の場合は、 イ メ ージはデスク ト ッ プに合わせて最大1600 x
1200または1680 x 1050( ワイ ド スク リ ーン ) のサイ ズまで調整さ

れます。 デスク ト ッ プの解像度がよ り 高い場合は、 次の現象が

発生し ます。

• 全画面画像はデスク ト ッ プの中央に表示さ れ、 こ の外枠と

なる 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウ領域が黒く 表示さ れま

す。

• メ ニュ ーと ツ ールバーはロ ッ ク さ れ、 常に表示さ れた状態に

なり ます。

• セッ シ ョ ン 画像の自動／フ ル／手動スケールのサイ ズ調整を 有

効にする 。
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• フ ル・スケールでは、 デスク ト ッ プ ・ウィ ン ド ウは固定さ れ、

デバイ スの画像はウィ ン ド ウに合わせてサイ ズ調整さ れま

す。

• 自動スケールでは、 表示中のタ ーゲッ ト ・デバイ スの解像度

に合わせてデスク ト ッ プ ・ウィ ン ド ウのサイ ズが調整さ れま

す。

• 手動スケールでは、 サポート さ れている 画像スケーリ ン グ解

像度がド ロ ッ プダウン ・メ ニュ ーに表示さ れます。

• セッ シ ョ ン 画像の色の階調を 変更する 。

マウスのカ ーソ ルの位置を 合わせる には：

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのツ ールバーで、 Align Local Cursorボ
タ ン を ク リ ッ ク し ます。 ロ ーカ ル・カ ーソ ルの位置がリ モート ・デバ

イ ス上のカ ーソ ルと 揃います。

注： カ ーソ ルが調整し た位置から ずれた場合は、 接続さ れているデバイ
スでのマウス加速度をオフ にし てく ださ い。

画面を 更新する には、 ビ デオ・ビ ュ ーア ･ウィ ン ド ウで、 Refresh Image
ボタ ン を ク リ ッ ク する か、 またはビ デオ・ビ ュ ーア ・ウィ ン ド ウ･メ

ニュ ーから View → Refreshの順に選択し ます。 デジタ ル化さ れたビ デ

オ画像が完全に再生成さ れます。

全画面表示モード を 有効にする には、 Maximizeボタ ン を ク リ ッ ク す

る か、 ビ デオ・ビ ュ ーア ・ウィ ン ド ウ･メ ニュ ーから View → Full Screenの
順に選択し ます。 デスク ト ッ プ ・ウィ ン ド ウは非表示の状態にな

り 、 アク セス中のデバイ スのデスク ト ッ プのみが表示さ れます。 画

面は最大1600 x 1200または1680 x 1050( ワイ ド スク リ ーン ) にサイ

ズ変更さ れます。 モニタ ーのデスク ト ッ プ解像度がこ れよ り 高い場

合は、 フ ル・スク リ ーン 画像が黒の背景で縁取ら れます。 浮動ツ ー

ルバーが表示さ れます。

全画面表示モード を 無効にする には、 浮動ツ ールバー上のFull Screen
Modeボタ ン を ク リ ッ ク し て、 デスク ト ッ プ ・ウィ ン ド ウに戻り ま

す。
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フ ル・スケーリ ン グを 有効にする には、 ビ デオ・ビ ュ ーア ・ウィ ン ド

ウ・メ ニュ ーから View → Scalingの順に選択し て、 Full Scaleを 選択し ま

す。 表示中のタ ーゲッ ト ・デバイ スの解像度に合わせて、 デバイ ス

の画像が自動的に調整さ れます。

手動スケーリ ン グを 有効にする には、 ビ デオ・ビ ュ ーア ・ウィ ン ド ウ・

メ ニュ ーから View → Scalingの順に選択し ます。 ウィ ン ド ウに適用す

る サイ ズを 選択し ます。 利用可能な手動スケールのサイ ズはシステ

ムによ っ て異なり ます。

イ メ ージ の更新

手動ビ デオ調整ダイ アロ グ・ボッ ク スのRefresh Imageボタ ン を ク

リ ッ ク する と 、 デジタ ル化さ れたビ デオ画像が完全に再生成さ れま

す。

注： またイ メ ージは、 「 ビデオ・ビュ ーア」 ウィ ンド ウのメ ニュ ーか
ら View→ Refreshの順に選択し て更新するこ と も できます。

ビ デオの設定

その他のビデオ調整

通常、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウの自動調整機能を 選択し た

場合には、 調整可能な範囲で最高のビ デオ画像に最適化さ れます。

ただし 、 Dellテク ニカ ル・サポート と の連携で 「 ビ デオ・ビ ュ ーア 」

ウィ ン ド ウのメ ニュ ーのTools → Manual Video Adjustコ マン ド を 使用する

か、 Manual Video Adjustボタ ン を ク リ ッ ク する と 、 ユーザーは画質を 微

調整でき ます。 こ れによ り 、 手動ビ デオ調整ダイ アロ グ・ボッ ク ス

が表示さ れます。 ビ デオ調整はタ ーゲッ ト 単位の設定です。

ユーザーは、 ダイ アロ グ・ボッ ク スの左下にある パケッ ト ・レ ート を

見ながら 、 静的画面を サポート する ために必要なパケッ ト 数／秒の

レ ベルを 確認でき ます。
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ウィ ン ド ウのビ デオ画質を 手動で調整する には次の手順を 実行し ま

す。

注： 次のビデオ調整を行う には、 必ずDellテク ニカ ル・サポート と の連携
が必要です。

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 Tools → Manual
Video Adjustの順に選択し ます。

-または -
Manual Video Adjustボタ ン を ク リ ッ ク し ます。

手動ビ デオ調整ダイ アロ グ・ボッ ク スが表示さ れます。

図 4.2. Manual Video Adjustダイ アロ グ・ボッ ク ス

表 4.2: 図 4.2の説明

番号 説明 番号 説明

1 画像キャ プチャ ーの幅 9 自動ビデオ調整

2 ピク セル・サンプリ ング／微調整 10  画像の更新
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番号 説明 番号 説明

3 画像キャ プチャ ーの水平位置 11 調整バー

4 画像キャ プチャ ーの垂直位置 12 ビデオ・テスト ・パタ ーン

5 コ ント ラ スト 13 Help

6 明るさ 14 Performance Monitor

7 ノ イ ズのし きい値 15 Closeボタ ン

8 し きい値優先順位

2 調整し たい機能に対応する アイ コ ン を ク リ ッ ク し ます。

3 まず、 コ ン ト ラ ス ト ・スラ イ ダー・バーを 移動し 、 その後Min( -)
またはMax( +) ボタ ン を ク リ ッ ク し て、 押さ れている 各アイ コ

ン に対応する パラ メ ータ ーを 微調整し ます。 調整は即座に「 ビ

デオ・ビ ュ ーア 」 ウィ ン ド ウに表示さ れます。

4 完了し たら Closeボタ ン を ク リ ッ ク し て、 手動ビ デオ調整ダイ ア

ロ グ・ボッ ク スを 閉じ ます。

タ ーゲッ ト ・ビデオの設定

イ メ ージ ・キャ プチャ ーの幅、 ピ ク セル・サン プ リ ン グ／微調整、 イ

メ ージ ・キャ プチャ ーの水平位置、 イ メ ージ ・キャ プチャ ーの垂直位

置の調整は、 目的のビ デオがどのよ う にキャ プチャ ーさ れ、 デジタ

ル化さ れる かに影響し ますが、 ほと んど変更さ れる こ と はあり ませ

ん。

イ メ ージ ・キャ プチャ ・パラ メ ータ ーは、 自動調整機能によ っ て自動

的に変更さ れます。 正確な調整を 個別に行う ためには、 タ ーゲッ ト

に特別のイ メ ージが必要になり ます。
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自動ビデオ調整

大抵の場合、 ビ デオ設定を デフ ォ ルト 設定から 変更する 必要はあり

ません。 システムが自動的に調整を 行い、 最適なビ デオ・パラ メ ー

タ ーが適用さ れます。 スイ ッ チのOBWIは、 ビ デオ・パラ メ ータ ーが

静的画面用ビ デオ・パケッ ト の送信なし ( ゼロ ) に設定さ れている

と き に最高の性能を 発揮し ます。

ビ デオ･パラ メ ータ ーは、 手動ビ デオ調整ダイ アロ グ･ボッ ク スのAuto
Adjust Videoボタ ン から 、 簡単に希望の設定に調整でき ます。

注： また、 ビデオを自動調整するこ と も できます。 こ の場合は、 「 ビデ
オ・ビュ ーア」 ウィ ンド ウのメ ニュ ーから 、 Tools→ Automatic VideoAdjustを選
択するか、 またはAutomatic VideoAdjustツールバー・アイ コ ンをク リ ッ ク し ま
す。

ビデオ・テスト ・パタ ーン

手動ビ デオ調整ダイ アロ グ・ボッ ク スのVideo Test Patternボタ ン を ク

リ ッ ク する と 、 ビ デオ・テスト ・パタ ーン の表示に切り 替わり ま

す。 Video Test Patternボタ ン を も う 一度ク リ ッ ク する と 、 通常のビ デ

オ画像に切り 替わり ます。

ベンダー固有のビデオ設定

ビ デオ設定はメ ーカ ー間で大幅に変わり ます。 Dellのオン ラ イ ン ･

データ ベースでは、 さ まざまなビ デオ･カ ード ( 特に Sun固有の製

品 ) での最適なビ デオ設定に関する データ を 提供し ています。 こ の

情報は、 Dellのオン ラ イ ン ・ノ レ ッ ジ ・ベースから 検索し ていただく

か、 Dellテク ニカ ル・サービ スまでお電話にてお問い合わせく ださ

い。
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色の設定

色の深度の調整

Dambrackas Video Compression® ( DVC) アルゴリ ズムでは、 リ モー

ト ・セッ シ ョ ン ・ウィ ン ド ウでの表示色数を 調整でき ます。 表示色を

増やすと 色の忠実度がベスト になり 、 色数を 減ら すと ネッ ト

ワーク ・データ 転送量を 減ら すこ と ができ ます。 必要に応じ て調整

し て く ださ い。

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウは、 「 色－最適化」 ( 更新レ ート

は最も 遅く なり ます ) 、 「 圧縮－最適化」 ( 最も 速い更新レ ー

ト ) 、 またはこ の2つの組み合わせ、 または「 グレ ースケール」 で

表示でき ます。

個々のポート と チャ ン ネルの色の階調は、 リ モート ・セッ シ ョ ン ・

ウィ ン ド ウで View Colorコ マン ド を 選択し て指定でき ます。 こ の設定

はチャ ン ネル別に保存さ れます。

コ ン ト ラ スト と 明るさ

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウの画像が暗すぎたり 明る すぎたり

する 場合は、 Tools → Automatic Video Adjustの順に選択する か、 Automatic
Video Adjustボタ ン を ク リ ッ ク し ます。 こ のコ マン ド はまた、 自動ビ

デオ調整ダイ アロ グ・ボッ ク スでも 使用でき ます。 大概の場合、 こ

れでビ デオの問題は修正さ れます。

Auto Adjustを 数回ク リ ッ ク し ても コ ン ト ラ ス ト と 明る さ が希望どおり

に調整さ れない場合は、 こ れら を 手動で調整する こ と で改善でき る

場合があり ます。 明る さ のレ ベルを 上げてみます。 コ ン ト ラ ス ト を

変える 前に、 10目盛り 以上増やさ ないでく ださ い。 一般的に、 コ ン

ト ラ ス ト はほんのわずかの変更ですむはずです。
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ノ イ ズの設定

検出し きい値

ビ デオ通信のノ イ ズがパケッ ト ／秒の読み取り 値に影響し て値が高

く なる こ と があり ます。 こ の場合、 カ ーソ ルを 動かすと カ ーソ ルの

周り で小さ なド ッ ト が変動する ため分かり ます。 し き い値を 変更す

る と 、 「 よ り 安定し た」 画面が得ら れ、 カ ーソ ル・ト ラ ッ キン グを

改善でき ます。

通常のビ デオ圧縮を 使用し ている 場合、 ノ イ ズのし き い値と 優先順

位のし き い値は変更でき ます。 し き い値を デフ ォ ルト に戻すに

は、 Auto Adjust Videoを ク リ ッ ク し ます。

注： ノ イ ズのし きい値をゼロに設定すると 、 ビデオが継続的に更新さ れ
るため、 ネッ ト ワーク 利用率が上がり 、 ビデオのちら つきが起こ り ま
す。 ノ イ ズのし きい値は最大に設定し 、 移動するマウス・カ ーソ ルの下
のピク セルの色が復元さ れる間も 、 システム性能を効率化するこ と をお
薦めし ています。

注： ノ イ ズのし きい値を調整する場合、 大き く 調整するにはスラ イ
ダー・バーを、 微調整するにはスラ イ ダー・バーの両端のPlus( +) ボタ ン
と Minus( -) ボタ ンを使用し ます。

色の階調の変更に関する 詳細は、 「 ビ ュ ーの調整」 ( ページ 96) を

参照し て く ださ い。

マウスの設定

マウス・オプショ ンの調整

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのマウス ・オプシ ョ ン では、 カ ーソ

ル・タ イ プ 、 カ ーソ ル・モード 、 マウス ・スケール、 位置合わせ、 およ

びリ セッ ト を 調整でき ます。 マウスの設定は、 デバイ スで固有で

す。 すなわち 、 デバイ スごと に異なる 設定ができ ます。
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注： マウスをプラ グ・アンド ・リ プラ グする機能をデバイ スでサポート し
ていない場合( 新し いPCのほと んどがこ の機能をサポート し ていま
す ) 、 マウスは使用不能になり 、 デバイ スの再起動が必要になり ます。

カ ーソ ル・タ イ プ

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーではロ ーカ ルのマウス ・

カ ーソ ル用に 5種類の表示オプショ ン があり ます。 また、 カ ーソ ル

「 なし 」 か、 デフ ォ ルト 設定にする こ と も でき ます。

「 Single Cursorル」 モード では、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウの

ロ ーカ ル ( 第二 ) カ ーソ ルの表示がオフ になり 、 タ ーゲッ ト ・デバイ

スのマウス ・ポイ ン タ ーだけが表示さ れます。 表示さ れる マウスの

動き は、 タ ーゲッ ト ・デバイ スのリ モート ・カ ーソ ルのも のだけにな

り ます。 「 Single Cursor」 モード は、 ロ ーカ ル・カ ーソ ルが不要な場合

に使用し ます。

図 4.3. ロ ーカ ルと リ モート の両方のカ ーソ ルが表示さ れた状態の「 ビ デオ・ビ ュ ー

ア 」 ウィ ン ド ウ
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表 4.3: 図 4.3の説明

番号 説明

1 リ モート ・カ ーソ ル

2 ローカ ル・カ ーソ ル

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウがどのカ ーソ ル・モード になっ てい

る かは、 タ イ ト ル・バーに、 「 Single Cursor」 モード の終了に使用する

キースト ロ ーク と 共に表示さ れます。 「 Single Cursor」 モード を 終了

さ せる ためのキースト ロ ーク は、 「 セッ シ ョ ン ・オプシ ョ ン 」 ダイ

アロ グ・ボッ ク スで定義でき ます。

注： ク ラ イ アント ・サーバーに送ら れる前にキースト ローク をキャ プ
チャ ーするデバイ スを使用し ている場合は、 マウス・ポイ ンタ ーの復元に
こ れら のキーを使用するこ と は避けてく ださ い。

「 Single Cursor」 モード を 開始する には、 「 ビ デオ・ビ ュ ーア 」 ウィ ン

ド ウ・メ ニュ ーから Tools → Single Cursor Modeの順に選択する か、 また

はSingle Cursor Modeボタ ン を ク リ ッ ク し ます。 ロ ーカ ル・カ ーソ ルは表

示さ れず、 すべての動き がタ ーゲッ ト ・デバイ スに対応し ます。

既存の「 Single Cursor」 モード を 終了する ためのキーを 選択する に

は：

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 Tools → Session
Options の順に選択し ます。

-または -
Session Optionsボタ ン を ク リ ッ ク し ます。

「 Session Options」 ダイ アロ グ・ボッ ク スが表示さ れます。

2 Mouseタ ブを ク リ ッ ク し ます。

3 「 Single Cursor」 モード 領域内のド ロ ッ プダウン ・メ ニュ ーから 、

終了用キースト ロ ーク を 選択し ます。

4 Saveを ク リ ッ ク し て、 設定内容を 保存し ます。
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「 Single Cursor」 モード を 有効にし た場合、 先ほど指定し たキーを 使

用すれば、 「 通常のデスク ト ッ プ 」 モード に戻れます。

「 Single Cursor」 モード を 終了する には、 タ イ ト ル・バーに表示さ れて

いる 終了用のキーを 押し ます。

マウス ・カ ーソ ルの設定を 変更する には次の手順を 実行し ます。

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 Tools → Session
Optionsの順に選択し ます。

-または -
Session Optionsボタ ン を ク リ ッ ク し ます。

「 Session Options」 ダイ アロ グ・ボッ ク スが表示さ れます。

2 Mouseタ ブを ク リ ッ ク し ます。

3 「 Local Cursor」 パネルでマウス ・カ ーソ ル・タ イ プを 選択し ま

す。

4 OKを ク リ ッ ク し て設定内容を 保存し ます。

マウス・スケール

Linuxの以前バージョ ン の一部では、 マウス加速度の調整がサポート

さ れていませんでし た。 こ れら の古いバージョ ン にイ ン スト ールす

る 必要がある 場合は、 事前設定さ れている 3種類のマウス ・スケー

ル・オプシ ョ ン から 選ぶか、 またはカ スタ ム・スケールを 設定でき ま

す。 前も っ て構成さ れている 設定は、 Default (1:1)、 High (2:1) または

Low (1:2) の3つです。

• 1:1のスケール率では、 デスク ト ッ プ ・ウィ ン ド ウでのマウスのす

べての動き は、 実際のマウスの動き と 等し い動き と し てタ ー

ゲッ ト ・デバイ スに送ら れます。

• 2:1のスケール率では、 同一のマウスの動き は2倍速の動き と し て

送ら れます。

• 1:2のスケール率では、 こ の値は2分の1になり ます。
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マウス ・スケールを 設定する には：

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 Tools → Session
Optionsの順に選択し ます。

-または -
Session Options ボタ ン を ク リ ッ ク し ます。

「 Session Options」 ダイ アロ グ・ボッ ク スが表示さ れます。

2 Mouseタ ブを ク リ ッ ク し ます。

3 規定の設定の1つを 使用する には、 該当する オプショ ン ・ボタ ン

を オン にし ます。

-または -
カ スタ ム・スケールを 設定する には：

a. Customオプショ ン ・ボタ ン を ク リ ッ ク し て、 Xフ ィ ールド と Y
フ ィ ールド を 有効にし ます。

b. スケール値を 「 X」 フ ィ ールド と 「 Y」 フ ィ ールド に入力し ま

す。 マウスの各入力に対し 、 マウスの動き は、 Xと Yの各ス

ケール係数を 乗じ た動き と なり ます。 有効な入力範囲

は、 0.25～3.00です。

マウス位置合わせと 同期

スイ ッ チのOBWIではマウスから のフ ィ ード バッ ク を 継続的に得る

こ と はでき ないため、 スイ ッ チでのマウスの動作がホスト ・システ

ムのマウス動作と 同期し な く なる こ と があり ます。 マウスやキー

ボード が正し く 応答し な く なっ た場合は、 マウスを 調整し て適切な

ト ラ ッ キン グが得ら れる よ う にでき ます。

位置合わせを 調整する こ と で、 ロ ーカ ル・カ ーソ ルがリ モート ・タ ー

ゲッ ト ・デバイ スのカ ーソ ルと 揃う よ う になり ます。 リ セッ ト を 行

う と 、 マウスと キーボード を 一度接続解除し て接続し 直し たかのよ

う な効果が得ら れます。
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マウスの位置を 再度合わせる には、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド

ウのツ ールバーで Align Local Cursorボタ ン を ク リ ッ ク し ます。

バーチャ ル・メ ディ ア

バーチャ ル・メ ディ ア機能を 使用する と 、 ク ラ イ アン ト ・サーバー上

のユーザーは、 そのマシン の物理ド ラ イ ブを バーチャ ル・ド ラ イ ブ と

し てタ ーゲッ ト ・デバイ ス上にマッ ピ ン グでき ます。 また、 ク ラ イ

アン ト ・サーバーは ISOまたはフ ロ ッ ピ ーのイ メ ージ ・フ ァ イ ルを バー

チャ ル・ド ラ イ ブ と し てタ ーゲッ ト ・デバイ ス上に追加し 、 マッ ピ ン

グでき ます。 同時にマッ ピ ン グでき る のは、 CDド ラ イ ブ 1台と 大容

量記憶装置1台です。

• CD／DVDド ラ イ ブ 、 ディ スク ・イ メ ージ ・フ ァ イ ル ( ISOまたは

フ ロ ッ ピ ーのイ メ ージ ・フ ァ イ ルなど ) は、 バーチャ

ルCD／DVD-ROMド ラ イ ブ と し てマッ ピ ン グさ れます。

• フ ロ ッ ピ ー・ド ラ イ ブ 、 USBメ モリ ー・デバイ ス、 その他のメ ディ

ア ・タ イ プは、 バーチャ ル大容量記憶装置と し てマッ ピ ン グさ れ

ます。

OBWIを 使用する バーチャ ル・メ ディ ア ・セッ シ ョ ン 設定の構成に関

する 詳細は、 「 ロ ーカ ル・バーチャ ル・メ ディ ア ・セッ シ ョ ン の構成」

( ページ 81) を 参照し て く ださ い。

要件

タ ーゲッ ト ・デバイ スは、 バーチャ ル・メ ディ アを サポート し 、 USB2
またはUSB2およ びCAC用SIPを 備えた KVMスイ ッ チに接続さ れてい

る 必要があり ます。

タ ーゲッ ト ・デバイ スは、 バーチャ ルにマッ ピ ン グし よ う と し てい

る USB2対応メ ディ ア ・タ イ プを 利用可能なデバイ スである 必要があ

り ます。 すなわち 、 タ ーゲッ ト ・デバイ スがポータ ブルUSBメ モリ ー・

デバイ スを サポート し ていない場合は、 ク ラ イ アン ト ・サーバー上の

メ モリ ー・デバイ スを バーチャ ル・メ ディ ア ・ド ラ イ ブ と し てタ ーゲッ

ト ・デバイ スにマッ ピ ン グする こ と はでき ません。
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ユーザー( またはユーザーが所属する ユーザー・グループ ) には、 タ ー

ゲッ ト ・デバイ スに対する バーチャ ル・メ ディ ア ・セッ シ ョ ン や予約

済みバーチャ ル・メ ディ ア ・セッ シ ョ ン を 確立する アク セス権が必要

です。 「 ユーザー・アカ ウン ト のセッ ト アッ プ 」 ( ページ 86) を 参

照し て く ださ い。

タ ーゲッ ト ・デバイ スに対し てアク テ ィ ブにでき る バーチャ ル・メ

ディ ア ・セッ シ ョ ン は、 一度に 1つだけです。

共有およびプリ エンプト 操作の考慮事項

KVMセッ シ ョ ン と バーチャ ル・メ ディ ア ・セッ シ ョ ン は別個のも ので

す。 し たがっ て、 共有／専用／プリ エン プ ト ・セッ シ ョ ン には多く

のオプショ ン があり ます。 Avocent管理ソ フ ト ウェ アには、 さ まざ

まなシステム・ニーズに対応でき る 柔軟性があり ます。

たと えば、 KVMセッ シ ョ ン と バーチャ ル・メ ディ ア ・セッ シ ョ ン を 同

時にロ ッ ク でき ます。 こ のモード では、 KVMセッ シ ョ ン の接続が解

除さ れる と 、 関連付けら れている バーチャ ル・メ ディ ア ・セッ シ ョ ン

の接続も 解除さ れます。 こ れら のセッ シ ョ ン が同時にロ ッ ク さ れて

いない場合は、 バーチャ ル・メ ディ ア ・セッ シ ョ ン を アク テ ィ ブにし

たまま 、 KVMセッ シ ョ ン を 終了でき ます。 こ の機能は、 ユーザーが

バーチャ ル・メ ディ ア ・セッ シ ョ ン を 使用し て時間がかかる タ スク

( オペレ ーテ ィ ン グ・システムのロ ード など ) を 実行し ている と き

に、 処理の進行中に他の機能を 実行する ために異なる タ ーゲッ ト ・

デバイ スと KVMセッ シ ョ ン を 確立し たい場合などに役立ち ます。

関連する KVMセッ シ ョ ン なし にバーチャ ル・メ ディ ア ・セッ シ ョ ン が

タ ーゲッ ト ・デバイ スでいっ たんアク テ ィ ブになっ た場合は、 その

チャ ン ネルにオリ ジナル・ユーザー( ユーザーA) が再接続する か、

別のユーザー( ユーザーB) が接続でき ます。 「 バーチャ ル・メ ディ

ア 」 ダイ アロ グ・ボッ ク スにある オプショ ン ( 「 予約済み」 ) を 設

定する と 、 KVMセッ シ ョ ン でそのチャ ン ネルへのアク セスを ユー

ザーAにのみ許可でき ます。

ユーザーBにこ のKVMセッ シ ョ ン へのアク セスを 許可し た

( 「 Reserved」 オプシ ョ ン が無効になっ ている ) 場合は、 ユーザーB
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がバーチャ ル・メ ディ ア ・セッ シ ョ ン で使用さ れている メ ディ アを 制

御でき ます。 テ ィ アド ( 階層 ) 接続環境で 「 Reserved」 オプシ ョ ン

を 使用する と 、 ユーザーAにのみ下層スイ ッ チへのアク セスを 許可

し 、 また上層スイ ッ チと 下層スイ ッ チ間のKVMチャ ン ネルを ユー

ザーA用に予約でき ます。

Virtual Mediaダイ アログ・ボッ ク ス

「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スでは、 バーチャ ル・メ

ディ アのマッ ピ ン グと アン マッ ピ ン グを 管理でき ます。 こ のダイ ア

ロ グ・ボッ ク スには、 バーチャ ル・ド ラ イ ブ と し てマッ ピ ン グ可能

なク ラ イ アン ト ・サーバー上の物理ド ラ イ ブがすべて表示さ れま

す。 「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スを 使用する

と 、 ISOやフ ロ ッ ピ ーのイ メ ージ ・フ ァ イ ルを 追加し た後で、 それら

を マッ ピ ン グする こ と も でき ます。

デバイ スを マッ ピ ン グする と 、 「 バーチャ ル・メ ディ ア 」 ダイ アロ

グ・ボッ ク スの詳細表示に、 転送さ れたデータ 量と 、 デバイ スの

マッ ピ ン グ後に経過し た時間に関する 情報が表示さ れます。

バーチャ ル・メ ディ ア ・セッ シ ョ ン は、 予約済みと し て指定でき ま

す。 セッ シ ョ ン が予約さ れ、 関連付けら れている KVMセッ シ ョ ン が

終了し た場合は、 他のユーザーがこ のタ ーゲッ ト ・デバイ スへのKVM
セッ シ ョ ン を 起動する こ と はでき ません。 セッ シ ョ ン が予約さ れて

いない場合は、 別のKVMセッ シ ョ ン を 起動でき ます。

Virtual Mediaダイ アロ グ・ボッ ク スから は、 SIPを リ セッ ト する こ と も

でき ます。 こ の操作によ り 、 タ ーゲッ ト ・デバイ ス上のすべてのUSB
メ ディ アがリ セッ ト さ れます。 こ の操作はタ ーゲッ ト ・デバイ スが

応答し ない場合にのみ、 注意し て実行し て く ださ い。

バーチャ ル・メ ディ ア・セッ ショ ンの開始

バーチャ ル・メ ディ ア ・セッ シ ョ ン を 起動する には次の手順を 実行し

ます。

ビ デオ・ビ ュ ーアのメ ニュ ーから 、 Tools → Virtual Mediaを 選択し ます。

「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スが表示さ れます。
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セッ シ ョ ン を 予約済みにする には、 Detailsを ク リ ッ ク し てか

ら 、 Reservedチェ ッ ク ボッ ク スを オン にし ます。

図 4.4. ビ デオ・ビ ュ ーアの「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク ス

バーチャ ル・メ ディ ア ・ド ラ イ ブを マッ ピ ン グする には次の手順を 実

行し ます。

1 ビ デオ・ビ ュ ーア ・メ ニュ ーから 、 Tools → Virtual Mediaを 選択し て

バーチャ ル・メ ディ ア ・セッ シ ョ ン を 開始し ます。

2 バーチャ ル・メ ディ ア ・ド ラ イ ブ と し て物理ド ラ イ ブを マッ ピ ン

グする には次の手順を 実行し ます。

a. 「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スで、 マッ ピ ン

グする ド ラ イ ブの横にある Mappedチェ ッ ク ボッ ク スを オン に

し ます。

b. マッ ピ ン グする ド ラ イ ブを 読み取り 専用アク セスに制限す

る 場合は、 ド ラ イ ブの横にある Read Onlyチェ ッ ク ボッ ク スを
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オン にし ます。 マッ ピ ン グさ れたすべてのド ラ イ ブがバー

チャ ル・メ ディ ア ・セッ シ ョ ン の設定で既に読み取り 専用に

なっ ている 場合は、 こ のチェ ッ ク ボッ ク スがあら かじ めオ

ン になり 、 こ れを 変更する こ と はでき ません。

セッ シ ョ ン の設定で読み取り ／書き 込みアク セスが

有効になっ ている も のの、 特定のド ラ イ ブへのアク

セスを 読み取り 専用に制限し たい場合は、 Read Only
チェ ッ ク ボッ ク スを オン にし ます。

3 ISOまたはフ ロ ッ ピ ー・イ メ ージを バーチャ ル・メ ディ ア ・ド ラ イ ブ

と し て追加し てマッ ピ ン グする には次の手順を 実行し ます。

a. 「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スで、 Add Image
を ク リ ッ ク し ます。

b. 共通のフ ァ イ ル・ダイ アロ グ・ボッ ク スが表示さ れ、 ディ

スク ・イ メ ージ ・フ ァ イ ル ( .isoか .imgの拡張子を 持つフ ァ イ

ル ) を 格納し ている ディ レ ク ト リ が表示さ れます。 ISOまた

はフ ロ ッ ピ ー・イ メ ージ ・フ ァ イ ルを 選択し て、 Openを ク

リ ッ ク し ます。

-または -
ク ラ イ アン ト ・サーバーのオペレ ーテ ィ ン グ・システム

がド ラ ッ グ・アン ド ・ド ロ ッ プを サポート し ている 場

合は、 ISOまたはフ ロ ッ ピ ー・イ メ ージ ・フ ァ イ ルを 共

通フ ァ イ ル・ダイ アロ グ・ボッ ク スから 選択し 、 それ

を 「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スに

ド ラ ッ グし ます。

c. 確認のため、 フ ァ イ ル・ヘッ ダーにチェ ッ ク 印がつき ます。

チェ ッ ク 印がつく と 共通フ ァ イ ル・ダイ アロ グ・ボッ ク スが

閉じ 、 選択し たイ メ ージ ・フ ァ イ ルが「 バーチャ ル・メ ディ

ア 」 ダイ アロ グ・ボッ ク スに表示さ れます。 こ のダイ アロ

グ・ボッ ク スのMappedチェ ッ ク ボッ ク スを オン にする と 、

フ ァ イ ルのマッ ピ ン グが可能になり ます。
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d. 他にも ISOやフ ロ ッ ピ ー・イ メ ージを 追加し たい場合は、 こ れ

ら の手順を 繰り 返し ます。 イ メ ージ ・フ ァ イ ルは ( メ モリ ー

の容量範囲内で ) いく つでも 追加でき ますが、 バーチャ ル

のCD、 DVDまたは大容量記憶装置は同時に 1つし かマッ ピ

ン グでき ません。

マッ ピ ン グし よ う と し ている ド ラ イ ブの数が多すぎたり ( 1台のCD
またはDVDド ラ イ ブ と 1台の大容量記憶装置 ) 、 特定タ イ プのド ラ

イ ブの数が多すぎる ( 2台以上のCDまたはDVDド ラ イ ブか大容量記

憶装置 ) 場合は、 メ ッ セージが表示さ れます。 新し いド ラ イ ブを

マッ ピ ン グする 場合は、 まず現在マッ ピ ン グさ れている ド ラ イ ブを

アン マッ プ し てから 別のド ラ イ ブを マッ ピ ン グする 必要があり ま

す。

物理ド ラ イ ブかイ メ ージのマッ ピ ン グが完了する と 、 タ ーゲッ ト ・

デバイ スで使用でき る よ う になり ます。

バーチャ ル・メ ディ ア ・ド ラ イ ブのマッ ピ ン グを 解除する に：

1 「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スで、 アン マッ プ

する ド ラ イ ブの横にある Mappedチェ ッ ク ボッ ク スを オフ にし ま

す。

2 確認を 求める メ ッ セージが表示さ れます。 アン マッ プを 確定す

る か、 キャ ン セルし ます。

3 アン マッ プする バーチャ ル・メ ディ ア ・ド ラ イ ブごと に上記の手

順を 繰り 返し ます。

バーチャ ル・メ ディ ア ・ド ラ イ ブの詳細を 表示する には次の手順を 実

行し ます。

「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スで、 Detailsを ク

リ ッ ク し ます。 ダイ アロ グ・ボッ ク スが拡張さ れ、 「 詳細」 の表が

表示さ れます。 各行の情報は、 次のと おり です：

• タ ーゲッ ト ・ド ラ イ ブ － マッ ピ ン グさ れたド ラ イ ブの名前

( バーチャ ルCD 1やバーチャ ルCD 2など ) 。
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• マッ ピ ン グ先 － 「 ク ラ イ アン ト 表示」 の「 ド ラ イ ブ 」 列に表

示さ れている ド ラ イ ブ情報と 同じ 。

• 読み取り バイ ト 数およ び書き 込みバイ ト 数 － マッ ピ ン グを

行っ てから 転送さ れたデータ 量。

• Duration － ド ラ イ ブを マッ ピ ン グし てから 経過し た時間。

「 詳細」 表示を 閉じ る には、 Detailsを 再度ク リ ッ ク し ます。

タ ーゲッ ト ・デバイ ス上のすべてのUSBデバイ スを リ セッ ト する には

次の手順を 実行し ます。

注： USBリ セッ ト 機能は、 タ ーゲッ ト ・デバイ ス上のすべてのUSBメ ディ
ア ( マウスおよびキーボード を含む ) をリ セッ ト し ます。 こ の操作を実
行するのはタ ーゲッ ト ・デバイ スが応答し ない場合のみに限定し てく だ
さ い。

1 「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スで、 Detailsを ク

リ ッ ク し ます。

2 「 Details」 ビ ュ ーが表示さ れます。 USB Resetを ク リ ッ ク し ます。

3 リ セッ ト し た場合の影響を 警告する メ ッ セージが表示さ れま

す。 リ セッ ト を 確定する か、 キャ ン セルし ます。

4 「 詳細」 表示を 閉じ る には、 Detailsを 再度ク リ ッ ク し ます。

バーチャ ル・メ ディ ア・セッ ショ ンの終了

「 バーチャ ル・メ ディ ア 」 ダイ アロ グ・ボッ ク スを 閉じ る には次の手

順を 実行し ます。

1 Exitを ク リ ッ ク し ます。

2 マッ ピ ン グし たド ラ イ ブがある 場合は、 アン マッ プ さ れる 旨の

メ ッ セージが表示さ れます。 操作を 確定する か、 キャ ン セルし

ます。

バーチャ ル・メ ディ ア ・セッ シ ョ ン 、 も し く はバーチャ ル・メ ディ ア ・

セッ シ ョ ン が関連付けら れてロ ッ ク さ れたアク テ ィ ブな KVMセッ
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ショ ン を ユーザーが接続解除し よ う と する と 、 バーチャ ル・メ ディ ア

のマッ ピ ン グが失われる 旨の確認メ ッ セージが表示さ れます。

スマ ート ･カ ード

ク ラ イ アン ト ･サーバーの利用可能な USBポート にスマート ･カ ード ･

リ ーダーを 接続し て、 スイ ッ チ ･システムに接続さ れている タ ーゲッ

ト ・デバイ スにアク セスでき ます。 その後、 KVMセッ シ ョ ン を 起動

し てビ デオ・ビ ュ ーアを 開き 、 スマート ・カ ード を マッ ピ ン グでき ま

す。

注： すべてのスマート ・カ ード ・リ ーダーには、 DellのUSB2およびCAC用SIP
またはAvocent VMC IQモジュ ールを使用する必要があり ます。

スマート ・カ ード の状態は、 ビ デオ・ビ ュ ーアのツ ールバーの右端にあ

る スマート ・カ ード ・アイ コ ン に表示さ れます。 次の表にスマート ・

カ ード のステータ ス ・アイ コ ン の概要を 示し ます。

表 4.4: スマート ･カ ード のアイ コ ン

アイ コ ン 説明

スマート ・カ ード がスマート ・カ ード ・リ ーダーに挿入さ

れていないか、 またはスマート ・カ ード ・リ ーダーが接

続さ れていません。

スマート ・カ ード はスマート ・カ ード ・リ ーダーに挿入さ

れていますが、 まだマッ ピングさ れていません。

スマート ・カ ード はマッ ピングさ れています ( 緑のア

イ コ ン ) 。

スマート ・カ ード を マッ ピ ン グする には次の手順を 実行し ます。

1 KVMセッ シ ョ ン を 開始し 、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ

ニュ ーを 表示し ます。
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2 ク ラ イ アン ト ･サーバーに接続さ れている スマート ･カ ード ･リ ー

ダーにスマート ･カ ード を 挿入し ます。

3 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウ・メ ニュ ーで、 Tools → Map Smart
Cardの順にク リ ッ ク し ます。

4 タ ーゲッ ト ・デバイ スにマッ ピ ン グさ れている スマート ・カ ード が

ない場合は、 「 マッ ピ ン グ済みのカ ード はあり ません」 オプ

シ ョ ン の横にド ッ ト が表示さ れます。 こ のオプショ ン の下の一

覧から スマート ・カ ード を 選び、 スマート ・カ ード を マッ ピ ン グし

ます。

スマート ・カ ード を アン マッ プする には、 「 ビ デオ・ビ ュ ーア 」 ウィ

ン ド ウのメ ニュ ーのXを ク リ ッ ク し て KVMセッ シ ョ ン を 終了

し 、 Tools → No Card Mappedの順に選択し 、 スマート ・カ ード ・リ ーダー

から スマート ・カ ード を 取り 外すか、 またはク ラ イ アン ト ・サーバー

と スマート ・カ ード ・リ ーダーと の接続を 解除し ます。

キーボード ・パス スルー

ユーザーが入力する キースト ロ ーク は、 「 ビ デオ・ビ ュ ーア 」 ウィ ン

ド ウの画面表示モード に従っ て 2種類に解釈さ れます。

• 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウが全画面表示 ( Full Screen) モー

ド の場合、 すべてのキースト ロ ーク およ びCtrl-Alt-Delを 除く キース

ト ロ ーク の組み合わせのすべてが、 表示中のリ モート ・タ ーゲッ

ト ・デバイ スに送ら れます。

• 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウが通常のデスク ト ッ プ ・モード

の場合、 特定のキースト ロ ーク やキーの組み合わせを リ モート ・

タ ーゲッ ト ・デバイ スと ロ ーカ ル・コ ン ピ ュ ータ ーのどち ら で認識

さ せる よ う にする かを 、 キーボード ・パススルー・モード によ っ て

制御でき ます。

こ れには、 キーボード ・パススルーを 「 セッ シ ョ ン ・オプシ ョ ン 」 ダ

イ アロ グ・ボッ ク スで設定する 必要があり ます。 キーボード ・パス ・ス

ルー・モード が有効になっ ている と 、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド
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ウがアク テ ィ ブであれば、 すべてのキースト ロ ーク およ びCtrl-Alt-Del
を 除く キースト ロ ーク の組み合わせのすべてが、 表示中のリ モート ・

タ ーゲッ ト ・デバイ スに送ら れます。 ロ ーカ ル・デスク ト ッ プがアク

テ ィ ブになっ ている 場合、 ユーザーが入力し たキースト ロ ーク と キー

スト ロ ーク の組み合わせはロ ーカ ル・コ ン ピ ュ ータ ーに反映さ れま

す。

注： Ctrl-Alt-Deleteのキースト ローク の組み合わせは、 マク ロを使用し なけ
ればリ モート ・タ ーゲッ ト ・デバイ スに送るこ と はできません。

注： 日本語キーボード のALT - 半角／全角キースト ローク の組み合わせ
は、 画面モード やキーボード ・パススルー・モード の設定に関係なく 、 常
にリ モート ・タ ーゲッ ト ・デバイ スに送ら れます。

キーボード ・パススルーを 指定する には：

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 Tools → Session
Optionsの順に選択し ます。

-または -
Session Options ボタ ン を ク リ ッ ク し ます。

「 セッ シ ョ ン ・オプシ ョ ン 」 ダイ アロ グ・ボッ ク スが表示さ

れます。

2 Generalタ ブを ク リ ッ ク し ます。

3 Pass-through all keystrokes in regular window modeを 選択し ます。

4 OKを ク リ ッ ク し て設定内容を 保存し ます。

マ ク ロ

スイ ッ チのOBWIには、 Windows、 Linux、 およ び Sunのプラ ッ ト

フ ォ ーム用にマク ロ が既定さ れています。

マク ロ を 実行する には、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ

ニュ ーから Macros → <目的のマク ロ > を 選択する か、 またはビ デオ・

ビ ュ ーア ・メ ニュ ーにある ボタ ン から 実行する マク ロ を 選択し ま

す。
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表示の保存

「 ビ デオ・ビ ュ ーア 」 の表示は、 フ ァ イ ルに保存する か、 またはク

リ ッ プボード にコ ピ ーし て、 ワード ・プロ セッ サーやその他のプロ グ

ラ ムで使用でき ます。

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウを フ ァ イ ルにキャ プチャ ーする に

は：

1 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから 、 File → Capture to
Fileの順に選択し ます。

-または -
Capture to Fileボタ ン を ク リ ッ ク し ます。

「 名前を つけて保存」 ダイ アロ グ・ボッ ク スが表示さ れま

す。

2 フ ァ イ ル名を 入力し 、 フ ァ イ ルの保存先を 指定し ます。

3 Saveボタ ン を ク リ ッ ク し 、 ウィ ン ド ウの画像を フ ァ イ ルに保存

し ます。

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウを ク リ ッ プボード にキャ プチャ ーす

る には、 「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウのメ ニュ ーから File →

Capture to Clipboardにキャ プチャ の順に選択する か、 またはCapture to
Clipboardボタ ン を ク リ ッ ク し ます。 イ メ ージ ・データ がク リ ッ プボー

ド に保存さ れます。

セッ シ ョ ン の終了

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウ・セッ シ ョ ン を 終了する には次の手

順を 実行し ます。

「 ビ デオ・ビ ュ ーア 」 ウィ ン ド ウから File → Exitの順に選択し ます。
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RCSの LDAP機能

LDAPは、 TCP/IPを 使用する ディ レ ク ト リ のアク セスおよ び更新に

使用さ れる プロ ト コ ルの規格です。 Dell RCSソ フ ト ウェ アおよ

びOBWIは、 標準スキーマと Dell拡張スキーマの両方を サポート し て

おり 、 認証、 プラ イ バシー、 およ び統合性などの強固なセキュ リ

テ ィ 機能を 提供し ます。

注： IPv6モード で LDAPを使用するには、 Windows 2008 Serverが必要です。

注： Active Directoryを使用し て RCSユーザーを認識する機能は、 Microsoft
Windows® 2000およびWindows Server 2003オペレーティ ング・システムでサ
ポート さ れています。

Active Directoryの構造

Active Directory( AD) 配置は、 オブジェ ク ト の階層構造を 持つ分散

型データ ベースで構成さ れています。 各オブジェ ク ト は、 そのオブ

ジェ ク ト に保存でき る データ の種類を 決定する オブジェ ク ト ・ク ラ

スと 関連付けら れています。 階層的構造はADド メ イ ン を 表すオブ

ジェ ク ト で始まり 、 ド メ イ ン 名の階層を 形成する よ う に配置さ れて

おり 、 こ の階層は、 DNS名前空間が通常描かれる のと 同じ 方法のツ

リ ー図で表現でき ます。 Dell RCSは、 浅いまたは深い階層的名前構

造に展開さ れたド メ イ ン の単一ツ リ ーを サポート する よ う に設計さ

れています。

ド メ イ ン ・コ ン ト ローラ ー・コ ンピュ ータ ー

ド メ イ ン 階層には、 ADがLDAPサービ スを 提供し ている ド メ イ ン ・コ

ン ト ロ ーラ ー・コ ン ピ ュ ータ ーの対応する 階層が関連付けら れていま
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す。 各ド メ イ ン が、 複数のピ ア ・ド メ イ ン ・コ ン ト ロ ーラ ーを 持つ場

合や、 地理的なサイ ト 全般にも わたっ ている 場合があり ます。 Dell
RCSのパッ ケージは、 ADのこ れら の両側面を サポート する よ う に設

計さ れています。 Dell RCSは、 DNSを 使用し てそれぞれのド メ イ ン ・

コ ン ト ロ ーラ ーのネッ ト ワーク 座標を 決定する ため、 ネッ ト ワーク

上で一部のド メ イ ン ・コ ン ト ロ ーラ ーが使用でき ない状況でも 正常

に処理でき ます。 DNS SRVレ コ ード がこ の目的で使用さ れる た

め、 Dell RCSは、 SRVレ コ ード に構成さ れた管理設定に基づいて、 常

にも っ と も 近いサイ ト から 先に代替ド メ イ ン ・コ ン ト ロ ーラ ーと の

接続を 試みます。

オブジェ ク ト ・ク ラ ス

各ド メ イ ン 内に、 さ まざまなエン テ ィ テ ィ やエン テ ィ テ ィ のグルー

プ分けについての情報を 保存する ために設計さ れた別のオブジェ ク

ト 階層があり ます。 こ れら のエン テ ィ テ ィ はAD内で、 オブジェ ク

ト のグループ分けを 編成する 役割を 果たす「 コ ン テナ」 を 定義する

ために使用さ れる オブジェ ク ト ・ク ラ スによ っ て表現さ れていま

す。 ほかのオブジェ ク ト ・ク ラ スは、 ネッ ト ワーク ・ユーザー、 コ ン

ピ ュ ータ ー、 プ リ ン タ ー、 またはネッ ト ワーク ・サービ スなどのエン

テ ィ テ ィ を 表し ます。 コ ン テナ・オブジェ ク ト ・ク ラ スの中で特に興

味深いも のは、 グループと 組織単位 ( OU) の2種類です。 こ れら

の2つのオブジェ ク ト ・ク ラ スを 使用し て、 エン テ ィ テ ィ のグループ

分けを 定義でき る ため、 AD管理者はアク セス制御やその他の管理

ポリ シーの適用を 簡素化でき ます。 たと えば、 ド メ イ ン

を Engineeringと いう 名前のOUコ ン テナを 持つよ う に構成し 、 その中

にHardware、 Software、 Supportなど機能に応じ た名前の付けら れた複

数のグループ ・オブジェ ク ト を 含め、 各グループにはUserオブジェ ク

ト のメ ン バーシッ プ ・リ ス ト 、 またコ ン ピ ュ ータ ー・オブジェ ク ト の

メ ン バーシッ プ ・リ ス ト などを 構成し ます。 さ ら に、 グループを ネ

スト する こ と で、 さ ら にも う 1つの階層レ ベルを 構成でき ます。 ネ

スト は、 グループ ・オブジェ ク ト の名前を 別のグループ ・オブジェ ク

ト のメ ン バーシッ プに含める こ と によ っ て形成さ れます。 各ADグ

ループ ・オブジェ ク ト には関連付けら れたスコ ープがあり 、 他のグ

ループと の間で許可さ れる ネスト 関係のタ イ プを 構成する ために使
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用さ れる こ と に注意し て く ださ い。 たと えば、 スコ ープがユニバー

サルに設定さ れている 場合、 グループはド メ イ ン 境界を 越える ネス

ト に参加でき ますが、 スコ ープがロ ーカ ルに設定さ れている 場合

は、 グループはそのよ う なネスト に参加でき ません。 ネスト の規則

は、 Microsoft社から 入手可能な AD製品のマニュ アルに記載さ れてい

ます。 Dell RCSのパッ ケージは、 ADに定義さ れている すべてのネス

ト 規則を サポート する よ う に設計さ れています。

属性

ADで使用さ れる 階層は、 も う 1つあり ます。 各オブジェ ク ト ・ク ラ

スには、 表現さ れている エン テ ィ テ ィ についての特定の情報を 保存

する ために使用さ れる 一連の「 属性」 が関連付けら れています。 た

と えば、 Userオブジェ ク ト ・ク ラ スには、 SAM ACCOUNT NAMEと い

う 名前の属性タ イ プや、 FIRST NAME、 SURNAME、 PASSWORDなど

を 関連付けら れます。 Dellリ モート ・コ ン ト ロ ール・スイ ッ チのパッ

ケージでは、 SAM ACCOUNT NAMEと PASSWORDの属性を 使用し

て、 ユーザーを 認証し ます ( こ れら の2つの属性の正式な AD名は、

それぞれ sAMAccountNameと unicodePWDです ) 。

スキーマの拡張

ADには、 コ ン ピ ュ ータ ー・オブジェ ク ト と ユーザー・オブジェ ク ト の

デフ ォ ルト ・コ ン テナを 含む多く のオブジェ ク ト ・ク ラ スのほ

か、 OUコ ン テナのク ラ ス、 およ びコ ン ピ ュ ータ ーと ユーザーのエン

テ ィ テ ィ を 表現する ク ラ スが同梱さ れています。 ADを 拡張し て、

アク セス制御の管理を 簡単にする ためにDellが提供する 新し いオブ

ジェ ク ト ・ク ラ スなどを 含むこ と ができ ます。 こ のよ う な拡張は通

常、 「 スキーマ拡張」 と 呼ばれ、 こ のマニュ アルで説明さ れてい

る Dell Extended Schema機能の根幹です。 こ れら のスキーマ拡張によ

り 、 カ スタ マイ ズさ れたオブジェ ク ト ・ク ラ スを 利用し て、 Dell
RCS、 アク セス制御情報、 およ び特定のアク セス制御情報と 特定

のDell RCSイ ン スタ ン スやユーザー・イ ン スタ ン スを 関連付ける ため

に使用さ れる コ ン テナの型を 表すこ と ができ ます。 ADで使用さ れ

る それぞれの属性タ イ プと オブジェ ク ト ・ク ラ スは、 オブジェ ク ト
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識別子 ( OID) と いう グロ ーバル一意識別子を 持っ ている 必要があ

る 点に、 注意する こ と が大切です。 こ れら の一意識別子は、 最終的

には国際的に認知さ れた機関によ っ て管理さ れています。 ADの場

合、 OID空間はMicrosoftによ っ て補助的に管理さ れています。 Dell
は、 Dell Extended Schema機能で使用さ れる カ スタ ム・オブジェ ク

ト ・ク ラ スと 属性タ イ プのためのOIDを 取得し ています。 以下

は、 Dellが取得し た OIDの概略です。

Dell拡張は： dell

Dellベース OIDは： 1.2.840.113556.1.8000.1280

RCS LinkID範囲は： 12070から 12079

Dell RCSのパッ ケージは、 ADに組み込まれている ク ラ スにある オブ

ジェ ク ト ・ク ラ スのみを 使用し ても 機能する よ う に設計さ れていま

す。 こ のオプショ ン は標準スキーマと 呼ばれています。 こ のオプ

ショ ン では、 コ ン ピ ュ ータ ー・オブジェ ク ト ・ク ラ スを 使用し

て、 Dell RCSオブジェ ク ト と 標準のGroupオブジェ ク ト が表さ れま

す。 こ れら のオブジェ ク ト は、 特定のアク セス制御情報を Dell RCS
と Userの特定イ ン スタ ン スに関連付ける ために使用さ れます。 こ の

場合、 アク セス制御情報は、 グループ ・オブジェ ク ト 内の特定の属

性タ イ プに保存さ れます。

ADに存在する 階層構造のため、 ディ レ ク ト リ ・オブジェ ク ト に保存

さ れた情報にアク セスする こ と が難し い場合があり ます。 階層のナ

ビ ゲーショ ン に伴う 遅れを 避ける ために、 Dell Remote Console Switch
のパッ ケージは、 グロ ーバル・カ タ ロ グ ( GC) と いう ADの特性を 使

用する よ う に設計さ れています。 GCは、 完全な ADデータ ベースに

保存さ れている データ のサブセッ ト へのアク セスを 可能にする こ と

と 、 階層と 地理的分布のすべてを 比較的に平ら な単一構造に「 折り

たたむ」 こ と によ っ て、 「 ク イ ッ ク 検索」 サービ スを 提供し ま

す。 GCは、 完全な ADデータ ベースで作用する のと 同じ LDAPディ

レ ク ト リ ・ク エリ を 使用し てク エリ さ れます。 GCサービ スも 提供す

る よ う に設定する ためには、 AD製品は企業内に最低1つのド メ イ

ン ・コ ン ト ロ ーラ ーを 必要と し 、 ADの実際の配置では、 ド メ イ ン ・コ

ン ト ロ ーラ ーの一部またはすべてがGCサービ スを 提供する よ う に設
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定でき ます。 Dell RCSのパッ ケージは、 DNSを 使用し て各GCサー

バーのネッ ト ワーク 座標を 決定し ます。 こ れによ り 、 Dell RCSは、

ネッ ト ワーク 上の一部のGCサーバーが使用でき ない状況も 問題なく

処理でき ます。 DNS SRVレ コ ード がこ の目的で使用さ れる た

め、 Dell RCSは、 SRVレ コ ード に構成さ れた管理設定に基づいて、 常

にも っ と も 近いサイ ト から 先に代替GCサーバーと の接続を 試みま

す。

Standard Schemaと Dell Extended Schema
多数の顧客環境で最大の柔軟性を 提供でき る よ う 、 Dellは、 希望す

る 結果に応じ てユーザーが設定でき る 1組のオブジェ ク ト を 提供し

ています。 Dellは、 Association、 Device、 およ びPrivilegeのオブジェ ク

ト を 含むよ う にスキーマを 拡張し ています。 Associationオブジェ ク

ト は、 ユーザーまたはグループを 、 1つ以上のSIPに対する 特権の特

定のセッ ト と リ ン ク する ために使用さ れます。 Deviceオブジェ ク ト

は、 Active Directory構造内の個々のRCSスイ ッ チを 定義し ま

す。 Privilegeオブジェ ク ト はAssociationオブジェ ク ト を 介し て Device
オブジェ ク ト にリ ン ク さ れ、 使用アク セス権を 割り 当てます。

こ のモデルは、 あまり 複雑さ を 増すこ と な く 、 ユーザー、 特権、 お

よ びRemote Console Switch上のSIPの異なる 組み合わせに対し て、 最

大の柔軟性を 管理者に提供し ます。

Dell Schema Extensionsを イ ン スト ールする 前に、 管理者はこ の章の説

明を 通読し て、 個々のイ ン スト ール状況にはどのスキーマが適切か

を 判断し て く ださ い。 スキーマ ・オブジェ ク ト を 変更する と Active
Directory全体に適用し ますので、 一旦作成し たら 削除でき ません。

非アク テ ィ ブにする こ と し かでき ません。 こ のため、 スキーマを 変

更する 前に、 そのメ リ ッ ト を 慎重に考慮し て く ださ い。

Dell Schema Extensionを イ ン スト ールする こ と で得ら れる 主なメ リ ッ

ト は、 混乱を 排除でき る こ と です。 標準のActive Directoryスキーマを

使用する 場合、 Remote Console Switchはコ ン ピ ュ ータ ー・デバイ ス ・オ

ブジェ ク ト に最も よ く 一致し 、 その1つと し て設定さ れます。 RCS
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はコ ン ピ ュ ータ ーではないため、 すべてのスキーマ機能が適用さ れ

る わけではあり ません。 こ の方法で指定さ れた RCSスイ ッ チを 正し

く 構成する ためには、 注意が必要です。

さ ら に、 Dell Schema Extensionを 使用する と 、 スイ ッ チ ・デバイ スの

検索と 識別が簡単になり ます。 コ ン ピ ュ ータ ー・デバイ ス ・オブ

ジェ ク ト を 使用し て設定さ れたスイ ッ チは、 Active Directory構造内

のすべてのコ ン ピ ュ ータ ー・デバイ スと と も に検索さ れます。

RCSは、 どち ら のスキーマを 使用し ても 同様に認証でき 、 どち ら の

方法を 使用し ても 機能性は失われません。 個々のイ ン スト ールに適

し た方法を 、 管理者が自由に選択でき ます。 Dell Schema Extensionが
ある 場合と ない場合のどち ら についても 、 イ ン スト ールの操作説明

が提供さ れています。 1つのスキーマ ・セッ ト のみに関する 説明はそ

のよ う に記載さ れていますので、 そのスキーマが使用さ れないイ ン

スト ールの場合には、 その説明を 無視し ても 構いません。

標準イ ン ス ト ール

Dell RCSで Active Directoryを 使用し て認証する ためには、 次を 行いま

す。

1 Override Admin Accountを 構成し ます。

2 DNS設定を 構成し ます。

3 NTP( Network Time Protocol) 設定し ます。

4 認証パラ メ ータ ーを 構成し ます。

5 グループ ・オブジェ ク ト を 構成し ます。

6 CAルート 証明書を 作成し 、 ダウン ロ ード し ます。

7 ロ グイ ン ・タ イ ムアウト を 設定し ます。
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Override Admin Accountを 構成し ま す。

ネッ ト ワーク 障害の発生に備え、 LDAPサーバーに照会し 、 認証する

ユニッ ト の性能に関係なく 使用でき る アカ ウン ト が用意さ れていま

す。 ほかの設定を 構成する 前に、 こ のアカ ウン ト を 構成する 必要が

あり ます。 Override Admin Accountを OBWIで構成する には次の手順を

実行し ます。

1 User Accountsを ク リ ッ ク し て、 Override Adminを ク リ ッ ク し ます。

2 ユーザーに割り 当てる ユーザー名と パスワード を 入力し 、 「 Verify
Password」 フ ィ ールド にパスワード を 再度入力し て確認し ます。

3 Saveを ク リ ッ ク し ます。

注： こ のオプショ ンのadmin権限でログイ ンする必要があり ます。

DNSの設定

LDAPク ラ イ アン ト が名前を 解決でき る よ う にする には、 最低1つ
のDNSサーバーを 指定する 必要があり ます。

Networkサブカ テゴリ ーにRCSの名前が表示さ れ、 IPアド レ ス、 サブ

ネッ ト ・マスク 、 ゲート ウェ イ 、 LAN速度、 DHCP/BootP設定などの

ネッ ト ワーク 設定を 変更でき ます。 表示さ れる RCSの名前は、 SNMP
カ テゴリ ー内のSystem Nameフ ィ ールド に指定さ れる 名前と 同じ で

す。

Networkサブカ テゴリ ーでは、 最大3つのDNSサーバーの入力およ び管

理を 行う こ と ができ ます。 こ れら のDNSサーバーは、 LDAP認証パネ

ルに提示さ れる DNS名を 解決する ために使用さ れます。

注： 最低1つのDNSサーバーが、 LDAP機能が作動するよう に構成さ れてい
る必要があり ます。 プラ イ マリ ・サーバーが使用できないと きは常
に、 RCSソ フ ト ウェ アで自動的にフ ェ ールオーバー機能が働き 、 こ こ で確
認さ れると DNSサーバーをバッ ク アッ プし ます。
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注： RCSのシリ アル管理イ ンタ ーフ ェ イ スを使用し ても 、 DNSサーバー・
アド レスを設定できます。 シリ アル管理イ ンタ ーフ ェ イ スの使用に関す
る詳細は、 RCSのマニュ アルを参照し てく ださ い。

OBWIで DNSを 設定する には次の手順を 実行し ます。

1 DNSを ク リ ッ ク し て、 DNS Settings画面を 開き ます。

2 DNSモード を 指定し 、 サーバー・アド レ スを 入力し て Saveを ク

リ ッ ク し ます。

図 5.1. OBWI - DNS Settings

NTP( Network Time Protocol) の設定

スイ ッ チは、 証明書の期限が切れていないこ と を 確認する ために、

現在の時刻にアク セスする 必要があり ます。 NTPから の時刻更新を

要求する よ う にスイ ッ チを 構成でき ます。 OBWIで NTP設定を 構成

する には次の手順を 実行し ます。

1 NTPを ク リ ッ ク し て、 NTP画面を 開き ます。

2 Enable NTPボッ ク スを ク リ ッ ク し ます。
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3 所定のボッ ク スにネッ ト ワーク 時刻のソ ースの名前を 入力し ま

す。 時刻更新を 要求する 頻度を 指定する ために、 1時間刻みの

間隔を 設定する こ と も でき ます。 間隔が0に設定さ れている 場

合は、 RCSの起動時、 またはGlobal → NTPメ ニュ ーが変更さ れた

場合にのみ、 要求が行われます。

4 Saveを ク リ ッ ク し ます。

LDAP認証パラ メ ータ ーの設定

認証パネルによ り 、 RCS管理者がLDAP Directory Services.にアク セス

する のに必要なパラ メ ータ ーを 構成する こ と ができ る よ う になり ま

す。 ユーザーから アク セス ・リ ク エスト を 受信する と 、 RCSはLDAP
プロ ト コ ルを 使用し てユーザー名、 パスワード 、 およ びその他の情

報を Directory Serviceに送信し てユーザーの持つアク セス権を 特定し ま

す。

注： LDAP構成の確立で用いら れるアク セス権は、 KVM User、 KVM User
Admin、 KVM Appliance Adminで、 こ れら はUser、 User Administrator、 RCS
Administratorにそれぞれ相当し ます。 こ れら のアク セス・レベルは変更さ
れていませんが、 指示に従っ て新し いアク セス権を使用し てく ださ い。

LDAP認証の有効

LDAP構成オプショ ン 画面の操作モード のセク シ ョ ン では、 LDAP
サービ スの適切なタ イ プを 選択し てユーザー認証に使用する こ と が

でき ます。 使用でき る モード は以下の通り です。

• 標準LDAPディ レ ク ト リ ・サービ ス ( 非Microsoft)

• Microsoft Active Directoryサービ ス

• LDAP認証の無効化

使用する 代替 ( 非LDAP) の認証方法が既に選択さ れている 場合

は、 LDAP認証は自動的に無効になり ます。 LDAP Directory Servicesを
使用する には、 こ の方法の選択を 解除する 必要があり ます。
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LDAP認証を 使用する ための機能を 復元する には：

1 「 User Access」 で 、 Avocent タ ブを 選択し て、 図 5.2を 参照し て く

ださ い。

2 Disassociateを ク リ ッ ク し て、 Avocent管理認証サーバーの使用を 選

択解除し ます。

3 Saveを ク リ ッ ク し ます。

図 5.2. Avocent認証画面

注： こ の手順を実行し ないでAvocent認証の関連付けを外部的に破棄する
こ と は可能です。 し かし ながら 、 ユーザー認証用にAvocentサーバーの関
連付けが作成さ れていた場合には、 LDAP認証構成を続行できるよう にす
るために、 明示的にこ の手順に従っ て削除する必要があり ます。

LDAP認証の有効化

1 「 User Access」 で 、 LDAP タ ブを 選択し て、 図 5.3を 参照し て く

ださ い。
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図 5.3. LDAP構成オプショ ン 画面

2 「 Operational Modes」 画面で使用でき る LDAP認証モード のなかか

ら 1つ選択し ます。

3 構成オプショ ン は、 LDAP認証を すべて有効にし て使用でき る よ

う に設定する 必要があり ます。 オプシ ョ ン のそれぞれについ

て、 こ の章で詳細し ます。

4 Saveを ク リ ッ ク し ます。

LDAP認証を 無効にする には、 Do Not Use LDAPオプショ ン を 選択し

て、 Saveを ク リ ッ ク し ます。 画面の他のオプショ ン すべてが無効に

なり 、 こ れ以外の他のフ ィ ールド の編集はでき な く なり ます。 さ ら

に、 標準およ びActive Directoryの両方のタ ブの下に表示さ れる 追加

の構成画面も 無効になり ます。

LDAP認証が無効になっ ている と 、 ユーザー・アク セスは、 ロ ーカ ル

で定義さ れたユーザー・アク セス ・リ ス ト またはAvocent管理ソ フ ト

ウェ アのいずれかによ っ て判定さ れます ( 「 ユーザー・アク セス 」

のセク シ ョ ン を 参照し て く ださ い ) 。
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LDAP認証が有効になっ ている と 、 ロ ーカ ルで定義さ れたユーザー・

アク セス ・リ ス ト がLDAP Directory Serversへのリ ク エスト よ り も 優先

し ます。 ユーザー・アク セスはRCS定義のユーザーについて最初の

チェ ッ ク を 求めます。 一致する も のがない場合は、 リ ク エスト は構

成に従っ て LDAP Directory Serversに送信さ れます。

認証パラ メ ータ ーの入力 -操作モード

アク セス ・タ イ プ

LDAPディ レ ク ト リ ・サーバーはオープン ・モード またはセキュ ア ・モー

ド ( SSL-セキュ ア ・ソ ケッ ト ・レ イ ヤー暗号化を 使用 ) のいずれかで

操作する よ う にセッ ト アッ プでき ます。 こ の選択し たモード はホス

ト ・ディ レ ク ト リ ・サーバーのも のと 一致する 必要があり ます。 セ

キュ ア／SSLモード を 選択する 場合は、 暗号化さ れた操作の要件を

満たすためのガイ ダン スと し て、 「 LDAP SSL証明書」 のタ イ ト ル

が付いたセク シ ョ ン も 参照し て く ださ い。

ユーザーのキャ ッ シュ 保存

LDAPを 介し たユーザーの認証が正し く 完了する と 常に、 RCS
で LDAPディ レ ク ト リ ・サーバーから 取得し た結果が選択し た期間保

持さ れます。 も し 、 その期間に、 別のアク セスが生成さ れた場合、

通常は、 結果と し てディ レ ク ト リ ・サーバーの繰り 返し リ ク エスト

になり ますが、 それら のリ ク エスト は内蔵のRCSでロ ーカ ルに取り

扱われます。 こ れによ り 、 ほぼ瞬時に近い応答が出さ れる こ と にな

る ので、 ユーザーが最小限度の遅延で操作を 続ける こ と が可能にな

り ます。

こ の構成オプショ ン には、 「 無効にする 」 、 「 有効にする 」 、 「 タ

イ ムアウト 」 の3種類の設定が設けら れています。

無効にする - ユーザーのキャ ッ シュ 保存を 認めないで、 常に LDAP
ディ レ ク ト リ ・サーバーにすべてのユーザーついて、 要求し たと き は

いつも 、 認証状態についてガイ ダン スを 求めます。 デフ ォ ルト で

は、 ユーザーのキャ ッ シュ 保存は無効です。
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有効にする - 最新のユーザー認証リ ク エスト の結果を LDAPディ レ ク

ト リ ・サーバーによ る 決定に従っ て保持し ます。 事前に決めら れた

期間内に同一の認証結果を 受けたと き には、 それら の以前の結果を

使用し て新規リ ク エスト を 処理し ます。

タ イ ムアウト 期間 - タ イ ム・ウィ ン ド ウの期間を 定めます。 値は分

単位で記録さ れます。 ボッ ク スの中には数字のみを 入力する か、 矢

印コ ン ト ロ ールを 使用し ます。

• デフ ォ ルト のタ イ ムアウト 値： 15 分

• 最小タ イ ムアウト ： 1 分

• 最大タ イ ムアウト ： 1000 分

注： 構成を更新するすべての場合と 同様に、 Saveをク リ ッ ク し て変更内
容を安全に保存する必要があり ます。 LDAP構成の変更内容は大概の場
合、 RCSで再起動の必要なし で、 直ちに使用可能になり ます。

拡張オプショ ンの入力 - Active Directory LDAP

Active Directoryモード を 選択し たら 、 管理者はStandardまたはExtended
スキーマを 使用する かを 決定する 必要があり ます。 さ ら に、 管理者

は、 Microsoft Global Catalogのオプショ ン を 使用する かどう かも 宣言

する 必要も あり ます。

認証パラ メ ータ ーの入力 -標準LDAP

標準LDAP ( Microsoft Active Directory LDAPでなく ) を 使用する と き

は、 最低1つの該当する ディ レ ク ト リ ・サーバーのアド レ スの直接エ

ン ト リ が必要になり ます。 各アド レ スを プラ イ マリ ・サーバーと セ

カ ン ダリ ・サーバーのフ ィ ールド に入力し ます。 プラ イ マリ ・サーバー

のエン ト リ は必須です。

サーバー・アド レ スは、 次の形式のなかの1つで入力する こ と ができ

ます。

• DNSアド レ ス ( 例、 myldapserver.com)

• IPv4アド レ ス ( 例、 10.20.255.255)

• IPv6アド レ ス ( 例、 fe80::200:f8af:fe20:76ce )
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認証パラ メ ータ ーの入力 - カ スタ ム IPポート の割り 当て

こ のセク シ ョ ン で、 こ れまで LDAP用と し て使用さ れてき た業界標

準の IPポート 番号への変更が許さ れます。 大部分の例では、 こ れら

の値を 変更する 必要はあり ません。 し かし なら が、 使用し てい

る LDAPディ レ ク ト リ ・サーバーの管理者が別のポート の割り 当てを

必要と し ている 場合は、 それら を こ こ に入力する こ と ができ ます。

正確な構成によ っ ても 変わり ますが、 LDAPでは異なる IPポート を

最高4つまで、 また同時に 2つまで使用する こ と ができ ます。 こ れら

の4つのそれぞれのスロ ッ ト は、 LDAP構成オプショ ン 画面に示さ れ

ます。 同一画面の他の設定は、 変更が可能なポート を 識別する のに

使用さ れます。 以下の表では、 使用でき る ポート ・スロ ッ ト を 有効

にし て編集でき る 条件を 定義し ています。

有効にし て、 カ

スタ マイ ズでき

るポート ・ス

ロッ ト のリ スト

オープン ・モード セキュ ア /SSLモード

グローバル・カ

タ ログを使用し

ない

標準LDAPメ ッ セージ・

ポート

標準LDAPメ ッ セージ・ポート - セ
キュ ア /SSLモード

グローバル・カ

タ ログを使用す

る

標準LDAPメ ッ セージ・

ポート およびActive
Directoryグローバル・

カ タ ログ・ポート

標準LDAPメ ッ セージ・ポート - セ
キュ ア /SSLモード およびActive
Directoryグローバル・カ タ ログ・

ポート - セキュ ア /SSLモード

表 5.1: IPポート の割り 当ての編集

元の業界標準の IPポート の送信先を 復元する 必要がある 場合はいつ

でも 、 「 Restore Default Port Settings」 ボタ ン を ク リ ッ ク し て く ださ

い。 4つのポート 値がすべて元の値に戻り ます。 それら は次のと お

り です。

標準LDAPメ ッ セージ ・ポート - 389
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標準LDAPメ ッ セージ ・ポート 、 SSL経由 - 636

Active Directory、 グロ ーバル・カ タ ロ グ・サーバー経由 - 3268

Active Directory、 グロ ーバル・カ タ ロ グ・サーバー/SSL経由 - 3269

IPポート の番号は、 1 ～ 65535の範囲が使用でき ます。 LDAPディ

レ ク ト リ ・サーバーによ っ て使用さ れている ポート 番号に一致し ない

と 、 当該サーバーと の通信が正し く 確立でき ない結果と なり ます。

LDAP構成の完了

標準と Active Directory LDAPモード の両方で、 LDAP Directory Serversへ
の適切な接続を 確保する ために追加のパラ メ ータ ーが必要です。 以

下のセク ショ ン でそれぞれのパラ メ ータ ーについて説明を 加えま

す。 し かし ながら 、 パラ メ ータ ーのアッ プデート が該当ページで作

成さ れる こ と を 確実にし 、 管理者を 支援する ためにOBWIページに

「 イ ン タ ーロ ッ ク 」 機能が設けてある こ と を ご承知く ださ い。

例えば、 Active Directory LDAPタ ブを 選択し ていて、 画面に以下の表

示が画面に示さ れた場合は、 図 5.4を 参照し て く ださ い。

図 5.4. 通知メ ッ セージ - LDAPモード が有効になっ ていません

こ の場合は、 Active Directoryモード が有効になっ ていないか、 または

有効になっ ていたけれども 、 保存さ れていないこ と を 示し ていま

す。 LDAP Options画面に戻り 、 Active Directory LDAPを 選択し て、 当該

する ページでこ のモード のセカ ン ダリ ・パラ メ ータ ーを メ モに記録し

て く ださ い。 こ の画面に戻る 前に、 Saveを ク リ ッ ク し て く ださ い。
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標準LDAPモード でも 、 当該モード が有効になっ ていないと き にいつ

も 示さ れる 同様な表示があり ます。

セカ ンダリ LDAP設定 -標準構成

LDAP Active Directory構成の場合と 同様に、 標準LDAPの認証、 検

索、 およ びク エリ ・パラ メ ータ ーはリ モート OBWIを 使用し て構成さ

れます。 本セク シ ョ ン での設定は、 こ の図 5.5に示さ れてい

る OBWIウィ ン ド ウを 介し て User Access / LDAP / Standardタ ブから アク

セスでき ます。

図 5.5. セカ ン ダリ LDAP設定 -標準構成

注： こ のセク ショ ンでは、 標準LDAP Directoryサーバーと の間でなさ れる
接続のセッ ト アッ プ ・パラ メ ータ ーについて記述し ていますが、 同時に、
こ のセク ショ ンは、 より 汎用バージョ ンのActive Directoryサービスと の接
続を確立するためにも 使用できる点に注意を払っ てく ださ い。
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標準LDAPク エリ 実行のためのRCSのセッ ト アッ プ

注： ク エリ ・モード を Active Directoryで使用する前に、 特定のク エリ ・モー
ド がユーザーに対する正し い承認レベルを割り 当てら れるよう 、 Active
Directoryに変更を加える必要があり ます。

グループ ・ク エリ を セッ ト アッ プする には次の手順を 実行し ます。

1 管理者特権で、 使用のLDAP Directory Serverソ フ ト ウェ アにロ グ

イ ン し ます。

2 グループ ・コ ン テナと し て使用する 組織単位 ( OU) を 作成し ま

す。

3 アプラ イ アン スのク エリ 用のスイ ッ チ ・システム名と 同一名、

またはタ ーゲッ ト ・デバイ スのク エリ 用の、 接続さ れている タ ー

ゲッ ト ・デバイ ス名と 同一名のコ ン ピ ュ ータ ー・オブジェ ク ト

を Active Directory内に作成し ます。 名前は、 大文字／小文字の区

別も 含めて完全に一致し ていなければなり ません。

4 グループ ・ク エリ 用のアプラ イ アン ス名と タ ーゲッ ト ・デバイ ス

名は、 アプラ イ アン スに保存さ れています。 リ モート OBWI
のAppliance Overview画面で指定し たアプラ イ アン ス名と タ ーゲッ

ト ・デバイ ス名は、 大文字、 小文字、 数字、 ハイ フ ン の任意の

組み合わせから なり 、 LDAPサーバー上のオブジェ ク ト 名に一致

し ていなければなり ません。

5 グループ ・コ ン テナの組織単位の下にグループ ( １ つまたは複

数 ) を 作成し ます。

6 ユーザー名、 タ ーゲッ ト ・デバイ ス、 アプラ イ アン ス ・オブジェ ク

ト を 手順4で作成し たグループに加えます。

7 アク セス制御属性を 実行する 上で必要な各属性値を 指定し ま

す。

検索構成の設定

正し いLDAP接続を 行う ために必要と なる 設定が4つあり ます。 「 検

索DN」 、 「 検索パスワード 」 、 「 検索ベース 」 、 およ び「 UIDマ
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スク 」 です。

検索 DN

「 検索DN」 フ ィ ールド では、 ディ レ ク ト リ ・サービ スにロ グイ ン す

る 際にタ ーゲッ ト ・デバイ スが使用する 管理者レ ベルのユーザーを 定

義でき ます。 タ ーゲッ ト ・デバイ スが認証さ れる と 、 ディ レ ク ト リ ・

サービ スによ り ディ レ ク ト リ へのアク セスが許可さ れ、 「 LDAPク
エリ 」 ページで指定さ れたユーザー認証ク エリ が実行さ れます。 検

索DNに入力する 個々の値は、 カ ン マで区切る 必要があり ます。 代

表的なエン ト リ は次のよ う になり ます：

cn=Administrator,cn=Users,dc=MyDomainName,dc=com

検索パスワード

「 検索パスワード 」 フ ィ ールド は、 検索オプショ ン でパスワード が

必須の場合に使用さ れます。 こ れによ り 、 検索DNフ ィ ールド で指

定し た管理者またはユーザーを 認証し ます。 任意の印刷可能な ASCII
文字の使用ができ ます。

検索ベース

「 検索ベース 」 フ ィ ールド では、 LDAP検索を 開始する 際の起点を 定

義し ます。 デフ ォ ルト 値は、 dc=yourDomainNameおよ び dc=comで

す。 検索DNに入力する 個々の値は、 カ ン マで区切る 必要があり ま

す。 例えば、 test.comでの検索ベースを 定義する に

は、 dc=test、 dc=comと 入力し ます。

UID マスク

「 UIDマスク 」 フ ィ ールド では、 LDAPタ ーゲッ ト ・デバイ スでのユー

ザーID検索のための検索基準を 指定し ます。 形式は、 <名

前>=<%1>です。 デフ ォ ルト 値は sAMAccountName=%1です。 こ れ

はActive Directoryと 併用する 場合の値と なっ ています。

ク エリ ・モード

アプラ イ アン スと タ ーゲッ ト ・デバイ ス用のク エリ ・モード ・パラ メ ー

タ ーを 構成し ます。 アプラ イ アン スは、 管理者およ びユーザーがコ



RCSのLDAP機能 | 137

ン ソ ール・スイ ッ チにアク セスし よ う と し ている 場合に、 管理者お

よ びユーザーの認証に使用さ れます。 タ ーゲッ ト ・デバイ スは、 接続

さ れている タ ーゲッ ト ・デバイ スにユーザーがアク セスし よ う と し て

いる 場合に、 そのユーザーの認証に使用さ れます。

使用でき る ク エリ ・モード は、 基本、 ユーザー属性、 グループ属性

の3種類です。

基本

ユーザーのユーザー名と パスワード に関する ク エリ がディ レ ク ト リ ・

サービ スに送信さ れます。 有効なユーザーと し て認証さ れる と 、

ユーザーには、 アプラ イ アン スと 接続さ れている 任意のタ ーゲッ ト ・

デバイ スへのアク セスが与えら れます。

ユーザー属性

ユーザーのユーザー名、 パスワード 、 アク セス制御属性に関する ク エ

リ がディ レ ク ト リ ・サービ スに送信さ れます。 アク セス制御属性

はActive Directory内のユーザー・オブジェ ク ト から 読み込まれます。

値が見つから ない場合は、 ユーザーにアプラ イ アン スまたはタ ー

ゲッ ト へのアク セス権は与えら れません。

グループ属性

ユーザー名、 パスワード 、 グループ ・ク エリ は、 ク エリ ・モード ( ア

プラ イ アン ス ) 時はアプラ イ アン スと 接続のタ ーゲッ ト ・デバイ ス

に関し て、 ク エリ ・モード ( デバイ ス ) 時には特定のタ ーゲッ ト ・デ

バイ スに関し てディ レ ク ト リ ・サービ スに送信さ れます。 ク エリ ・

モード ( アプラ イ アン ス ) 時の場合、 該当ユーザーと アプラ イ アン

ス名を 含むグループが検索さ れる と 、 グループ ・コ ン テン ツ の内容

に従っ て、 アプラ イ アン スまたは接続さ れている タ ーゲッ ト ・デバ

イ スへのユーザー・アク セスがユーザーに与えら れます。 ク エリ ・モー

ド ( タ ーゲッ ト ・デバイ ス ) の場合、 該当ユーザーと タ ーゲッ ト ・デ

バイ ス IDを 含むグループが検索さ れる と 、 アプラ イ アン スに接続さ

れている 特定タ ーゲッ ト ・デバイ スへのユーザー・アク セスがユーザー

に与えら れます。
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注： 選択し たク エリ ・モード によっ て異なり ますが、 こ の画面で示さ れ
た構成項目の一部がそれぞれ適用できるかどう かによっ て有効または無
効になり ます。

グループ構成パラ メ ータ ー

以下のいく つかのグループ構成パラ メ ータ ーが使用でき ます。

グループ ・コ ン テナ

グループ ・コ ン テナでは、 管理者がActive Directory内にグループ ・オブ

ジェ ク ト 用位置と し て作成し た OU( 組織ユニッ ト ) を 指定し ま

す。 グループ ・オブジェ ク ト には、 ユーザー、 コ ン ピ ュ ータ ー、 連絡

先、 他のグループなどに特定のアク セス ・レ ベルの割り 当て付き で

含める こ と ができ ます。

グループ ・コ ン テナ・マスク

グループ ・コ ン テナ・マスク では、 グループ ・コ ン テナのオブジェ ク

ト ・タ イ プ 、 通常、 OUを 定義し ます。 デフ ォ ルト 値は「 ou=%1」 で

す。

タ ーゲッ ト ・デバイ ス ・マスク

タ ーゲッ ト ・デバイ ス ・マスク ではタ ーゲッ ト ・デバイ スの検索フ ィ ル

タ ーを 定義し ます。 デフ ォ ルト 値は「 cn=%1」 です。

アク セス制御属性

アク セス制御属性では、 ク エリ ・モード が「 ユーザー属性」 または

「 グループ属性」 に設定さ れている 場合に使用する 属性名を 指定し

ます。 デフ ォ ルト 値は「 info」 です。

アク セス制御区切り 文字

LDAP標準では、 セミ コ ロ ン (;) を 単一名の属性内にある 複数のプロ

パテ ィ の区切り 文字と し て使用する よ う に指定し ます。 通常の操

作では、 こ れを 変更する 必要はあり ません。 例えば、 LDAP
Directoryに速乾タ イ プのボード マーカ ー・オブジェ ク ト がある と 想定

し た場合に、 属性「 Color」 を 用いてこ のマーカ ーが持つ色を 識別で

き ます。

Color: red;blue;green;black;purple
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「 Color」 が属性の名前で、 残り はこ の属性の値と なり 、 こ の場合

は複合値を 表し ます。 複合値では、 1つの要素の終わり と 次の要素

の始まり を 示めすのに、 セミ コ ロ ン を 区切り 文字と し て使用し ま

す。

稀ですが、 LDAP管理者が、 値そのも のの一部と し てセミ コ ロ ン を

必要と する 場合があり ます。 そのと き は、 区切り 文字を 別のも のに

変更する 必要があり ます。 該当する 場合は、 こ のフ ィ ールド を 使用

し て、 アク セス制御属性の区切り 方法を 識別する 文字のすべてを 指

定し ます ( 最低1つの文字が必要でが、 2つ以上でも 構いません )
。 例、 区切り 文字フ ィ ールド で次のよ う に設定し ます： #$;( 3文
字 )

Color: red#blue$green;black#purple

こ れら の区切り 文字で、 上記の最初に示し た 5つ同じ 値要素が検索

さ れます。 LDAP管理者は、 定義さ れたアク セス制御の区切り 文字

が、 区切り の目的以外で属性の文字と し て他で一切使用さ れていな

いこ と を 確認する 必要があり ます。

上に示すよ う に、 アク セス制御属性 ( ACA) は名前と 値の組み合わ

せから なり たっ ています。 デフ ォ ルト では、 ユーザーと タ ーゲッ ト ・

デバイ スに一致する LDAP Directoryエン ト リ を 、 「 info」 と 名付けら

れた属性で検索し ます。 見つかっ たと き は、 該当する 属性の値に

よ り 、 そのデバイ スでのユーザーの認証レ ベルが知ら さ れる こ と に

なり ます。 LDAPサービ スの管理者が「 info」 以外の属性を 使用し た

い場合は、 上に示し たフ ィ ールド を 使っ てカ スタ マイ ズする こ と が

でき ます。

ユーザーがいく つかのグループのメ ン バーであり 、 各グループが異な

る デバイ スに対し て異なる 認証レ ベルを 有し ている ため、 結果につ

いての集計の実行が保管さ れます。 LDAP標準では、 報告さ れた最

終の認証レ ベルが、 セキュ リ テ ィ の下での特定のユーザーと デバイ

ス用と し て検索さ れた該当する すべての結果のなかで見つけら れる

最高 ( 最も 高い許可 ) レ ベルです。
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セカ ンダリ LDAP設定 - Active Directory構成

本セク ショ ン での設定は、 こ のに示さ れている OBWIウィ ン ド ウを

介し て User Access / LDAP / Standardタ ブから アク セスでき ます。

図 5.6. セカ ン ダリ LDAP設定 - Active Directory構成

Dell Extended Schemaを イ ン スト ールする 場合は、 使用する RCSと ルー

ト ・ド メ イ ン のみを 入力し ます。

Dell Extended Schemaを 使用し ない場合、 設置さ れている RCSと アク

セス制御さ れている SIPは、 Active Directory内でコ ン ピ ュ ータ ー・オブ

ジェ ク ト と し て構成さ れます。 こ れを 行う には、 アク セス制御さ れ

た RCSおよ び接続さ れている SIPにユーザーを 関連付ける グループ ・オ

ブジェ ク ト を 格納する 組織単位を 構成する 必要があり ます。 こ れは

以前に作成し た OUでも 、 特にこ の目的のために作成し た OUでも 構

いませんが、 グループ ・コ ン テナ・ド メ イ ン 内のすべてのOUオブ

ジェ ク ト で一意である 必要があり ます。

次に、 任意アク セス制御情報を 含むために使用さ れる 、 LDAPディ

レ ク ト リ 内の属性を 選択し ます。 こ れは、 文字列の値を 格納でき る
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未使用の属性である 必要があり ます。 ( デフ ォ ルト はグループ ・オ

ブジェ ク ト の「 info」 属性。 )

最後に、 OBWI ウィ ン ド ウの空欄に、 グループ ・コ ン テナの場所、

グループ ・コ ン テナ・ド メ イ ン 、 アク セス制御属性を 入力する 必要が

あり ます。

図 5.6に示す各フ ィ ールド の詳細については、 表 5.2を 参照し て く だ

さ い。

表 5.2: Active Directory構成フ ィ ールド の説明

フ ィ ール

ド
説明

RCS
Domain

RCS Domainフ ィ ールド には、 RCSと SIPを表すすべてのオブ

ジェ ク ト の格納に選択さ れたActive Directoryド メ イ ンの名前が入

り ます。

Root
Domain

Active Directoryフ ォ レスト 内の最上部のド メ イ ン。

Group
Container
( Standard
スキーマ・

セッ ト の

み)

こ のフ ィ ールド は、 Standardスキーマが選択さ れていると きに使

用でき 、 組織単位( OU) オブジェ ク ト の識別名の一部を含みま

す。 OUは、 アク セス制御さ れたRemote Console Switchおよび接続

さ れたSIPにユーザーを関連付けるグループ・オブジェ ク ト を格納

するために使用さ れます。

たと えば、 選択さ れたOUの識別名がou=KVM-AccessControls,
dc=MyCom,dc=comだと し ます。 こ の場合、 Group Containerフ ィ ール

ド は「 KVM-AccessControls」 に設定し てく ださ い。 Group Container
フ ィ ールド に入力する名前は、 Group Containerド メ イ ン内のすべ

てのOUオブジェ ク ト のなかで固有でなければなり ません。 以前

にそのGroup Containerに作成し たOUでも 、 特にこ の目的のために

作成し たOUでも 使用できます。

デフ ォ ルト のGroup Containerは、 KVMです。
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フ ィ ール

ド
説明

Group
Container
Domain
( Standard
スキーマ・

セッ ト の

み対象)

こ のフ ィ ールド は、 グループ・コ ンテナが配置さ れている Active
Directoryド メ イ ンのDNS名で、 Standardスキーマが選択さ れている

と きに使用できます。

Access
Control
Attribute
( Standard
スキーマ・

セッ ト の

み対象)

こ のフ ィ ールド の値は、 LDAPディ レク ト リ 内のどの属性が任意

アク セス制御情報の格納に使用さ れるかを指定し 、 Standardス
キーマが選択さ れていると きにのみ有効になり ます。

Access Control Attributeは、 LDAPディ レク ト リ ・オブジェ ク ト 内の

属性から 選択さ れます。 こ の属性は、 ユーザーおよびアク セス

し よう と し ている RCSまたは接続さ れたコ ンピュ ータ ーの両方が

メ ンバーシッ プに含まれるグループを表し ます。

Standardスキーマを使用し ている場合、 グループ・コ ンテナ内の

グループ・オブジェ ク ト が持つ属性は、 そのグループと 関連付け

ら れた許可レベルを含むよう に選択さ れている必要があり ま

す。 Access Control Attributeフ ィ ールド は、 Standardスキーマが選択

さ れていると きに使用でき 、 選択さ れた属性の名前を含みま

す。 選択さ れた属性は、 文字列値を格納できる必要があり ま

す。 たと えば、 デフ ォ ルト 属性は「 info」 属性で、 Active Directory
ユーザーと コ ンピュ ータ ー( ADUC) のスナッ プイ ンから アク セ

ス可能です。 ADUCを使用し 、 グループ・オブジェ ク ト の

「 Notes」 プロパティ にアク セスするこ と によっ て、 info属性の

値が設定さ れます。
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LDAP SSL証明書

すべてのLDAPプロ ト コ ル交換 ( RCSと Active Directoryサーバー間 )
は、 SSLによ っ てセキュ リ テ ィ 保護さ れています。 LDAPプロ ト コ ル

がSSLで保護さ れている と き は、 LDAPS( Lightweight Directory Access
Protocol over SSL) と 呼ばれます。 各LDAPS接続はプロ ト コ ル・ハン ド

シェ イ ク で始まり 、 それによ り 、 応答側のActive Directoryサーバーか

ら RCSにセキュ リ テ ィ 証明書が転送さ れます。 証明書が受信さ れる

と 、 RCSによ っ て証明書が確認さ れます。 証明書を 確認する に

は、 RCSにルート 証明機関 ( CA) 証明書のコ ピ ーを 構成する 必要が

あり ます。 こ れを 行う には、 まず、 証明書を 作成する 必要があり ま

す。

ド メ イ ン ・コ ン ト ローラ ー上のSSLの有効

Microsoftエン タ プラ イ ズのルート CAを 使用し てすべてのド メ イ ン ・

コ ン ト ロ ーラ ーSSL証明書を 自動的に割り 当てる 場合、 各ド メ イ ン ・

コ ン ト ロ ーラ ー上のSSLが有効になっ ていなければ、 以下の手順を

行っ て有効にする 必要があり ます。

1 Microsoftエン タ プラ イ ズのルート CAを ド メ イ ン ・コ ン ト ロ ーラ ー

にイ ン スト ールし ます。

a. スタ ート → コ ン ト ロ ール パネル → プロ グラ ムの追加と 削

除を 選択し ます。

b. Windowsコ ン ポーネン ト の追加と 削除を 選択し ます。

c. Windows コ ン ポーネン ト ウィ ザード で、 証明書サービ ス

チェ ッ ク ボッ ク スを オン にし ます。

d. [CAの種類 ]と し て Enterprise root CAを 選択し て、 Nextを ク

リ ッ ク し ます。

e. こ のCAに [共通名 ]を 入力し 、 Enterprise root CAを ク リ ッ ク し

て、 Finishを ク リ ッ ク し ます。
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2 ド メ イ ン ・コ ン ト ロ ーラ のそれぞれに SSL証明書を イ ン スト ール

する こ と によ っ て、 各コ ン ト ロ ーラ で SSLを 有効にし ます。

a. スタ ート → 管理ツ ール → ド メ イ ン セキュ リ テ ィ ポリ シー

を ク リ ッ ク し ます。

b. 公開キーのポリ シー・フ ォ ルダを 拡張し て、 自動証明書要求

の設定を 右ク リ ッ ク し 、 自動証明書要求を ク リ ッ ク し ま

す。

c. 自動証明書要求セッ ト アッ プ ウィ ザード で、 Nextを ク

リ ッ ク し 、 Domain Controllerを 選択し ます。

3 Nextを ク リ ッ ク し 、 Finishを ク リ ッ ク し ます。

Linux環境では、 opensslを 使用し て証明書／秘密鍵フ ァ イ ルを 作成で

き ます。 Opensslはopenssl.orgから ダウン ロ ード でき ます。 <>で囲ま

れたテキスト 付き の手順説明は、 ユーザーが条件に基づいてその行

の最後に設定する 必要がある 箇所を 示し ています。

注： <>で囲まれたテキスト 付きの手順説明は、 ユーザーが条件に基づい
てその行の最後に設定する必要がある箇所を示し ています。

イ ン ポート する 証明書を 作成する には：

1 Linuxのコ マン ド ・プロ ン プ ト で、 opensslopenと 入力し 、 Enterキー

を 押し ます。 OpenSSLプロ ン プ ト に切り 替わり ます。

OpenSSL> genrsa -out privatekey.pem <512>
Generating RSA private key, 512 bit long modulus
..........++++++++++++
.....++++++++++++
e is 65537 (0x10001)
OpenSSL req -new -key privatekey.pem -x509 -out certificate.pem-batch
-days 365

2 識別名 ( DN) には、 証明書要求に組み込まれる 情報を 入力し ま

す。 一部のフ ィ ールド にはデフ ォ ルト 値があり ます。 必要に応
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じ て '.'と 入力する こ と で、 フ ィ ールド を 空欄のまま残すこ と がで

き ます。

-----
国名 ( 2文字の略称 ) [GB]:<US>
都道府県名 ( 正式表記 ) [Berkshire]:<Texas>
市町村名 ( 市など ) [Newbury]:<Austin>
組織名 ( 会社名など ) [My Company Ltd]:<Dell, Inc.>
組織単位名 ( 部など ) []:Round Rock<Round Rock>
一般名 ( 自分の名前、 サーバーのホスト 名など ) []:<RCS
DNS名または IP>
Email Address []:<support@dell.com>
OpenSSL> quit

3 Linuxのコ マン ド ・プロ ン プ ト に cat certificate.pem privatekey.pem >
webserver.pemと 入力し 、 さ ら に unix2dos webserver.pemと 入力し て

フ ァ イ ルの改行タ イ プを UNIXから DOSに変換し ます。

CA証明書を エク スポート する には次の手順を 実行し ます。

1 Windowsオペレ ーテ ィ ン グ・システムで証明機関管理ツ ールを 開

く には、 スタ ート → すべてのプロ グラ ム → 管理ツ ール → 証明

機関の順にク リ ッ ク し ます。

2 ツ リ ー表示で証明機関を 右ク リ ッ ク し てプロ パテ ィ を 選択する

こ と で、 証明機関のプロ パテ ィ を 表示でき ます。 [CA プロ パ

テ ィ ]ダイ アロ グ・ボッ ク スが開き ます。

3 全般タ ブと 証明書の表示ボタ ン を ク リ ッ ク し て、 [証明書 ]ダイ

アロ グ・ボッ ク スを 開き ます。

4 詳細タ ブを ク リ ッ ク し 、 次にフ ァ イ ルにコ ピ ーボタ ン を ク

リ ッ ク し ます。 証明書のエク スポート ・ウィ ザード が開き ます。

5 次へを ク リ ッ ク し て、 ウィ ザード の使用を 開始し ます。

6 [エク スポート フ ァ イ ルの形式 ]画面で、 Base-64 encoded X.509
(.CER)オプショ ン ・ボタ ン を 選択し 、 次へボタ ン を 押し ます。
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7 エク スポート する フ ァ イ ル画面で、 フ ァ イ ル名と エク スポート

さ れる 証明書のパスを 入力または参照し ます。 次へボタ ン を 押

し ます。

8 完了ボタ ン を 押し ます。

こ の結果作成さ れた証明書フ ァ イ ルは正し い形式で、 OpenSSLで読

み取り 可能です。

一般に、 CA証明書は一度だけアッ プロ ード する 必要があり ます

が、 証明書が失効さ れていたり 期限切れの場合、 またはシリ アル・

コ ン ソ ール・メ ニュ ーから 「 Restore Factory Defaults」 が選択さ れてい

る 場合は、 再度アッ プロ ード する 必要があり ます。

注： 上記の説明は、 Microsoft Root CA証明書に関し て書かれています。 他
のCAについては、 CAベンダーにお問い合わせく ださ い。

注： LDAPSが機能できるよう に、 NTP( Network Time Protocol) が有効に
なっ ている必要があり ます。

図 5.7. OBWI - LDAP証明書

Updateを ク リ ッ ク し たら 、 次のウィ ン ド ウが表示さ れます。
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図 5.8. OBWI - LDAP証明書の更新

証明書フ ァ イ ルは、 参照ダイ アロ グ・ボッ ク スで選択し て開く こ と

ができ ます。 証明書が開かれ、 その内容が表示さ れたら 、 証明書

を RCSに送信でき ます。

ログイ ン ・タ イ ムアウト

ディ レ ク ト リ ・ツ リ ーのサイ ズが大き いために LDAP認証に時間がか

かる 場合に備え、 Sessionsウィ ン ド ウにはLogin Timeoutの設定ボッ ク

スがあり ます。 デフ ォ ルト のタ イ ムアウト は30秒に設定さ れていま

す。 ロ グイ ン ・タ イ ムアウト は、 Loginダイ アロ グ・ボッ ク スでユー

ザーがOKボタ ン を 押し た時点から 、 最終的にRCSが応答し ていない

と 判定さ れる までの時間です。 RCSはこ の値を 使用し て、 認証に関

する LDAP要求のタ イ ムアウト を 決定し ます。

OBWIでロ グイ ン ・タ イ ムアウト を 指定する には次の手順を 実行し ま

す。

1 Sessionsを ク リ ッ ク し て、 General Session Settings画面を 開き ます。

2 Login Timeoutメ ニュ ーでタ イ ムアウト の長さ ( 秒単位 ) を 指定

し ます。

3 Saveを ク リ ッ ク し ます。
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図 5.9. OBWI - ロ グイ ン ・タ イ ムアウト

注： ログイ ン ・タ イ ムアウト は、 ユーザー・ログイ ン ・キャ ッ シュ 保存機
能と は別のも のです。 後者は、 ログイ ン後に機能し 、 認証結果を一定の
期間キャ ッ シュ 保存し 、 繰り 返し のLDAP通信リ ク エスト を解消し て、 完
了し ます。

CA証明書情報の表示

RCSでは、 公開キーの長さ が2048ビ ッ ト 以下の場合にのみ、 こ の

ウィ ン ド ウに完全な CA証明書情報を 表示でき ます。 キーの長さ

が2048ビ ッ ト を 超える 場合、 サブジェ ク ト 、 発行者、 有効期間の

データ はこ のウィ ン ド ウに完全には表示さ れなく なり ます。 1

下記はCA証明書情報の例です：

1 ク ラ イ アン ト から RCSにCA証明書を ダウン ロ ード し ます。

2 シリ アル・コ ン ソ ールのメ イ ン ・メ ニュ ーでオプショ ン 8を 指定

し 、 LDAP CA証明書を 表示し ます。

RCSには次のタ イ プの情報が表示さ れます：
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Begin CA certificate information display
subject= /DC=msft/DC=ldaptest/CN=MyCertificate
issuer= /DC=msft/DC=ldaptest/CN=MyCertificate
notBefore=Dec 7 20:0956 2005 GMT
notAfter=Dec 7 20:1834 2010 GMT
serial=7BA146C0221A08B447B989292074329F
MD5 Fingerprint=6D:70:30:31E5:1B:C0:90:BB:DB:32:B2:C9:D15A
End CA certificate information display

Microsoft Windows Server 2003プラ ッ ト フ ォ ームにRCSソ フ ト ウェ アを

イ ン スト ールでき る よ う にする には、 次の手順を 実行し ます。

1 スタ ート メ ニュ ーを 選択

2 マイ コ ン ピ ュ ータ ーを 右ク リ ッ ク し 、 プロ パテ ィ を 選択し ま

す。

3 詳細設定タ ブを 選択

4 パフ ォ ーマン スボタ ン を ク リ ッ ク

5 データ 実行防止タ ブを 選択

6 重要なWindowsプロ グラ ムおよ びサービ スについてのみ有効にす

る のオプショ ン ・ボタ ン を 選択し ます。

7 OKを ク リ ッ ク し ます。

8 「 システムのプロ パテ ィ 」 ダイ アロ グ・ボッ ク スで OKを も う 一

度ク リ ッ ク し ます。

グループ ・オブ ジ ェ ク ト の構成

Group Container内のグループのメ ン バーシッ プにユーザーを 含める こ

と で、 アク セス制御が特定のActive Directoryユーザー・アカ ウン ト に

適用さ れます。 グループのメ ン バーシッ プには、 ユーザーにアク セ

スを 許可する RCSと SIPを 表すオブジェ ク ト も 含める 必要があり ま

す。 許可さ れる アク セスのレ ベルは、 グループ ・オブジェ ク ト
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( Standardスキーマ ) またはAssociationオブジェ ク ト ( Extendedスキー

マ ) 内の特定の属性の値によ っ て決定さ れます。 3種類の許可レ ベ

ルがあり 、 こ れら は、 アク セス権が増える 順に「 KVM User」 、

「 KVM User Admin」 、 およ び最も 強力なレ ベルの「 KVM Appliance
Admin」 と なっ ています。

注： KVM Userのアク セス・レベルが使用さ れていない場合は、 両方の管
理者アク セス権はデフ ォ ルト ですべてのSIPにアク セスできるため、 SIP
オブジェ ク ト を構成する必要はあり ません。

操作 KVM Appliance Admin KVM User Admin KVM User

プリ エ

ンプト

別のKVM Appliance
AdminまたはKVM User
Adminをプリ エンプト

できます。 Directory内
の適切なグループ・オ

ブジェ ク ト にTDを含

めるこ と により 、 タ ー

ゲッ ト ・デバイ スごと

に許可を構成する必

要があり ます。

別のUser Adminをプリ

エンプト できま

す。 Directory内の適

切なグループ・オブ

ジェ ク ト にタ ーゲッ

ト ・デバイ スを含め

るこ と により 、 タ ー

ゲッ ト ・デバイ スご

と に許可を構成する

必要があり ます。

不可

ネッ ト

ワーク ・

パラ

メ ー

タ ーと

グロー

バル設

定の構

成

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と に

より 、 RCSごと にアク

セス権を構成する必

要があり ます。

不可 不可

表 5.3: アク セス ・レ ベルによ っ て許可さ れる 操作
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操作 KVM Appliance Admin KVM User Admin KVM User

再起動

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と に

より 、 RCSごと にアク

セス権を構成する必

要があり ます。

不可 不可

フ ラ ッ

シュ ・

アッ プ

グレー

ド

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と に

より 、 RCSごと にアク

セス権を構成する必

要があり ます。

不可 不可

ユー

ザー・ア

カ ウン

ト の管

理

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と に

より 、 RCSごと にアク

セス権を構成する必

要があり ます。

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と

により 、 RCSごと に

アク セス権を構成す

る必要があり ます。

不可

ポート

設定の

構成

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と に

より 、 RCSごと にアク

セス権を構成する必

要があり ます。

不可 不可
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操作 KVM Appliance Admin KVM User Admin KVM User

タ ー

ゲッ

ト ・デ

バイ ス

への

アク セ

ス

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と に

より 、 RCSごと にアク

セス権を構成する必

要があり ます。

可 - Directory内の適切

なGroupオブジェ ク ト

にRCSを含めるこ と

により 、 RCSごと に

アク セス権を構成す

る必要があり ます。

可( 管理者と し て

構成さ れている場

合) Directory内の

適切なグループ・

オブジェ ク ト にTD
を含めるこ と によ

り 、 タ ーゲッ ト ・

デバイ スごと に許

可を構成する必要

があり ます。

RCS管理者アク セス権でのAuthenticationパネルのフ ィ ールド 変更を

許可する 前に、 RCS管理者 ( KVM Appliance Admin) アク セス権を 受

信する よ う にADユーザー・アカ ウン ト を 構成する 必要があり ます。

特に、 Authentication Settingsを 変更でき る のは、 RCS管理者のみで

す。

標準スキーマのActive Directoryオブジェ ク ト の概要

認証およ び承認のためにネッ ト ワーク 上の物理RCSを Active Directory
に統合する 場合、 各物理RCSを 表すコ ン ピ ュ ータ ー・オブジェ ク ト を

少な く と も 1つ作成する 必要があり ます。 また、 KVM User特権レ ベ

ルを 使用し て制御さ れる RCSに接続さ れている SIPごと に、 コ ン

ピ ュ ータ ー・オブジェ ク ト を 作成する 必要があり ます。 SIPを 表現す

る コ ン ピ ュ ータ ー・オブジェ ク ト は、 管理者レ ベルのグループには必

要あり ません。 KVM Userグループのユーザーは、 KVM Userグループ

内にある SIPにのみアク セスでき ます。 管理者特権を 持つユーザー

は、 デフ ォ ルト によ り 、 すべてのSIPにアク セスでき ます。

RCSのGroupオブジェ ク ト を セッ ト アッ プする には次の手順を 実行

し ます。

1 イ ン スト ールさ れたスイ ッ チに関連し たグループ ・オブジェ ク ト

を 含む組織単位がまだ作成さ れていない場合は、 作成し ます。
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2 こ の組織単位内に、 ユーザー特権レ ベルを 表すグループ ・オブ

ジェ ク ト を 3つ作成し ます。 KVM Appliance Administrator、 KVM
User Administrator、 およ びKVM Userのそれぞれに 1つずつ作成し

て く ださ い。

3 MSADUCツ ールを 使用し て、 KVM Appliance Administrator Group オ

ブジェ ク ト を 開き 、 Notesプロ パテ ィ を 選択し ます。 Notesフ ィ ー

ルド に、 そのグループのアク セス ・レ ベル ( 「 KVM Appliance
Admin」 ) を 入力し て保存し ます。 ほかの2つのグループ ・オブ

ジェ ク ト についても 、 それぞれの名前を 使用し て、 こ の手順を

繰り 返し ます。

注： すべてのアク セス制御の属性の値に、 次の単一の構文を使用し ま
す。

"[<属性文字列> <区切り 文字>] <特権レ ベル> [<区切り 文

字> <任意の文字列>]"
こ こ で、 <特権レ ベル> : =「 KVM User」 または「 KVM User
Admin」 または「 KVM Appliance Admin」
<区切り 文字> ::区切り 文字 := 以下のう ち の1つまたは複

数： 「 改行」 、 「 c/r」 、 「 コ ン マ 」 、 「 セミ コ ロ ン 」 、

「 タ ブ 」 のいずれかです ( 複数可 ) 。

<任意の文字列> は、 任意の英数文字列で、 Null( 空の ) 文

字列にする こ と も 可能です。

角かっ こ は、 オプシ ョ ン のアイ テムを 示し ます。 たと え

ば、 次のテン プレ ート は、 オプシ ョ ン の文字列と 区切り 文字

と 、 それに続く 必要な特権レ ベルを 示し ています。 "[<任意

の文字列> <区切り 文字>] < 特権レ ベル1>"

4 RCSを 表すコ ン ピ ュ ータ ー・オブジェ ク ト を 作成し ます。

5 KVM User特権レ ベルでアク セス制限さ れる サーバーに接続さ れ

ている 各SIPごと に、 コ ン ピ ュ ータ ー・オブジェ ク ト を 作成し ま

す。

6 スイ ッ チを 表すコ ン ピ ュ ータ ー・オブジェ ク ト を 適切なグループ ・

オブジェ ク ト に追加し ます。
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7 ユーザー・オブジェ ク ト を 、 アク セス ・レ ベルに応じ て適切なグ

ループ ・オブジェ ク ト に追加し ます。

8 アク セス制御さ れた SIPのコ ン ピ ュ ータ ー・オブジェ ク ト を KVM
User Groupに追加し ます。

Dell Extended SchemaのActive Directoryオブジェ ク ト の概要

認証と 承認のためにActive Directoryと 統合する 、 ネッ ト ワーク 上にあ

る それぞれの物理RCSには、 物理スイ ッ チを 表す少なく と も 1つ
のRCSデバイ ス ・オブジェ ク ト と 1つのAssociationオブジェ ク ト を 作成

する 必要があり ます。 Associationオブジェ ク ト は、 ユーザーまたはグ

ループを 、 1つ以上のSIPに対する 特権の特定のセッ ト と リ ン ク する

ために使用さ れます。 こ のモデルを 使用する こ と によ り 、 管理者は

設定を 複雑にし 過ぎる こ と な く 、 ユーザー、 RCS特権、 およ

びRemote Console Switch上のSIPのさ まざまな組み合わせを 、 最大限

柔軟に活用でき ます。

RCSデバイ ス ・オブジェ ク ト が、 認証と 承認のためにActive Directory
を ク エリ する ためのRCSへのリ ン ク です。 RCSを ネッ ト ワーク に追

加し たら 、 管理者はActive Directory名で RCSと そのデバイ ス ・オブ

ジェ ク ト を 構成し 、 ユーザーがActive Directoryで認証と 承認を 行える

よ う にする 必要があり ます。 ユーザーが認証でき る よ う に、 管理者

は少なく と も 1つのAssociationオブジェ ク ト にも Remote Console Switch
を 追加する 必要があり ます。

Associationオブジェ ク ト はいく つでも 作成でき 、 各Associationオブ

ジェ ク ト は無限数のユーザー、 ユーザーのグループ 、 RCS Deviceオブ

ジェ ク ト にリ ン ク でき ます。 ユーザーと RCS Deviceオブジェ ク ト

は、 エン タ プラ イ ズ内のどのド メ イ ン のメ ン バーであっ ても 構いま

せん。

ただし 、 各Associationオブジェ ク ト は、 ( ユーザー、 ユーザーのグ

ループ 、 またはRCS Deviceオブジェ ク ト を ) 1つのPrivilegeオブジェ ク

ト にのみリ ン ク でき ます。 Privilegeオブジェ ク ト によ り 、 管理者

は、 どのユーザーが特定のSIPに関し てどの種類の特権を 持っ ている

かを コ ン ト ロ ールでき ます。
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次の図では、 Associationオブジェ ク ト が、 すべての認証と 承認に必

要な接続を 提供する 様子を 示し ます。

図 5.10. Active Directoryオブジェ ク ト の一般的なセッ ト アッ プ

希望や必要に応じ て、 多数または少数のAssociationオブジェ ク ト を

作成でき ます。 ただし 、 少な く と も 1つのAssociationオブジェ ク ト を

作成する 必要があり 、 また、 認証と 承認のためにActive Directoryと
統合する ネッ ト ワーク 上にある 、 それぞれのRCSに対し て 1つのRCS
デバイ ス ・オブジェ ク ト を 持っ ている 必要があり ます。 Associationオ
ブジェ ク ト は、 RCS Deviceオブジェ ク ト のほかに、 必要に応じ て多

数または少数のユーザーまたはグループ 、 ある いはその両方を 持つ

こ と ができ ます。 ただし 、 Associationオブジェ ク ト 1つにつき 、 1つ
のPrivilegeオブジェ ク ト し か持てません。 Associationオブジェ ク ト

は、 RCSで特権を 持つユーザーを 接続し ます。

さ ら に、 単一ド メ イ ン または複数ド メ イ ン で Active Directoryオブ

ジェ ク ト を セッ ト アッ プでき ます。 たと えば、 2つのRCS( RCS1
と RCS2) があり 、 3人の既存Active Directoryユーザー
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( User1、 User2、 User3) がいる と し ます。 User1と User2に両方のRCS
の管理者特権を 与え、 User3にRCS2へのロ グイ ン 特権を 与える と し

ます。

次の図に、 こ のシナリ オでのActive Directoryオブジェ ク ト のセッ ト

アッ プ方法を 示し ます。

図 5.11. 単一ド メ イ ン でのActive Directoryオブジェ ク ト の設定

単一ド メ イ ン のシナリ オの場合にActive Directoryオブジェ ク ト を 設

定する には、 以下の作業を 行います。

1 2つのAssociationオブジェ ク ト を 作成し ます。

2 2つのRCSを 表すために、 RCS1と RCS2と いう 2つのRCSデバイ ス ・

オブジェ ク ト を 作成し ます。

3 Priv1と Priv2と いう 2つのPrivilegeオブジェ ク ト を 作成し 、 Priv1はす

べての特権 ( 管理者 ) を 持ち 、 Priv2はロ グイ ン 特権を 持つよ う

にし ます。

4 User1と User2を Group1にグループ化し ます。
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5 Group1を メ ン バーと し て Associationオブジェ ク ト 1( AO1)
に、 Priv1を Privilegeオブジェ ク ト と し て AO1に、 RCS1と RCS2
を RCS Deviceと し て AO1に追加し ます。

6 User3を メ ン バーと し て Associationオブジェ ク ト 2( AO2) に、 Priv2
を Privilegeオブジェ ク ト と し て AO2に、 RCS2を RCSデバイ スと し

て AO2に追加し ます。

詳細な手順については、 「 Dell Schema Extensionを 使用する Active
Directoryへのユーザーと 特権の追加」 を 参照し て く ださ い。

次の図に、 複数ド メ イ ン でのActive Directoryオブジェ ク ト のセッ ト

アッ プ方法を 示し ます。 こ のシナリ オでは、 2つのRCS( RCS1
と RCS2) があり 、 3人の既存Active Directoryユーザー

( User1、 User2、 User3) がいる と し ます。

User1はDomain1に、 User2と User3はDomain2に属し ます。 User1と User2
に両方のRCSの管理者特権を 与え、 User3にRCS2へのロ グイ ン 特権

を 与える と し ます。

図 5.12. 複数ド メ イ ン でのActive Directoryオブジェ ク ト の設定
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複数ド メ イ ン のシナリ オの場合にActive Directoryオブジェ ク ト を 設

定する には、 以下の作業を 行います。

1 ド メ イ ン ・フ ォ レ スト 機能は、 必ずネイ テ ィ ブまたはWindows
2003モード にし ます。

2 任意のド メ イ ン にAO1( ユニバーサル・スコ ープ ) と AO2と いう 2
つのAssociationオブジェ ク ト を 作成し ます。 図は、 Domain2内の

オブジェ ク ト を 示し ています。

3 2つのRCSを 表すために、 RCS1と RCS2と いう 2つのRCSデバイ ス ・

オブジェ ク ト を 作成し ます。

4 Priv1と Priv2と いう 2つのPrivilegeオブジェ ク ト を 作成し 、 Priv1はす

べての特権 ( 管理者 ) を 持ち 、 Priv2はロ グイ ン 特権を 持つよ う

にし ます。

5 User1と User2を Group1にグループ化し ます。 Group1のグループ ・ス

コ ープは、 ユニバーサルである 必要があり ます。

6 Group1を メ ン バーと し て Associationオブジェ ク ト 1( AO1)
に、 Priv1を Privilegeオブジェ ク ト と し て AO1に、 RCS1と RCS2
を RCS Deviceと し て AO1に追加し ます。

7 User3を メ ン バーと し て Associationオブジェ ク ト 2( AO2) に、 Priv2
を Privilegeオブジェ ク ト と し て AO2に、 RCS2を RCSデバイ スと し

て AO2に追加し ます。

RCSア ク セス のためのDell Schema
Extensionを 使用し た Active Directoryの構成

Active Directoryを 使用し て RCSにアク セスでき る よ う にする には、 次

の手順を 番号順に実行し て、 Active Directoryソ フ ト ウェ アと Remote
Console Switchを 構成する 必要があり ます。

1 Active Directoryスキーマを 拡張し ます。

2 Active Directoryユーザーと コ ン ピ ュ ータ ー・スナッ プイ ン を 拡張し

ます。
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3 RCSユーザーと 特権を Active Directoryに追加し ます。

Active Directoryスキーマの拡張 ( オプショ ン )

Active Directoryスキーマを 拡張する と 、 Dellの組織単位、 スキーマ ・ク

ラ スと 属性、 およ び特権の例と Associationオブジェ ク ト が、 Active
Directoryスキーマに追加さ れます。

注： スキーマを拡張するには、 ド メ イ ン ・フ ォ レスト のスキーマ・マス
タ ・フ レキシブル・シングル・マスタ 操作( FSMO) の役割所有者に関し
て、 スキーマ管理者の特権を持っ ている必要があり ます。

スキーマは、 2つの異なる 方法で拡張でき ます。 Dell Schema Extender
ユーテ ィ リ テ ィ を 使用する か、 またはLDIFスク リ プ ト ・フ ァ イ ルを

使用でき ます。

注： LDIFスク リ プト ・フ ァ イ ルを使用する場合は、 Dellの組織単位は追加
さ れません。

LDIFフ ァ イ ルと Dell Schema Extenderは、 dell.com/supportよ り 入手でき

ます。

LDIFフ ァ イ ルを 使用する 場合は、 LDIFフ ァ イ ル・ディ レ ク ト リ

の readmeフ ァ イ ルの説明を 参照し て く ださ い。 Dell Schema Extenderを
使用し て Active Directoryスキーマを 拡張する には、 「 Dell Schema
Extenderの使用」 の手順を 実行し て く ださ い。

Schema ExtenderまたはLDIFフ ァ イ ルは、 任意の場所にコ ピ ーし て実

行でき ます。

Dell Schema Extenderの使用

注： Dell Schema ExtenderはSchemaExtenderOem.iniフ ァ イ ルを使用し ま
す。 Dell Schema Extenderユーティ リ ティ が確実に正常な機能を果たすよう
にするために、 こ のフ ァ イ ルの名前を変更し ないでく ださ い。

1 Welcome画面でNextを ク リ ッ ク し ます。

2 警告文を 読んで、 も う 一度Nextを ク リ ッ ク し ます。

3 Use Current Log In Credentialsを オン にする か、 またはスキーマ管

理者アク セス権を 持つユーザー名と パスワード を 入力し ます。
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4 Nextを ク リ ッ ク し て Dell Schema Extenderを 実行し ます。

5 Finishを ク リ ッ ク し ます。

Active Directoryユーザーと コ ンピュ ータ ー・スナッ プイ ンへのDell
Extensionのイ ンスト ール ( オプショ ン )

Active Directoryでスキーマを 拡張する 場合、 管理者がRCSデバイ ス、

ユーザー、 ユーザー・グループ 、 RCS関連付け、 SIP特権を 管理でき る

よ う に、 Active Directoryユーザーと コ ン ピ ュ ータ ーのスナッ プイ ン も

拡張する 必要があり ます。 Active Directoryユーザーと コ ン ピ ュ ータ ー・

スナッ プイ ン へのDell Extensionのイ ン スト ールは、 「 Dell Systems
Management Consoles CD」 を 使用し てシステム管理ソ フ ト ウェ アを

イ ン スト ールする と き に行う こ と ができ る オプショ ン です。 システ

ム管理ソ フ ト ウェ アのイ ン スト ールの詳細については、 『 Dell
OpenManage Software Quick Installation Guide』 を 参照し て く ださ い。

注： Active DirectoryのRCSオブジェ ク ト を管理し ている各システムに、 管
理パッ ク をイ ンスト ールする必要があり ます。 イ ンスト ールの手順につ
いては、 後続の「 Active Directoryユーザーと コ ンピュ ータ ー・スナッ プイ ン
を開く 」 のセク ショ ンを参照し てく ださ い。 コ ンテナに含まれてい
る Dell SIP オブジェ ク ト は、 Administrator Packをイ ンスト ールし なければ参
照できません。

注： Active Directoryユーザーと コ ンピュ ータ ー・スナッ プの詳細について
は、 Microsoftのマニュ アルを参照し てく ださ い。

Active Directoryユーザーと コ ンピュ ータ ー・スナッ プイ ンを開く

Active Directoryユーザーと コ ン ピ ュ ータ ー・スナッ プイ ン を 開く には、

以下の手順を 行います。

ド メ イ ン ・コ ン ト ロ ーラ ー上で操作し ている 場合は、 スタ ート → 管

理ツ ール → Active Directoryユーザーと コ ン ピ ュ ータ ーを ク リ ッ ク し ま

す。

-または -

ド メ イ ン ・コ ン ト ロ ーラ 上で操作し ていない場合は、 ロ ーカ ル・シス

テムに適切な Microsoft Administrator Packがイ ン スト ールさ れている 必
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要があり ます。 こ の管理パッ ク を イ ン スト ールする には、 スタ ート

→ フ ァ イ ル名を 指定し て実行を ク リ ッ ク し 、 「 MMC」 と 入力し

て、 Enterキーを 押し ます。 こ の操作で、 Microsoft Management Console
( MMC) が開かれます。

1 [コ ン ソ ール1]ウィ ン ド ウでフ ァ イ ル ( または、 Windows 2000を
実行し ている システムでは、 [コ ン ソ ール ]) を ク リ ッ ク し ま

す。

2 スナッ プイ ン の追加と 削除を ク リ ッ ク し ます。

3 Active Directoryユーザーと コ ン ピ ュ ータ ーのスナッ プイ ン を 選択

し て、 追加を ク リ ッ ク し ます。

4 閉じ る を ク リ ッ ク し て、 OKを ク リ ッ ク し ます。

Dell Schema Extensionを 使用する Active
Directoryへのユーザーと 特権の追加

Dell拡張Active Directoryユーザーと コ ン ピ ュ ータ ーのスナッ プイ ン で

は、 SIP、 Association、 およ びPrivilegeの各オブジェ ク ト を 作成する こ

と で、 RCSのユーザーと 特権を 追加でき ます。 オブジェ ク ト のそれ

ぞれの種類を 追加する には、 それぞれの項の手順に行っ て く ださ

い。

SIPオブジェ ク ト の作成

1 MMCの [コ ン ソ ール ルート ]ウィ ン ド ウ内で、 コ ン テナを 右ク

リ ッ ク し ます。

2 新規 → Dell SIP Objectを 選択し ます。 こ の操作で [新規オブ

ジェ ク ト ]ウィ ン ド ウが表示さ れます。

3 新し いオブジェ ク ト の名前を 入力し ます。 こ の名前は、

「 Remote Console Switchの構成」 ( ページ 40) の手順4で入力す

る RCS名と 一致し ている 必要があり ます。

4 SIP Device Objectを 選択し ます。

5 OKを ク リ ッ ク し ます。
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Privilegeオブジェ ク ト の作成

Privilegeオブジェ ク ト は、 関連付けら れる オブジェ ク ト と 同じ ド メ

イ ン で作成さ れる 必要があり ます。

1 [コ ン ソ ール ルート ]( MMC) ウィ ン ド ウ内で、 コ ン テナを 右ク

リ ッ ク し ます。

2 新規 → Dell SIP Objectを 選択し て、 [新規オブジェ ク ト ]ウィ ン ド

ウを 開き ます。

3 新し いオブジェ ク ト の名前を 入力し ます。

4 Privilege Objectを 選択し ます。

5 OKを ク リ ッ ク し ます。

6 作成し た Privilegeオブジェ ク ト を 右ク リ ッ ク し て、 プロ パテ ィ を

選択し ます。

7 RCS Privilegesタ ブを ク リ ッ ク し 、 ユーザーに割り 当てる RCS特権

を 選択し ます。

Dell Associationオブ ジ ェ ク ト 構文の使用

Dell Associationオブジェ ク ト 構文では、 Dell LDAPスキーマ内のオブ

ジェ ク ト ・タ イ プはユーザーおよ びグループにデフ ォ ルト 設定さ れて

います。 Dell拡張スキーマの場合には、 次の4つの新規オブジェ ク

ト ・ク ラ スに対し て固有のオブジェ ク ト IDが追加さ れています：

• KVM RCSオブジェ ク ト

• KVM SIPオブジェ ク ト

• Privilegeオブジェ ク ト

• Associationオブジェ ク ト

こ れら の新規オブジェ ク ト ・ク ラ スはそれぞれ、 Active Directoryでの

デフ ォ ルト のク ラ スの様々な組み合わせ ( 階層 ) と Dellでの固有属

性タ イ プに従っ て定義さ れています。 Dell固有属性タ イ プはそれぞ
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れ、 Active Directoryでのデフ ォ ルト の属性構文に従っ て定義さ れて

います。

MicrosoftのActive Directoryでのデフ ォ ルト のオブジェ ク ト ・ク ラ スに

はユーザーおよ びグループがあり ます。 ユーザー・ク ラ スと は通常、

単一エン テ ィ テ ィ の情報を 含むActive Directoryオブジェ ク ト を さ し

ます。 グループ ・ク ラ スはネスト 用のコ ン テナを 表し 、 オブジェ ク

ト 群の情報を 含んでいます。

各KVM RCSオブジェ ク ト は、 Active Directory内の個々のRemote
Console Switchを 表し ます。 こ れら は単一エン テ ィ テ ィ である た

め、 LDAPデフ ォ ルト 言語ではグループ ・オブジェ ク ト ではなく ユー

ザー・オブジェ ク ト になっ ています。

各Privilegeオブジェ ク ト はそれぞれ独特の特権の組み合わせを 規定

し ます。 個々の組み合わせは別個のエン テ ィ テ ィ と し て扱われま

す。 従っ て、 グループ ・オブジェ ク ト ではなく ユーザー・オブジェ ク

ト と なり ます。

Associationオブジェ ク ト には、 特定のRCSやSIPに関し て特定のユー

ザー・アカ ウン ト に付与さ れた特権の情報一式が含まれていま

す。 RCSオブジェ ク ト 内のユーザー・アカ ウン ト は、 次の任意の組み

合わせによ っ て指定でき ます。

• 個別アカ ウン ト

• ユーザー・アカ ウン ト のActive Directoryセキュ リ テ ィ ・グループ

• ユーザー・アカ ウン ト のActive Directoryセキュ リ テ ィ ・グループ

( 複数 )

同様に、 Associationオブジェ ク ト 内のRCSやSIPの場合、 Associationオ
ブジェ ク ト は複数のセキュ リ テ ィ ・グループを 同様に使用でき る た

め、 自身がGroupオブジェ ク ト と し て定義さ れます。

Associationオブジェ ク ト の作成

Associationオブジェ ク ト はグループから 派生し ており 、 グループの種

類を 含んでいる 必要があり ます。 Associationスコ ープは、 Association
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オブジェ ク ト のセキュ リ テ ィ ・グループの種類を 指定し ま

す。 Associationオブジェ ク ト を 作成する 場合は、 追加し よ う と し て

いる オブジェ ク ト ・タ イ プに適用さ れる Associationスコ ープを 選択す

る 必要があり ます。 たと えば、 ユニバーサルを 選択する と 、 Active
Directoryド メ イ ン がネイ テ ィ ブまたはよ り 上位のモード で機能し て

いる と き にのみ、 Associationオブジェ ク ト が使用可能になり ます。

Associationオブジェ ク ト を 作成する には：

1 [コ ン ソ ール ルート ]( MMC) ウィ ン ド ウ内で、 コ ン テナを 右ク

リ ッ ク し ます。

2 New → Dell SIP Objectを 選択し て、 [新規オブジェ ク ト ]ウィ ン ド

ウを 開き ます。

3 新し いオブジェ ク ト の名前を 入力し ます。

4 Association Objectを 選択し ます。

5 Association Objectのスコ ープを 選択し ます。

6 OKを ク リ ッ ク し ます。

Association Objectへのオブジェ ク ト の追加

Associationオブジェ ク ト の [プロ パテ ィ ]ウィ ン ド ウを 使用する と 、

ユーザーやユーザー・グループ 、 Privilegeオブジェ ク ト 、 およ び SIPデバ

イ スやSIPデバイ ス ・グループを 関連付ける こ と ができ ます。

注： Windows 2000モード またはそれ以上を使用し ている場合は、 ユニバー
サル・グループを使用し て、 ユーザーやSIPオブジェ ク ト でド メ イ ンを補
う 必要があり ます。

ユーザーと SIPデバイ スのグループを 追加でき ます。 Dell関連のグ

ループの作成は、 他のグループの作成と 同じ 方法で行う こ と ができ

ます。

ユーザーまたはユーザー・グループを 追加する には：

1 Associationオブジェ ク ト を 右ク リ ッ ク し て、 Propertiesを 選択し ま

す。

2 Usersタ ブを 選択し て、 Addを ク リ ッ ク し ます。
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3 ユーザーまたはユーザー・グループの名前を 入力し 、 OKを ク

リ ッ ク し ます。

Privilege Objectタ ブを ク リ ッ ク し て、 SIPデバイ スへの認証時にユー

ザーまたはユーザー・グループの特権を 定義する Associationオブジェ ク

ト に、 Privilegeオブジェ ク ト を 追加し ます。

注： 1つのAssociationオブジェ ク ト には、 1つのPrivilegeオブジェ ク ト のみ
を追加できます。

特権を 追加する には：

1 Privileges Objectタ ブを 選択し て、 Addを ク リ ッ ク し ます。

2 Privilegeオブジェ ク ト の名前を 入力し て、 OKを ク リ ッ ク し ま

す。

Productsタ ブを ク リ ッ ク し て、 1つまたは複数のSIPデバイ ス

を Associationに追加し ます。 関連付けら れたデバイ スは、 定義さ れ

たユーザーやユーザー・グループが利用でき る 、 ネッ ト ワーク に接続

さ れた SIPデバイ スを 指定し ます。

注： 1つのAssociationオブジェ ク ト に複数のSIPデバイ スを追加できます。

SIPデバイ スまたはSIPデバイ ス ・グループを 追加する には：

1 Productsタ ブを 選択し て、 Addを ク リ ッ ク し ます。

2 SIPデバイ スまたはSIPデバイ ス ・グループの名前を 入力し 、 OK
を ク リ ッ ク し ます。

3 [プロ パテ ィ ]ウィ ン ド ウで、 Applyと OKを 順にク リ ッ ク し ます。

コ ン ソ ール・リ ダ イ レ ク シ ョ ン ・ア ク セ ス
のセ キュ リ テ ィ

RCSの運用環境では、 いずれのユーザー特権でも OBWIを 起動でき ま

す。 そのユーザーに対する OBWIの機能は、 RCS内に設定さ れている

ユーザーの特権レ ベルによ っ て制限さ れます。 Dell Extended Schema
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を 使用する LDAPでは、 管理者がOBWIへのユーザーのアク セスを 制

限でき る ため、 RCS管理のセキュ リ テ ィ を 強化でき ます。

OBWIの使用の承認は、 Dell Privilegeオブジェ ク ト ( DPO) のKVM
RCS Privilegesタ ブで、 ユーザーの特権レ ベルが構成さ れている かど

う かによ っ て定義さ れます。 DPOのKVM SIP Privilegesタ ブにあ

る Console Redirection Accessチェ ッ ク ボッ ク スを 選択する と 、 OBWIを
表示でき ないユーザーがRCSク ラ イ アン ト から SIPのサブセッ ト に対

し てビ デオ・ビ ュ ーア ・セッ シ ョ ン を 起動でき る よ う になり ます。 こ

の認証は、 DPOで設定し た構成パラ メ ータ ーと 、 Dell Associationオブ

ジェ ク ト ( DAO) に含まれる SIPオブジェ ク ト を 組み合わせて実行

さ れます。

OBWIへのアク セス権を 持たないユーザーがRCSク ラ イ アン ト から

ビ ュ ーア ・セッ シ ョ ン を 起動でき る よ う にする には、 下記の手順に

従っ て く ださ い。

1 そのユーザーのアク セスを 許可する SIPごと にDell SIPオブジェ ク

ト を 作成する 。

2 対象と なる ユーザーそれぞれにActive Directoryユーザー・アカ ウン

ト を 作成する 。

3 DPOを 作成する 。 KVM RCS Privilegesタ ブの3つのボッ ク スについ

ては、 いずれにも チェ ッ ク を 入れないでく ださ い。 KVM SIP
Privilegesタ ブのConsole Redirection Accessボッ ク スにチェ ッ ク を 入

れます。

注： KVM RCS Privilegesチェ ッ ク ボッ ク スのいずれかにチェ ッ ク を入
れ、 Console Redirection Accessボッ ク スにも チェ ッ ク を入れると 、 Console
Redirection Accessチェ ッ ク ボッ ク スより も KVM RCS Privilegesボッ ク スで選
択し た特権レベルに関連付けら れた標準のユーザー特権が優先さ れるた
め、 ユーザーはAMPを表示できます。

4 DAOを 作成する 。

5 手順4で作成し た DAOのプロ パテ ィ を 開く 。

a. 手順2で作成し たすべてのユーザー・アカ ウン ト を 追加する 。

b. 手順3で作成し た DPOを 追加する 。
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c. 手順1で作成し た SIPオブジェ ク ト を 追加する 。

Active Directoryを 使用し た RCSへのロ グイ
ン

Active Directoryを 使用し て、 RCSソ フ ト ウェ アまたはOBWIを 介し

て RCSにロ グイ ン でき ます。

ロ グイ ン 構文は、 以下の3つの方法すべてに共通です。

<username@domain>または<domain>\<username>また

は<domain>/<username>( こ こ で、 usernameは1～256バイ ト のASCII
文字列です ) 。 空白や特殊文字 ( \、 /、 @など ) は、 ユーザー名、 ド

メ イ ン 名のどち ら にも 使用でき ません。

注： AmericasなどのNetBIOSド メ イ ン名は解決できないので、 指定するこ
と ができません。

注： ド メ イ ン名が含まれていない場合は、 Remote Console Switchのローカ
ル・データ ベースがユーザーの認証に使用さ れます。

LDAPの実装で タ ーゲッ ト ・デバイ ス 名を
指定する 際の要件

下記のエラ ー：

Login Failure.Reason:Access cannot be granted due to Authentication Server
errors

Active Directory内に SIPオブジェ ク ト が作成さ れている こ と と 、 その

名前がコ ン ソ ール・スイ ッ チで OBWIを 介し てそのSIPに割り 当てら

れている 名前に完全に一致し ている こ と を 確認し て く ださ い。

Dell Standard Schemaおよ びDell Extended Schemaでは、 Microsoft
Windows Active Directory内で SIPを 表すために固有のオブジェ ク ト ・ク

ラ スを 使用し ています。 こ れら のオブジェ ク ト ・ク ラ スに対す

る Microsoftの通常の命名規則では特殊文字やスペースは使用でき な
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いこ と になっ ています。 SIP内のタ ーゲッ ト ・デバイ ス名にスペース

や特殊文字が現在含まれている 場合、 LDAPを 使用する にはこ れら

の文字を 含まないよ う 名前を 変更する 必要があり ます。

SIP内のタ ーゲッ ト ・デバイ ス名を 変更する には、 まずコ ン ソ ール・ス

イ ッ チで OBWIを 介し て行い、 次にRCSソ フ ト ウェ アから 再同期化

し ます。 OBWIではSIPに割り 当てら れる 名前にスペースを 使用でき

ますが、 Active Directoryでは使用でき ないこ と に注意し て く ださ

い。 SIPでのオブジェ ク ト 名はMicrosoftのActive Directoryの規則に準

じ て指定し なければなり ません。

よ く ある 質問

次の表に、 よ く ある 質問と その答えを 示し ます。

複数のフ ォ レスト にわたる Active
Directoryを使用し て Remote
Console Switchにログイ ンできま

すか?

RCS Active Directoryク エリ のアルゴリ ズム

は、 単一フ ォ レスト 内の単一ツリ ーのみ

をサポート し ています。

混在モード で動作する Active
Directory( つまり 、 Microsoft
Windows NT® 4.0、 Windows 2000、
またはWindows Server 2003などの

異なるオペレーティ ング・システ

ムを実行し ている複数のド メ イ

ン ・コ ン ト ローラ ーがフ ォ レスト

内に存在する ) を使用し

て Remote Console Switchにログイ

ンするこ と はできますか。

はい。 混在モード では、 RCSク エリ 処理

( ユーザー、 SIP Deviceオブジェ ク ト 、 お

よびAssociationオブジェ ク ト 間) で使用さ

れるすべてのオブジェ ク ト が同じ ド メ イ

ン内に存在し ている必要があり ま

す。 Dell拡張のActive Directoryユーザーと コ

ンピュ ータ ー・スナッ プイ ンはモード を確

認し て、 混在モード の場合は各ド メ イ ン

でオブジェ ク ト を作成できるよう にユー

ザーを制限し ます。

表 5.4: よ く ある 質問
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Active DirectoryでのRCSの使用

は、 複数ド メ イ ンの環境をサ

ポート し ていますか。

はい。 ド メ イ ン ・フ ォ レスト 機能レベル

は、 ネイ ティ ブ ・モード またはWindows
2003モード である必要があり ます。 さ ら

に、 Associationオブジェ ク ト 、 Remote
Console Switchユーザー・オブジェ ク ト 、 お

よびSIP Deviceオブジェ ク ト ( Associationオ
ブジェ ク ト を含む ) 中では、 グループは

ユニバーサル・グループでなければなり ま

せん。

こ れら のDell拡張オブジェ ク ト

( Dell Associationオブジェ ク

ト 、 Dell Remote Console Switch
Device、 およびDell Privilegeオブ

ジェ ク ト ) は、 異なるド メ イ ン

に存在できますか?

Associationオブジェ ク ト と Privilegeオブ

ジェ ク ト は、 同じ ド メ イ ンに存在し てい

る必要があり ます。 Dell拡張Active Directory
ユーザーと コ ンピュ ータ ー・スナッ プイ ン

は、 強制的にこ れら の2つのオブジェ ク ト

を同じ ド メ イ ン内に作成さ せます。 他の

オブジェ ク ト は、 別のド メ イ ンにあっ て

も 構いません。

ド メ イ ン ・コ ン ト ローラ SSLの構

成に制限はあり ますか?

はい。 RCSには信頼できる CAのSSL証明書

を 1つし かアッ プロード できないため、

フ ォ レスト 内のすべてのActive Directory
サーバーのSSL証明書は、 同一のルート CA
によっ て署名さ れている必要があり ま

す。
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Active Directory認証を使用し

て RCSにログイ ンできない場合

は、 どう し たら よいですか。

以下のよう にト ラ ブルシュ ーティ ングし

てく ださ い。

ド メ イ ン名が指定さ れていない場合に

は、 ローカ ル・データ ベースが使用さ れま

す。 AD認証が機能し ていないと きにログ

イ ンするには、 デフ ォ ルト のローカ ル管

理者アカ ウント を使用し てく ださ い。

RCS Active Directory構成ページで、 Enable
Active Directoryチェ ッ ク ・ボッ ク ス ( RCSソ
フ ト ウェ アの場合) またはUse LDAP
Authenticationチェ ッ ク ・ボッ ク ス ( OBWIの
場合) にチェ ッ ク を入れているこ と を確

認し ます。

RCS Networking構成ページのDNS設定が正

し いこ と を確認し ます。

NTPパネルで指定さ れたサーバーのう ち、

少なく と も 1つのサーバーでNTP( Network
Time Protocol) が有効になっ ているこ と を

確認し ます。

Active Directoryの証明書を Active Directory
ルート CAから RCSへアッ プロード 済みであ

るこ と を確認し ます。

ド メ イ ン ・コ ン ト ローラ ーSSL証明書の期

限が切れていないこ と を確認し ます。

「 Remote Console Switch Name」 、 「 Root
Domain Name」 、 「 RCS Domain Name」
が、 Active Directory環境の構成と 一致し て

いるこ と を確認し ます。

NetBIOS名ではなく 、 正し いユーザー名と

ド メ イ ン名を使用し てログイ ンし ている

こ と を確認し ます。
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付録 A： タ ーミ ナルの操作

各RCSは、 SETUPポート から アク セスさ れる コ ン ソ ール・メ ニュ ー・イ

ン タ ーフ ェ イ スを 介し て、 スイ ッ チ ・レ ベルで構成でき ます。 すべ

てのタ ーミ ナル・コ マン ド は、 タ ーミ ナル・エ ミ ュ レ ーショ ン ・ソ フ ト

ウェ アを 実行し ている タ ーミ ナルまたはコ ン ピ ュ ータ ーを 介し て

アク セスさ れます。

注： 推奨方法は、 ローカ ルUIでの構成設定です。

タ ーミ ナルを スイ ッ チに接続する には次の手順を 実行し ます。

1 付属のRJ-45/DB-9( メ ス ) 変換アダプタ ーと RJ-45フ ラ ッ ト ・ケーブ

ルを 使用し て、 タ ーミ ナル・エ ミ ュ レ ーショ ン ・ソ フ ト ウェ ア

( HyperTerminalなど ) を 実行し ている タ ーミ ナルまたはコ ン

ピ ュ ータ ーを 、 スイ ッ チの背面パネルにある SETUPポート に接続

し ます。 タ ーミ ナル設定の種類は、 9600bps、 8ビ ッ ト 、 1スト ッ

プ ・ビ ッ ト 、 パリ テ ィ なし 、 フ ロ ー・コ ン ト ロ ールなし です。

2 各タ ーゲッ ト ・デバイ スを オン にし てから 、 スイ ッ チの電源を オ

ン にし ます。 スイ ッ チの起動が完了する と 、 コ ン ソ ール・メ

ニュ ーに次のメ ッ セージが表示さ れます。 「 Press any key to
continue」 ( 続行する には任意のキーを 押し て く ださ い ) 。

コ ン ソ ール・ブ ート ・メ ニ ュ ー・オプシ ョ ン

スイ ッ チの電源投入中に、 キーを 押し てブート ・メ ニュ ーを 表示でき

ます。 こ のメ ニュ ーから は、 次の4つのオプショ ン のいずれかを 選

択でき ます。

• Boot Normal( 通常ブート )

• Boot Alternate Firmware( 代替フ ァ ームウェ アのブート )
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• Reset Factory Defaults( 出荷時デフ ォ ルト へのリ セッ ト )

• Full-Factory Reset( 完全出荷時リ セッ ト )

コ ン ソ ール・メ イ ン ・メ ニ ュ ー・オプシ ョ ン

電源がオン になる と 、 メ イ ン ・メ ニュ ーに製品の名前と バージョ ン

が表示さ れます。 こ のメ ニュ ーから は、 次の4つのオプショ ン のい

ずれかを 選択でき ます。

• Network configuration( ネッ ト ワーク 構成 ) ： こ のメ ニュ ー・オプ

シ ョ ン では、 RCSのネッ ト ワーク 設定を 構成でき ます。

• Debug messages( デバッ グ・メ ッ セージ ) ： こ のメ ニュ ー・オプ

シ ョ ン で、 コ ン ソ ール・ステータ ス ・メ ッ セージを オン にでき ま

す。 Dell™こ の操作を 行う と 性能が大幅に低減する こ と がある た

め、 テク ニカ ル・サポート から の指示を 受けた場合にのみデバッ

グ・メ ッ セージを 有効化し て く ださ い。 メ ッ セージの閲覧が終了

し たら 、 任意のキーを 押し てこ のモード を 終了し ます。

• Reset RCS( RCSのリ セッ ト ) ： こ のメ ニュ ー・オプシ ョ ン では、

スイ ッ チのソ フ ト ・リ セッ ト を 実行でき ます。

• Exit( 終了 ) ： こ のメ ニュ ーを 選択する と 、 入力待機のプロ ン プ

ト に戻り ます。 コ ン ソ ール・メ ニュ ー・イ ン タ ーフ ェ イ スのパス

ワード が有効になっ ている 場合には、 次のユーザーにユーザー名

と パスワード のロ グイ ン 画面によ る メ ッ セージが出さ れる よ う

に、 コ ン ソ ールのメ イ ン ・メ ニュ ーを 終了する 必要があり ます。
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付録 B： SIPの使用

各シリ アルSIPポート は、 Avocent ACSコ ン ソ ール・サーバーまた

はCiscoのピ ン 配列から 選択でき ます。 こ れは、 ロ ーカ ル・ユーザー・

イ ン タ ーフ ェ イ スまたはリ モート OBWIから 選択でき ます。 ACSがデ

フ ォ ルト です。

ピ ン 配列を Ciscoモード に変更する には次の手順を 実行し ます。

1 Unit View → RCS → RCS Settings → Ports → SIPs の順に選択し ます。

2 対象のSIPを ク リ ッ ク し ます。

3 Settings → Pinout の順に選択し ます。

注： DB-9アダプタ ーを使用し ている場合は、 ACSコ ンソ ール・サーバーの
ピン配列を選択し ます。

ACSコ ン ソ ール・サーバー・ポート のピ ン 配
列

次の表に、 SIPのACSコ ン ソ ール・サーバー・シリ アル・ポート のピ ン 配

列を 一覧で示し ます。

ピン番

号
信号名

入力／出

力

1 RTS - Request to Send( 送信要求) 出力

2
DTR - Data Terminal Ready( データ ・タ ーミ ナル・レ

ディ ー)
出力

表 B.1: ACSコ ン ソ ール・サーバー・シリ アル・ポート のピ ン 配列



174 | 付録 B： SIPの使用

ピン番

号
信号名

入力／出

力

3 TXD - Transmit Data( 送信データ ) 出力

4 GND - Signal Ground( 信号用接地) なし

5 CTS - Clear to Send( 送信可) 入力

6 RXD - Receive Data( 受信データ ) 入力

7 DCD/DSR - Data Set Ready( データ ・セッ ト ・レディ ー) 入力

8 N/C - Not Connected( 未接続) なし

Ciscoポート のピ ン 配列

次の表に、 SIPのCiscoシリ アル・ポート のピ ン 配列を 一覧で示し ま

す。

ピン番

号
信号名

入力／出

力

1 CTS - Clear to Send( 送信可) 入力

2 DCD/DSR - Data Set Ready( データ ・セッ ト ・レディ ー) 入力

3 RXD - Receive Data( 受信データ ) 入力

4 GND - Signal Ground( 信号用接地) なし

5 N/C - Not Connected( 未接続) なし

6 TXD - Transmit Data( 送信データ ) 出力

表 B.2: Ciscoシリ アル・ポート のピ ン 配列
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ピン番

号
信号名

入力／出

力

7
DTR - Data Terminal Ready( データ ・タ ーミ ナル・レ

ディ ー)
出力

8 RTS - Request to Send( 送信要求) 出力
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付録 C： MIBと SNMPト ラ ッ プ

Dell RCSには監査イ ベン ト を SNMPマネージャ ーに送信する 機能があ

り ます。 SNMPト ラ ッ プは、 SNMPト ラ ッ プ MIBに定義さ れていま

す。

Save Trap MIB機能を 使用し て、 ト ラ ッ プ MIBフ ァ イ ルを RCSから アッ

プロ ード でき ます。 その後、 アッ プロ ード さ れたト ラ ッ プ MIBフ ァ

イ ルは、 SNMPト ラ ッ プ ・レ シーバー・アプ リ ケーショ ン に読み込むこ

と ができ ます。

監査イ ベン ト は「 syslog」 送信先に送る こ と も でき ます。 各 syslog
メ ッ セージの形式は、 ト ラ ッ プ MIBフ ァ イ ルに定義さ れている 各ト

ラ ッ プの、 対応する 「 --#SUMMARY」 コ メ ン ト に指定さ れます。

こ の付録では、 RCSが生成でき る ト ラ ッ プ ・イ ベン ト を 説明し ま

す。 こ の付録内の情報は、 努めて最新のも のと し ていますが、 ト

ラ ッ プ MIBフ ァ イ ルに含まれている ト ラ ッ プ情報が最も 正確です。

SNMPマネージャ ーは、 IPv4または IPv6プロ ト コ ルを 使用し て、 RCS
のMIB-IIオブジェ ク ト にアク セスでき ます。

設計上、 RCS内の企業固有のMIBオブジェ ク ト には、 SNMPを 使用し

てアク セスする こ と はでき ません。

RCSト ラ ッ プの定義では、 次のRFC( Request For Comments) で説明

する 構造を 使用し ています。

• RFC-1155-SMI

TCP/IPベースのイ ン タ ーネッ ト で使用する 管理情報の定義に

対する 一般的な構造と 同定法を 説明し ます。

• RFC-1212
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簡潔で記述的な MIBモジュ ールを 作成する ための形式を 説明

し ます。

• RFC-1213-MIB

TCP/IPベースのイ ン タ ーネッ ト ワーク でのネッ ト ワーク 管理

プロ ト コ ルでの使用に対する イ ン タ ーネッ ト 標準MIB-II を 説

明し ます。

• RFC-1215

SNMP標準ト ラ ッ プを 説明し 、 企業固有のト ラ ッ プを 定義す

る 方法を 提供し ます。 各ト ラ ッ プによ っ て報告さ れる 特定

のオブジェ ク ト は、 RCSから アッ プロ ード さ れたト ラ ッ

プ MIBフ ァ イ ルに定義さ れています。 次の表に、 生成さ れた

ト ラ ッ プ ・イ ベン ト の一覧を 示し ます。
表 C.1: 生成さ れたト ラ ッ プ ・イ ベン ト

ト ラ ッ プ ・イ ベント ト ラ ッ プ番号

再起動が開始し まし た 1

ユーザーログイ ン 2

ユーザーログアウト 3

タ ーゲッ ト セッ ショ ンが開始し まし た 4

タ ーゲッ ト セッ ショ ンが停止し まし た 5

タ ーゲッ ト セッ ショ ンが終了し まし た 6

ト ラ ッ プ 7～9は廃止さ れまし た 7-9

イ メ ージ・フ ァ イ ルのアッ プグレード が開始し まし た 10

イ メ ージ・フ ァ イ ルのアッ プグレード 結果 11

ユーザーが追加さ れまし た 12
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ト ラ ッ プ ・イ ベント ト ラ ッ プ番号

ユーザーが削除さ れまし た 13

ユーザーが変更さ れまし た 14

ユーザーはロッ ク 状態です 15

ユーザーはロッ ク 解除さ れています 16

ユーザー認証の失敗 17

SIP が追加さ れまし た 18

SIP が取り 外さ れまし た 19

SIPが移動さ れまし た 20

タ ーゲッ ト デバイ ス名が変更さ れまし た 21

ティ アド スイ ッ チが追加さ れまし た 22

ティ アド スイ ッ チが取り 外さ れまし た 23

ティ アド スイ ッ チの名前が変更さ れまし た 24

構成フ ァ イ ルが読み込まれまし た 25

ユーザーデータ ベース フ ァ イ ルが読み込まれまし た 26

CA証明書が読み込まれまし た 27

SIP イ メ ージのアッ プグレード が開始し まし た 28

SIP イ メ ージのアッ プグレード 結果 29

SIP が再起動し まし た 30

バーチャ ル メ ディ ア セッ ショ ンが開始し まし た 31
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ト ラ ッ プ ・イ ベント ト ラ ッ プ番号

バーチャ ル メ ディ ア セッ ショ ンが停止し まし た 32

バーチャ ル メ ディ ア セッ ショ ンが終了し まし た 33

バーチャ ル メ ディ ア セッ ショ ンが予約さ れまし た 34

バーチャ ル メ ディ ア セッ ショ ンが予約解除さ れまし た 35

バーチャ ル メ ディ ア ド ラ イ ブがマッ ピングさ れまし た 36

バーチャ ル メ ディ ア ド ラ イ ブがマッ プ解除さ れまし た 37

ト ラ ッ プ 38～44は廃止さ れまし た 38-44

画面解像度が変更さ れまし た 45

集約タ ーゲッ ト ・デバイ スの状態が変更さ れまし た 46

出荷時デフ ォ ルト 設定 47

電源エラ ー 48

電源が復元さ れまし た 49

PDUデバイ スはオンラ イ ンです 50

PDUデバイ スはオフ ラ イ ンです 51

PDUソ ケッ ト ・オン ・コ マンド 52

PDUソ ケッ ト ・オフ ・コ マンド 53

PDUソ ケッ ト 再起動コ マンド 54

PDUソ ケッ ト ・オンの検出失敗 55

PDUソ ケッ ト ・オフ の検出失敗 56
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ト ラ ッ プ ・イ ベント ト ラ ッ プ番号

PDU状態ソ ケッ ト ・オン 57

PDU状態ソ ケッ ト ・オフ 58

PDUポート 名が変更さ れまし た 59

PDUソ ケッ ト 名が変更さ れまし た 60

PDU入力フ ィ ード 合計負荷高 61

PDU入力フ ィ ード 合計負荷低 62

PDUデバイ ス名が変更さ れまし た 63

PDU入力フ ィ ード 名が変更さ れまし た 64

PDUソ ケッ ト ・ロッ ク ・コ マンド 65

PDUソ ケッ ト ・ロッ ク 解除コ マンド 66

PDU状態ソ ケッ ト ・ロッ ク 67

PDU状態ソ ケッ ト ・ロッ ク 解除 68

PDUイ メ ージ・フ ァ イ ルのアッ プグレード が開始し まし た 69

PDUイ メ ージ・フ ァ イ ルのアッ プグレード 結果 70

PDU回路名が変更さ れまし た 71

PDUデバイ ス合計負荷高 72

PDU回路合計負荷高 73

PDUソ ケッ ト 合計負荷高 74

フ ァ ン ・エラ ー 75
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ト ラ ッ プ ・イ ベント ト ラ ッ プ番号

温度範囲 76

スマート カ ード が挿入さ れまし た 77

スマート カ ード が取り 外さ れまし た 78
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付録 D： ケーブ ルのピ ン 配列
情報

注： すべてのスイ ッ チには、 モデム・ポート と コ ンソ ール／セッ ト アッ
プ ・ポート 用にRJ45( 8ピン ・モジュ ラ ー) ジャ ッ ク が付いています。

モデムのピ ン 配列

モデム・ポート のピ ン 配列と 説明を 次の図およ び表に示し ます。

図 D.1. モデムのピ ン 配列

表 D.1: モデムのピ ン 配列の説明

ピン

番号
説明

ピン

番号
説明

1
送信要求( RTS： Request to
Send)

5 送信データ ( TXD： Transmit Data)

2
データ ・セッ ト ・レディ ー

( DSRData Set Ready)
6 信号用接地( SG： Signal Ground)
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ピン

番号
説明

ピン

番号
説明

3
データ ・キャ リ ア検出

( DCD： Data Carrier Detect)
7

データ ・タ ーミ ナル・レディ ー

( DTR： Data Terminal Ready)

4
受信データ ( RXD： Receive
Data)

8 送信可( CTS： Clear to Send)

コ ン ソ ール／セッ ト ア ッ プのピ ン 配列

コ ン ソ ール／セッ ト アッ プ用ポート のピ ン 配列と 説明を 次の図およ

び表に示し ます。

図 D.2. コ ン ソ ール／セッ ト アッ プのピ ン 配列

表 D.2: コ ン ソ ール／セッ ト アッ プのピ ン 配列の説明

ピン番

号
説明

ピン番

号
説明

1 接続なし 5
送信データ ( TXD： Transmit
Data)

2 接続なし 6
信号用接地( SG： Signal
Ground)

3 接続なし 7 接続なし

4
データ 受信( RXD： Receive
Data)

8 接続なし
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付録 E： UTPケーブ ル

以下に、 接続媒体のさ まざまな特徴を 説明し ます。 RCSシステムで

はUTPケーブル配線を 使用し ます。 スイ ッ チ ・システムの性能は、

高品質の接続が得ら れる かどう かに依存し ます。 品質が優れない

ケーブル、 設置や保守に問題のある ケーブルは、 システムの性能を

損なう 結果と なる 場合があり ます。

注： こ の付録は情報の提供のみを目的と し ています。 設置する前に、 当
地のコ ード 当局やケーブル関連の専門家に確認し てく ださ い。

銅製UTPケーブ ル

RCSでサポート さ れている 3種類のUTPケーブルの基本的な定義は次

のと おり です。

• CAT 5 ( 4ペア ) 高性能ケーブルは、 ツ イ スト ・ペア電線で構成

さ れており 、 主にデータ 送信に使用さ れます。 ペア線がよ り 合

わさ れている こ と で、 こ のケーブルでは不要な干渉の混入から

ある 程度免れる こ と ができ ます。 CAT 5ケーブルは通

常、 10～100 Mbpsの範囲で動作する ネッ ト ワーク に使用し ま

す。

• CAT 5E( 強化 ) ケーブルの特徴はCAT 5と 同様ですが、 製造規

格が若干厳し いも のになっ ています。

• CAT 6ケーブルは、 CAT 5Eケーブルに比べよ り 厳し い要件に合わ

せて製造さ れています。 CAT 6はよ り 高い測定周波数範囲を 持

ち 、 同一周波数においてはCAT 5Eに比べ明ら かに分かる 優れた

性能要件を 示し ます。
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配線規格

8導線 ( 4ペア ) RJ-45終端処理済みUTPケーブルには、 2種類の推奨

配線規格があり ます。 EIA/TIA 568Aおよ びB。 こ れら の規格は、 UTP
ケーブル仕様によ る イ ン スト ールに適用さ れます。 RCSシステムで

はこ れら の規格のいずれかがサポート さ れています。 次の表は、 各

ピ ン の規格を 説明し ています。

表 E.1: UTP配線規格

ピン固定 EIA/TIA 568A EIA/TIA 568B

1 白／緑 白／オレンジ

2 緑 オレンジ

3 白／オレンジ 白／緑

4 青 青

5 白／青 白／青

6 オレンジ 緑

7 白／茶 白／茶

8 茶 茶

ケーブルの設置、 保守、 およ び安全情報

次に、 ケーブルの設置や保守を 実行する 前に目を 通し ておく べき 重

要な安全注意事項を 一覧で示し ます。

• 各UTPの長さ は最長で 9.1 m( 30フ ィ ート ) と し て く ださ い。

• ペア線は、 必ず終端箇所までツ イ スト さ れた ( よ り 合わさ れ

た ) 状態を 保つか、 またはツ イ スト になっ ていない部分が1.3
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cm( 半イ ン チ ) を 超えないよ う にし て く ださ い。 終端処理の

際、 外被を 2.5 cm( 1イ ン チ ) 以上剥がさ ないでく ださ い。

• ケーブルを 曲げる 必要がある 場合は、 半径が2.5 cm( 1イ ン チ )
よ り 小さ く なら ない範囲で緩やかに行っ て く ださ い。 ケーブル

を 鋭角に曲げたり ねじ っ たり する と 、 ケーブル内部に恒久的な

損傷が生じ る おそれがあり ます。

• ケーブルは、 ケーブル・タ イ を 用いて低～中程度の圧力で束ねて

まと めてく ださ い。 ケーブル・タ イ は締め過ぎないでく ださ い。

• ケーブルは必要に応じ て、 定格のパン チ ・ブロ ッ ク 、 パッ チ ・パ

ネル、 その他のコ ン ポーネン ト を 用いて交差接続し ます。 ケー

ブルは絶対に繋ぎ合わせたり ブ リ ッ ジにし たり し ないで く ださ

い。

• UTPケーブルは、 電線、 ト ラ ン ス、 電灯などのよ う な EMI源と な

り 得る 品物から はでき る だけ距離を 持たせてく ださ い。 ケーブ

ルを 電線用導管に結びつけたり 、 電気機器上に配置し たり し な

いで く ださ い。

• 設置部分は必ずケーブル・テスタ ーでテスト し て く ださ い。 ト ー

ニン グのみではテスト と し て適切ではあり ません。

• ジャ ッ ク の設置は、 接点に埃や他の汚染物質が蓄積し ないよ う

な形で行っ て く ださ い。 ジャ ッ ク の接点は、 埋め込み型のプ

レ ート 上では上向き に、 表面実装型ボッ ク スの場合は左／右／

下向き にし ます。

• ケーブルには常に遊びを も たせ、 天井部分ある いは付近の引込

んだ箇所にはコ イ ル状に整然と 配置し ます。 少な く と も 、 コ ン

セン ト 側では1.5 m( 5フ ィ ート ) 、 パッ チ ・パネル側では4.5 m
( 15フ ィ ート ) のケーブルの長さ を 残し ておいてく ださ い。

• 作業を 開始する 前に、 568Aと 568Bのどち ら の配線規格を 使用す

る かを 決めておいてく ださ い。 ジャ ッ ク およ びパッ チ ・パネル

はすべて、 同一の配線方式で配線し ます。 同一の設置に 568A
と 568Bのワイ ヤーを 混在さ せないでく ださ い。
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• 常に、 地方／国の消防規則およ び建築条例のすべてに従っ て く

ださ い。 防火壁を 通過する ケーブルには必ず火炎止めを し て く

ださ い。 規定に応じ てプレ ナム・ケーブルを 使用し て く ださ い。
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付録 F： Sunアド バン ス ト ・
キー・エ ミ ュ レ ーシ ョ ン

標準タ イ プ 5 (US) Sun キーボード の特定のキー、 ロ ーカ ル・ポート

のUSBキーボード でキーを 連続し て押すこ と によ り 、 エ ミ ュ レ ート す

る こ と ができ ます。 Sun Advanced Key Emulation( Sunアド バン スト ・

キー・エ ミ ュ レ ーショ ン ) モード を 有効にし てこ れら のキーを 使用す

る には、 Ctrl+Shift+Altキーを 押し たまま Scroll Lockキーを 押し ま

す。 Scroll LockのLEDが点滅し ます。 Sunキーボード のアド バン スト ・

キーを 使用する のと 同様に、 次の表のキーを 使用し ます。

例： Stop+Aは、 Ctrl+Shift+Altキーを 押し たまま Scroll Lockキーを 押

し 、 F1+Aキーを 押し ます。

こ れら のキー・コ ン ビ ネーショ ン は、 Dell USB、 USB2、 USB2と CAC
用SIPおよ びAvocent USB、 USB2、 VMC IQモジュ ールで使用でき ま

す。 こ れら のキー・コ ン ビ ネーショ ン は、 F12を 除き 、 Microsoft
Windows製品では認識さ れません。 F12キーは、 Windowsのキープレ

スを 実行し ます。 終了し たら 、 Ctrl+Shift+Altキーを 押し たまま Scroll
Lockキーを 押し 、 Sunアド バン スト ･キー・エ ミ ュ レ ーショ ン ･モード を

切り 替えてオフ にし ます。

表 F.1: Sunキー・エ ミ ュ レ ーショ ン

Compose アプリ ケーショ ン 1

Compose キーパッ ド

電源 F11キー

開く F7キー
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ヘルプ Num Lock

Props F3キー

前面 F5キー

停止 F1キー

Again F2キー

元に戻す F4キー

切り 取り F10キー

コ ピー F6キー

貼り 付け F8キー

Find F9キー

Mute keypad /

Vol.+ keypad +

Vol.- keypad -

Command( 左) (2) F12キー

Command( 左) (2) Win (GUI)左 (1)

Command( 右) (2) Win (GUI)右 (1)

備考：

(1) Windows 95 104キー・キーボード 。

(2) CommandキーはSun Meta( ダイ ヤモンド ) キーです。
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付録 G： 技術仕様
表 G.1: RCS技術仕様

ポート

の個数

1082DS： 8

2162DS： 16

4322DS： 32

タ イ プ

Dell PS/2、 USB、 USB2、 USB2+CAC、 およびシリ アルSIP。 Avocent
PS/2、 PS2M、 USB、 Sun、 USB2、 VMC、 およびシリ アル・モジュ ー

ル。

コ ネク

タ ー
8ピン ・モジュ ラ ー( RJ-45)

同期タ

イ プ
垂直／水平同期信号分離
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入力ビ

デオ解

像度

標準

640 x 480 @ 60 Hz
800 x 600 @ 75 Hz
960 x 700 @ 75 Hz
1024 x 768 @ 75 Hz
1280 x 1024 @ 75 Hz
1600 x 1200 @ 60 Hz
ワイ ド スク リ ーン

800 x 500 @ 60 Hz
1024 x 640 @ 60 Hz
1280 x 800 @ 60 Hz
1440 x 900 @ 60 Hz
1680 x 1050 @ 60 Hz

推奨

ケーブ

ル

4ペア UTP、 最長45メ ート ル

寸法

フ ォ ー

ム・

フ ァ ク

タ ー

1Uまたは0Uラ ッ ク 収納

寸法 1.72. x 17.00 x 9.20 (高さ x幅 x奥行き )

重量

( ケー

ブルを

除く )

1082DS： 6.6 lb (3.0 kg)

2162DS： 7.0 lb (3.2 kg)

4322DS： 7.6 lb (3.4 kg)

SETUPポート

番号 1
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プロト

コ ル
RS-232シリ アル

コ ネク

タ ー
8ピン ・モジュ ラ ー( RJ-45)

ローカ ル・ポート

個数／

タ イ プ
1 VGA/4 USB

ネッ ト ワーク 接続

番号 2

プロト

コ ル
10/100/1000イ ーサーネッ ト

コ ネク

タ ー
8ピン ・モジュ ラ ー( RJ-45)

USBデバイ ス・ポート

番号 4

プロト

コ ル
USB 2.0

MODEMポート

番号 1

プロト

コ ル
RS-232シリ アル

コ ネク

タ ー
8ピン ・モジュ ラ ー( RJ-45)
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PDUポート

番号 2

プロト

コ ル
RS-232シリ アル

コ ネク

タ ー
8ピン ・モジュ ラ ー( RJ-45)

電源仕様

コ ネク

タ ー

1082DS： 1 IEC C14

2162DS： 2 IEC C14

4322DS： 2 IEC C14

タ イ プ 内部

電源 18W

熱放散 47 BTU/時

AC入力

範囲
100～240 VAC

AC周波

数
50/60 Hz自動検知

AC入力

電流定

格

1.25 A

AC入力

電源

( 最

大)

40 W
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周囲大気条件定格

温度 0～50℃( 動作時) 、 -20～70℃( 非動作時)

湿度
作動時： 20%～80%相対湿度( 結露なし ) 5%～95%相対湿

度、 38.7℃ 最大湿球温度

安全規

格およ

びEMC
規格認

証、

マーキ

ング類

UL / cUL、 CE - EU、 N (Nemko)、 GOST、 C-Tick、 NOM / NYCE、 MIC
(KCC)、 SASO、 TUV-
GS、 IRAM、 FCC、 ICES、 VCCI、 SoNCAP、 SABS、 Bellis、 FIS/
Kvalitet、 Koncar、 INSM、 Ukrtest、 STZ、 KUCAS
本製品の安全性証明書およびEMC証明書は、 次の1つまたは複数の

題名の下でご覧いただけます。 CMN( 証明書モデル番号) 、 MPN
( 製造元部品番号) 、 販売段階で付く 型式名称。 EMCおよび／ま

たは安全性の報告書および証明書で参照さ れている題名は、 製品

に使用さ れているラ ベル上に印刷さ れています。
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付録 H： テ ク ニ カ ル・サポート

Dell製品のイ ン スト ールや操作について問題や疑問点が生じ た場合

には当社のテク ニカ ル・サポート までご連絡く ださ い。 担当スタ ッ

フ がお手伝いいたし ます。 万一問題が生じ た場合は、 よ り 良いサー

ビ スを お受けいただける よ う 、 次の手順に従っ て く ださ い。

問題を 解決する には：

1 問題の該当箇所を マニュ アルで調べ、 記載さ れている 手順に

従っ て解決でき る かど う かを 試し て く ださ い。

2 弊社のWebサイ ト ( dell.com/support) にある 「 Knowledge Base( ノ

レ ッ ジ ・ベース ) 」 のデータ ベースから ご検索いただく か、 また

は「 Online Service Request( オン ラ イ ン ・サービ ス ・リ ク エスト ) 」

を ご利用く ださ い。

3 最寄り のDellテク ニカ ル・サポート までお電話にてご連絡く ださ

い。
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